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About the Conductor

Overview of the QALoad Conductor

Use the QALoad Conductor to configure, run, and monitor aload test that utilizesthe scriptscreated in the
Script Development Workbench. The Conductor controlsthe QALoad Players and managestests while they
arerunning. When the Conductor process stops for any reason during aload test, the associated Player
processes automatically terminate.

The Conductor'sinterface isdynamic — it changes depending on where you arein the testing process:
setting up atest or running atest. Both interfaces are described below.

Test Setup

Beforerunning atest, you must set up atest by recording descriptive information about the test, setting
general test options, configuring Player workstations, assigning compiled test scriptsto Players, and setting
up monitoring options. Then, save thetest setup in afile called a session ID. Once you have configured
and saved atest session ID, you can reuse it without re-entering any test information.

The Conductor'sMain Window isdivided into tabson which you enter information about your test and
set up the machines and scriptsfor the test. For more information about the test setup interface, see Test
Setup Interface.

Running a Test

While atest isrunning, the Conductor interface changesto atri-pane view called the Runtime Window
that facilitates monitoring of individual machines and Players, and displaysreal-time test results. You can
view default graphs of performance datathat are created for you by the Conductor and create custom
graphsbased on the data being collected during the test. Custom graph layouts can be saved in the session
ID file and reused in future tests.

QALoad Conductor Menus and Toolbar Buttons

The Conductor's menus and toolbar buttonsare dynamic; their content depends on whether you are
preparing atest setup or running atest.

Test Setup

The Conductor Configuration and Setup Menus allow you to configure the Conductor and your specific
test. The menusor toolbars are:

File

Edit

View

Run

Tools

Help

Configuration and Setup Toolbar Buttons
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Running a Test

The Conductor's Runtime menus and toolbar allow you to control your running test and the datathat is
displayed at test time. The menus are;

Test Options

View

Runtime Windows

Virtual User

Graph

Runtime Toolbar Buttons

Starting the Conductor

The following procedure describes how to start the Conductor.

To start the QALoad Conductor:

1. From Windows:
= Click Start>Programs>Compuware>QALoad>Conductor.
From a Command Prompt:
= Type mpwi n32 <session_file_name> /1 /e [a /t

The applicable parameters are defined in the following table.

T

/1 (Optional) Creates a log file showing error messages
and test status.

/ e (Optional) Exitsthe Conductor when the test
completes.

[ a (Optional) Launches Analyze when the test
completes.

/t (Optional) Executes Conductor at a set time. Valid

time formatsare/t xx: Xxx or
[t XX/ xx/ xx [txx:xX.

2. When the Session Optionsdialog box appears, select the appropriate option to create a new session 1D
file or to open an existing one. Click OK.

3. If you choseto open an existing session ID file, the Open dialog box appears. Navigate to the session
ID file you wish to open, select it, and click Open. The selected session ID file opensin the Conductor
Test Information Window.

If you choseto set up anew session ID file, the Conductor opensdisplaying the Test Information
Window, and the configuration and setup toolbar. For information about the Conductor’s
configuration and setup toolbar buttons, see Configuration and Setup Toolbar Buttons.
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Starting the Conductor From the Command Line

To start the Conductor from the command line, type:
nmpwi n32 <sessionl D file_name> /I /e /a It

Note: You must have a complete session file before the test can start. For example, you must specify either
a set number of transactions or a test duration. A transaction count or a test duration of 0 is not valid.

Valid startup parameters are:

/1 Creates alog file showing error messages and test status.
(Optional)

/e Exitsthe Conductor when the test completes.
(Optional)

/a Launches Analyze when the test completes.

(Optional)

/It Executesthe Conductor at a set time or a set date and

(Optional) time. Time can be specified by either 12-hour or 24-hour
format. The following examples of the/t parameter
demonstrate each scenario.

Command Result

/1" 03:30: 00 pnt Sartsthe Conductor at
3:30PM today.

/t06:00: 00 Sartsthe Conductor at
6:00AM today.

/t"12/01/04 03:30: 00 Sartsthe Conductor on
pnt December 1, 2004 at
3:30PM.

/t"12/ 25/ 04 14:00: 00" Sartsthe Conductor on
December 25, 2004 at
2:00PM.

Test Setup Interface

Test Setup Interface

The Conductor'sMain Window isdivided into tabson which you enter information about your test and
set up the machines and scriptsfor the test. In addition, the Conductor'stoolbar provides access to
standard Windows functionality such as Print and Copy, as well as quick accessto Conductor setup
optionsand to QALoad Analyze. Usethe tabson the Main Window to set up your test. For detailed
information about the fields on these tabs, click one of the links below or press F1 on any Conductor tab.
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i QALoad Conductor, - Untitled E”E|E|
File Edit Miew FRun Tools Help

13 E® | d @ mr ME @
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Test Description: | |
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Test Information Tab

Usethistab to enter descriptive information about the test, view statisticsfrom the previoustest, and set a
maximum amount of time for the current test to run. All descriptive information about the test will be
incorporated into your test'stiming file, and can be viewed in Analyze with your test statistics after the test
has finished.

Script Assignment Tab

Usethistab to set up any scriptsthat have previously been recorded and compiled. Any scriptsyou add
hereisincluded in your load test, and one virtual user isautomatically assigned to your script on the
Machine Assignment tab. After setting up your scripts here, you must assign additional virtual usersto
your script from the Machine Assignment tab.

Monitoring Options Tab

Usethe Monitoring Optionstab to specify optionsfor your monitoring task. You also can integrate
ServerVantage into your load test. QALoad assumesthat the appropriate ServerVantage software is
installed, configured, and running before you start aload test.

Machine Assignment Tab

Usethe Machine Assignment tab to assign scriptsto specific Player workstations. You can use the Edit
menu's Copy and Paste commandsto copy and paste machine entries (rows) as needed.
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Runtime Window Interface

Runtime Window Interface

When you start atest, the Conductor'sinterface changesto an interactive test control station called the
Runtime Window. The Runtime Window displaysinformation about the scripts, machines, and virtual
usersthat are executing the load test. Thetest dataisdivided into three views— Details, Graphs, and
Session —that are accessed from the Test Views workspace on the left side of the interface.

On the Runtime Window, you can observe the progress of individual scriptsand Player machines, view
real-time graphs, and start or suspend scriptsand Players from arunning test to better ssmulate the
unpredictability of real users. Thiswindow hasthree unique areas. Click on apanein the following
graphic for a brief description of that pane. Or, click on the links below the graphic for detailed
information.

Details View

The Detailsview of the Datawindow in the Conductor Runtime Window displaysall your test datain real-
timein aseries of interactive tabs. By clicking on icons representing scripts, virtual users, and workstations,
you can view different types of data. By default, each test displaystest detailsin the right pane. You can
also choose to view the script asingle virtual user isrunning, the Web page a WWW script isutilizing, or
the RIP file generated by afailed virtual user.

Test Details

Test details display automatically, and describe the object you select in the tree view. You can view details
for all test scripts, individual test scripts, all player machines, and individual player machines.

See Test details for moreinformation about the tree itemsthat can be displayed in the data window.
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Runtime Tabs

The following runtime tabs can be displayed for arunning script. These tabs can be enabled from the
Virtual User menu.

Debug
RIP File (WWW)

Runtime Control Panel

The Runtime Control Panel isadockable control station that enables you to change virtual user options
and data transfer optionswhile theload test isrunning. For more information, see Runtime Control Panel.

Graphs View

The Graphsview in the Conductor Runtime Window displays graphs of data collected during the test. By
default, the Graphsview displays graphsfor response times, test status, and player machine health.

Other graphs, such as user-defined checkpointsand Remote Monitoring counters, can also be plotted in
theright pane of the Graphsview if they were enabled for the session.

To display graphs:

1. Right-click on a counter or other data type in the tree view that you want to plot in a graph.
2. Choose Add Graph or Add Plot To.

You can also modify a graph's appearance by right-clicking on the graph and choosing one of the
formatting options, such as colors and axes properties. To increase the visibility of a plot when you have
multiple plotson a graph, click on a plot (or that plot'snumber in the legend) to highlight it.
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Session View

The Session view in the Conductor Runtime Window provides summary information about the test session
that iscurrently running. The Session view can be printed as a report by right-clicking and choosing Print
from the shortcut menu.

Click on the sectionsin the following graphic for more information about the Session view.
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Setting Up a Test

About Setting Up a Test Setup

To set up aload test, set optionsrelated to general Conductor behavior aswell asinformation about your
specific test environment. Before you can successfully set up aload test, you must have recorded and
compiled one or more test scripts. For information about recording a test script, see Developing Scripts.

Determining General Conductor Behavior
General Conductor optionsyou set will be applicable for all testsrun until you change them. Conductor
optionsarerelated to the following:

I Viewing optionsfor real-timeresults

! Global Player options

I Player machine performance data

I Optionsfor runtime reporting

! And more...

All of the above information, and more, can be configured on the Conductor's Options dialog box.

Setting Up a Specific Test Session

To prepare the Conductor for a specific test, save information and parameters specific to that test into a
reusable session ID file (.id). You need to enter the following types of information to set up atest's session
ID file:

I General information about the test such asa description, the size of the database, the length of the
test, and any notes or comments

I Information about the test script(s) included in the test, including script name,
middleware/protocol type, pacing, whether to include external data, and so on

I Information about the workstationswhere the QALoad Playersreside, including which script is
assigned to each workstation, how many virtual users are assigned to each workstation, the
machine name, and so on

I (Optional) configuration for server monitoring
I (Optional) integration with other Compuware products

All of the above information can be entered and saved from the Conductor's main window, see Setting Up
aTest Session.

Generating Random Number Seeds

Random number seeds are used to inject random delaysin script execution for each load test. The seed (or
value) isautomatically generated by QALoad. The random value used within the end of transaction
function isused to generate the pacing time. The Player uses a system-generated sequence of numbers, so
that each VU (virtual user) hasits own seed value.

Setting Up the Conductor

To prepare for running aload test, you must set up the Conductor.

10
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To set up the Conductor:

1. Start the Conductor.

2. Configure the Conductor. After starting the Conductor, you may need to verify that the Conductor’s configuration
parameters are set properly.

3. Set Up a Session ID File. For every test you run, you must create a session ID file containing information the
Conductor needs to run the test, such as which scripts to run, which Player machines to use, and whether to collect
server or performance monitoring data. You use the Conductor to create and save session ID files in the
\ QAl oad\ Sessi on directory.

Configuring the Conductor

There are several settings for the Conductor that you should review before beginning your load test.

To set Conductor optionsthat are not specificto one test:

1. From the main menu, choose Tools>Options.

2. On the Options dialog box, set options related to post-test activity, warnings and prompts, runtime grids, timing
settings, interface refresh intervals, Conductor/Player communications, monitoring intervals, and more.

3. When you are finished, click OK to save your changes. Any options you set will apply to all tests until you change
them.

For detailed descriptions of the optionsthat are available, see Options dialog box.

Setting Up a Test Session

You can enter all theinformation necessary for your session ID fileright in the Conductor'smain window,
the Test Information Window.

€ Hint: The following procedures guide you through setting up areusable test session ID using the
Conductor's main window, the Test Information window. Follow each step in turn to configure your test, or
revisit this help topic later to make changesto any specific part of the test setup.

Step 1: Enter descriptive information about the test:

On the Test Information tab:

1. (Optional) Type descriptive information about the test in the Test Description, Client System, Server System,
Database Size, and Comments fields.

2. Inthe Session Duration field, type a time limit to specify the maximum duration for the test to run. Type 0 (zero) if
you do not want to specify a maximum duration.

' Hint: For details about any field on the Test Information tab, see Test Information.

Step 2: Assign compiled scriptsto the test:

On the Script Assignment tab:

1. Click New to open the Select Script dialog box. The Select Script dialog box lists the scripts available for your
transaction type. If it does not, select your transaction type (middleware environment) from the Scripts of Type list.

' Hint: To open the Select cript dialog box from the Script column, click in the Script column to
enable the Browse (...) button. Then, click Browse.

11
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The Select Script dialog box lists a status for each script that indicateswhether the script is
compiled. If it isnot, you must compile the script before attempting to use it in atest.

Select a script from thelist and click Select to return to the Script Assignment tab.

Continue selecting scripts until all scriptsyou wish to usein thistest are listed.

(Optional) Select ApplicationVantage Mode to enable AV timings. When you make this selection. you
must also perform Sep 5: Set up ApplicationVantage Options.

' Hint: For details about any field on the Script Assignment tab, see Script Assignment.

Step 3: Set test options for each script:

For each assigned script on the Script Assignment tab:

1.

In the Transactions column, type the number of transactionsthat each virtual user running this
script should run. Once a workstation executesthe number of transactionsthat you specify, script
execution continueswith theline following the End_Transaction command rather than jumping
to the beginning of the transaction loop

Click in the Debug Options column to enable the Browse button. Click Browse to open the Debug
Optionsdialog box, and then set any optionsfor Debug Trace and Logfile generation. For a
description of the Debug Optionsdialog box, see Debug Options.

In the Error Handling column, select the option that indicateshow the Player running this script
should behave when encountering non-fatal errors: Abort the transaction, Continue the
transaction, or Restart the transaction.

Enter avaluein the Seep Factor column to specify the percentage of any originally recorded delay
to preservein the script (for example, a value of 80 means preserve 80% of the original delay).

In the Service Level Threshold column, type amaximum duration for thisscript. At runtime, the
QALoad Conductor will display aruntime graph comparing the Service Level Threshold with the
actual duration.

In the Pacing column, type avalue, in seconds, for pacing.

Click in the Timing Optionscolumn to enable the Browse button. Then, click Brow se to access
the Timing Optionsdialog box and set optionsrelated to checkpointsand datathinning.

(Optional) Click in the External Data column to enable the Browse button. Then, click Browse to
open the External Data dialog box and associate any necessary external fileswith your selected
script.

' Hint: For details about any field on the Script Assignment tab, see Script Assignment.

Step 4: Set up Player machines:

On any tab:
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1.

Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box
appears.

Click File>Discover Player Machinesto query your network for QALoad Player workstations. All
workstationswith QALoad Playersinstalled are listed. If Player machines are discovered to have
previousversions of QALoad installed, an error message informsyou which machinesneed to be
updated.
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3. Check the availability of all the Player machines on your network by clicking Verify All, or by
selecting individual machines and clicking Verify. The QALoad Conductor requests each selected
Player machineto ensure it isavailable.

If a Player machineisavailable, system information for that machine appearsin the Details area of
the dialog box. View the Properties dialog box for that Player machine by double-click on the
Player machine listing. If the Player machine isnot available, you receive a message that the Player
isnot responding.

4. (Optional) Use New to manually add a Player machine, or Delete or Delete All to remove
machines. To save the current machine setup for re-use, create a new configuration file (.cfg). How?

' Hint: For details about any field on the Machine Configuration tab, see Monitoring Options.

Step 5: (Optional) Set up ApplicationVantage:

Note: You must have ApplicationVantage installed on the Player machine to activate these fields.
This step isrequired if you selected ApplicationVantage Mode on the Select Script dialog box . Refer to Step 2:
Assign Compiled Scriptsto the Test for more information.

On any tab:

1. Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box
appears.

Double-click on the Player machine listing. The Edit Player Machine dialog box appears.
Click the ApplicationVantage Settings tab.

In the NIC Name field, select the Network Interface Card on which you will collect timings.
Click Apply, then click OK.

o M wN

Step 6: (Optional) Set up Remote Monitor machines:

On the Monitoring Optionstab:

1. Click the Enable Performance Monitoring at Runtime check box to enable monitoring at test
time.

2. Create amonitoring task to specify which countersto monitor or apply an existing task and
modify the counters as necessary:

= Createanew monitoring task

= Usean existing task

Step 7: Assign scriptsto Player machines:

On the Machine Assignment tab, the scriptsyou assigned to the test on the Script Assignment tab are
listed in the Script column. Fll in the following columns:

Note: Use Auto Configure to have QALoad automatically assign scriptsto virtual users.

1. Inthe Sarting VUscolumn, type the number of virtual usersto initially launch the script on this
machine when atest begins.

2. Inthe VU Increment column, type the number of virtual usersthat should be added, at intervals, if
you want thismachineto add incremental virtual users. You must also fill in the Time Interval and
Ending VUsfields.

13
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3. IntheTimelnterval column, typethetimeinterval at which incremental virtual users should be
added to atest. (For example, to add virtual users every 5 minutes, type 00:05:00). You must also
fill in the VU Increment and Ending VUsfield.

4. Typethenumber of virtual usersassigned to run until the end of the test.

In the Machine column for each script, select a Player machine from the drop-down list to assign it
to that script. If no Player machines are available in the drop-down list, click the Manage Player
Machines button to set up a Player.

6. Inthe Mode column, select the test mode for each Player machine: thread-based or process-based.

7. (Optional) Use New, Delete, and Delete All to add or remove scripts from thistest.

Step 8: (Optional - WWW only) Enable expert user:

On the Machine Assignment tab:

1. Clickin the Sript column to enable the Browse button. Click Browse to open the Expert User
Optionsdialog box.

2. Select Enable Expert User timings.
3. In theVirtual User field, type avirtual user number, if necessary.
4. Click OK.

When all scripts have been successfully assigned to Player machinesand the test isready to run, Run on
the Machine Assignment tab will become available and you can run atest.

Step 9: Save the test setup you just created as a reusable session ID file:

Save the Test Setup
To save the current test setup to areusable test file called a session ID, click File>Save to name and save it.
Save the Machine Configurations

To save the Player Agent, Server Analysis Agent, Remote Monitoring Agent, Expert User, and
ApplicationVantage integration configurationsto areusable file, called a configuration file (.cfg) see Saving
machine configurations.

Adding a Script to a Test

To add a script to a test session:

1. From the Test Information Window, click the Script Assignment tab.
2. Click the browse[...] button in the Script column to open the Select Script dialog box.

3. Inthe Scripts of Type box, select your script type. From the list of available scriptsthat appears,
highlight a script name and click Select. You are returned to the Test Information Screen.

4. In the Transactions column, specify the maximum number of transactionsthat you want each
virtual user running thisscript to run. Once aworkstation executesthe number you specify, script
execution continueswith theline following the End_Transaction command rather than jumping
to the beginning of the transaction loop.

5. In the Debug Options, click the browse [...] button column to accessthe Debug Optionsdialog
box, where you can specify virtual usersfor debug trace and logfile monitoring. Click OK.
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6. In the Error Handling column, select what to do when the script encountersan error: abort
transaction, continue transaction (asif no error had been encountered), or restart transaction
(WWW, SAPGUI, and Citrix scriptsonly. Click OK.

7. Enter avaluein the Seep Factor % column to specify the percentage of any originally-recorded
delay to preservein the script (for example, a value of 80 means preserve 80% of the original
delay). Valid values are 0-100, or Random. The default value is 100%.

8. In the Service Level Threshold column, enter aresponse time by which to compareincoming
responsetimesduring atest. When you run atest, alinerepresenting the Service Level Threshold
appearson theruntime graph. Asthe test progresses, you can compare incoming responsetime
datato the Service Level Threshold.

9. Enter avalue, in seconds, in the Pacing field. Pacing isthe time interval between the start of a
transaction and the start of the next transaction for each virtual user running a script.

10. In the Timing Optionscolumn, click the browse [...] button to accessthe Timing Optionsdialog
box where you can configure how much timing datais collected. Click OK. For details about the
Timing Optionsdialog box, click Timing Options.

11. Click the browse[...] button in the External Data column to accessthe External Data dialog box
where you can select a datapool or other file to include with your test. Click OK. For details about
the External Data dialog box, see External Data.

12. From the File menu, choose Save to save your changesto the current session ID file, or Save Asto
save them to anew session ID file.

Removing a Script from a Test

To remove a script from a test:

1. In the Conductor, on the Test Information tab, click on the selection box to the left of the script
nameto highlight the row.

2. Click Deleteto removethe script from the test.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

Anticipating Error Conditions

You know before beginning aload test that errors are a possibility, but you may not alwayswant them to
stop your progress during testing.

QALoad helpsanticipate error conditionsand determine, before running the test, how Playersreact to non-
fatal errors. By setting one option, you can instruct a Player to continue asif no error was encountered,
stop running immediately, or restart at the beginning of the transaction.

IEl Note: When the Conductor process stops for any reason during a load test, the associated Player processes
automatically terminate.

To set the error handling option, see Script Assignment tab.

Managing Large Amounts of Test Data

With alarge number of virtual users, it ispossible to create atiming file containing hundreds of thousands
of timing records for each checkpoint. Attempting to graph just a few of those checkpoints can slow
QALoad Analyze down considerably.
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For example, if atiming file contained 250,000 timing records for each data point, attempting to graph
even one checkpoint meansthat QALoad Analyze must paint 250,000 lineson the graph. Snce most
monitorsonly have 1024 pixels acrossthe screen, the 250,000 data pointswould mostly be plotted atop
one another and the results would be unreadable.

Now imagine attempting to graph the data of several data points of that size. The sheer amount of data
could easily overwhelm a workstation. And every time you move the window, resize the window, or right-
click on the graph, QALoad Analyze hasto re-draw the graph. You could conceivably spend enormous
amountsof time simply attempting to graph data.

To make large amounts of data manageable, QALoad Analyze provides an option that allowsyou to
determine how to thin data. That is, how to determine how many data pointsto plot.

When your test isrunning and your Conductor iscollecting timing information from your Player
machines, the sheer amount of data can take up more of your resourcesthan you would like to expend.
Use QALoad's Timing Data Thinning option to thin the amount of timing data being transferred back to
the Conductor during the test so that your test can run longer without stressing your resources.

Saving Machine Configurations

After configuring the machinesto use for aload test, you can save the machine configuration information
into a configuration file (.cfg) that can be reused in later tests, saving you significant time setting up later
tests. A configuration fileincludesinformation about which machineson the network were used as Player
machines. You can save multiple configurations under different names. By default, when first using
QALoad, the Conductor uses a configuration file named Def aul t . cf g. The Conductor saves any changes
to your machine configurationsto thisfile unless you save your configuration to a new file with a different
name.

You can open or save .cfg files from the Manage Player Machines and Groupsdialog box. The .cfg field
always displaysthe active configuration.

To create a new, empty .cfg file:

1. OntheMonitoring Optionstab, click Tools>Player Machines. The Manage Player Machines and
Groupsdialog box displays.

Click down arrow on the .cfg field at the bottom of the dialog box.
Choose <New>.

On the Save As dialog box, specify aname for the new file and click Save.

A

Add the necessary Player and agent machinesusing the fieldsand buttonson the Manage Player
Machines and Groups dialog box. The machinesyou configure are saved automatically to thefile
you just created.

To rename the current .cfg file:

1. OntheManage Player Machines and Groups dialog box, click the down arrow on the .cfg field at
the bottom of the dialog box.

2. Choose <Save As>.
3. On the Save Asdialog box, specify aname for the new file and click Save.

4. Make any necessary changesto the configuration. Your changes are saved automatically to thefile
you just created.
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To open a previously created .cfg file:

1. OntheManage Player Machines and Groupsdialog box, click the down .cfg field at the bottom
of the dialog box.

2. Choosethe .cfgfile to open.

El Note: The .cfg file only storesinformation about Player machines. It does not store information specific to a
test, such as script names or settings. Test specific information is saved in the session ID file. A session ID file
for a specific test saves the name of the .cfg file associated with that test, and opens it automatically when the
session ID file isopened. You can change the .cfg file at any time without being concerned about the session
ID file.

Assigning Scriptsto Player Workstations

Usethe Conductor's Machine Assignment tab to assign scriptsto Player workstations. You can assign
scripts manually or enable QALoad to assign them automatically.

1. Dooneof thefollowing:

= Manual assignment — In the Machine column for the appropriate script, select a machine
from thelist to assign it to that script.

= Automatic assignment — Type thetotal number of virtual usersto assign to thetest in the
Sarting VUs column, then click the Auto Configure button. QALoad will automatically assign
scriptsto each Player workstation.

2. Click File>Save to save your changesto the current session ID file, or click File>Save Asto save
them to anew session ID file.

Changing the Number of Virtual Users

Change the number of virtual users assigned to a script on the Machine Assignment tab of the
Conductor'smain window.

To change the number of virtual users:

1. Typeanew valuein the Starting VUs column for the selected script.

2. If you have assigned incremental virtual users, changethe valuesin the VU Increment column
and the Ending VUs column to determine how many virtual usersto add at the interval specified
in the Time Interval column.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

Changing Test Options

To change test options:

1. Makechangesin the Conductor on the Test Information, Script Assignment, Monitoring Options,
or Machine Assignment tabs.

2. Click File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file,
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Setting Delays Between Tests

You can set afixed delay or pause between tests by specifying avaluein the Delay Between Tests field on
the Batch Test dialog box. After each test iscomplete, the Conductor delays for the specified amount of
time before starting the next test.

Validating Scriptsin Conductor

Beforerunning atest, you should run your script in asimpletest to ensure that it runswithout errors. You
can validate UNIX or Win32 scriptsin the Conductor.

Debugging a Script

If you encountered errorswhile validating or testing a script, use QALoad's debugging optionsto monitor
the Player(s) that generated errorswhile they are running or after the test.

You can watch avirtual user execute a script on a Player Workstation whileit isrunning. To monitor
selected virtual usersat runtime, enable the Debug Trace option before you run your test. Each virtual user
for which you enabled Debug Trace displays messages on its assigned Player workstation indicating which
commands are being executed.

You can instruct the Conductor to generate and save details about the script execution of selected virtual
users by enabling Logfile Generation before you run your test. Thisappliesto Citrix, ODBC, Oracle, Oracle
Forms Server, SAP, Winsock, or WWW only.

To enable the debug options:

1. On the Conductor's Script Assignment tab, highlight the script you want to monitor.

2. In the Debug Optionscolumn, click the browse (...) button (note that the button may not be
visible until you click in the Debug Options column).

3. On the Debug Optionsdialog box, you can optionally choose the following options:

a. To enablethe Debug Trace option: in the Debug Trace Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

b. To enable Logfile Generation: in the Logfile Generation Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

4. Click OK to save your changes.
5. From the Conductor'smain menu, click File>Save to save your test session ID.

6. Run your test asusual.

El Note: Some log files are generated automatically when you run a test in the Script Development
Workbench or Player.
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Managing Players and Groups

Overview of Players and Groups

In Conductor, on the Monitoring Optionstab, use Tools>Manage Players and Groups option to configure
the variousmachinesand agentsthat will participate in aload test. You can configure Player Machines,
Player Groups, and ApplicationVantage settingsinformation from a single screen.

You should use thisoption to update Player or Agent information whenever a Player or Agent isadded to
thetest network, removed from the test network, or the network address of a Player or Agent has changed.

You can collect Player machinesinto logical groups
Player Agents

Player machines execute the virtual usersthat perform the transactionsrecorded in your test scripts. If no
Player machines are listed, can retrieve information from Player machineson the local network, or you can
add Player machines manually.

Managing Player Machines

Adding Player Machines

From the Conductor'smain menu, click Tools>Manage Player Machines. The Manage Player Machines
and Groupsdialog box displays.

To add a Player Machine:

Click File>New Player Machine. The New Player Machine dialog box displays.
On the Properties tab:
1. IntheMachinefield, type aname for the Player Machine.

2. IntheCommunicationsport field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Test Connection to check that the machine is active. The Player or Agent returnsthe
operating system, processor type, and amount of memory on the machine.

4. Select the Player Machine settings.
5. Click Apply to add this player machine to the group or groups selected.
On the Groupstab (Optional):
1. Click Add... The Add Groupsdialog box displays.
2. Select the groupsto which this Player Machine will be added, then click OK.

On the ApplicationVantage Settingstab:

El Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player Machine and
ApplicationVantage Mode is selected when you choose a script in the Script Assighment tab.
! From the drop-down list in the NIC Name field, select the Network Interface Card (NIC) that is
used by the machine.

Save the Player Machine:
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I Click Add Player. The Player Machine appearsin the Manage Playersand Groupsdialog box in
the All Player Machines and Groupstree.

Editing a Player Machine

From the Conductor'smain menu, click ToolsSManage Player Machines. The Manage Player Machines
and Groupsdialog box displays. Use the following procedure to edit Player Machines.

To edit a Player machine:

Double-click an individual Player Machine in the All Player Machines and Groupstree. The Edit Player
Machine dialog box displays.

On the Properties tab:
1. IntheMachinefield, type aname for the Player Machine.

2. Inthe Communications port field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Test Connection to check that the machine isactive. The Player or Agent returnsthe
operating system, processor type, and amount of memory on the machine.

4. Select the Player Machine settings.

5. Click Apply to add this player machine to the group or groupsyou selected.
On the Groupstab (Optional):

1. Click Add... The Add Groupsdialog box displays.

2. Select the groupsto which this Player Machine will be added, then click OK.

On the ApplicationVantage Settings tab:

Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player Machine and
ApplicationVantage Mode is selected when you choose a script in the Script Assignment tab.
! From the drop-down list in the NIC Name field, select the Network Interface Card (NIC) that is
used by the machine.

Save the Player machine you added:
I Click Apply. The Player Machine isupdated with theinformation you entered.

Retrieving Information on Player Machines

In Conductor, you can retrieve information from Player machineson the local network by doing the
following:

To retrieve information on Player machines:

1. OntheMonitoring Optionstab, click Tools>Manage Player Machines. The Manage Player
Machines and Groups dialog box displays.

2. Click File>Discover Player Machines. QALoad Conductor queriesthe network for available Player
workstations and addsthe resultsunder Player Machinesin the All Player Machines and Groups
tree.
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Managing Groups

Adding a Group

Use the following procedure to add a group for Player Machineswhilein Conductor.

To add a group:

1.

R

From Conductor'smain menu, click Tools>Manage Player Machines. The Manage Player
Machines and Groupsdialog box displays.

Click File>New Group. The New Group dialog box appears.
In the Group Name field, type aname for the group.

In the Description field, type a description for the group.
Click Add... The Add Player Machines dialog box displays.

Select a Player machine in the Available Player Machines panel, and click Add. The Player
Machine isadded to the Selected Player Machines panel.

2] Note: You can select more than one machine by holding down the Ctrl key and selecting each Player
Machine to select. Select all the available Player Machines by clicking Add All.

Click OK. The New Group dialog box displays with the selected Player Machines displayed in the
Player Machinesin Group panel.

Click Apply to add the Player Machinesto the new group.

Editing a Group

Use the following procedure to edit a group.

To edit a group:

1.

On Conductor's main menu, select Tools>Manage Player Machines. The Manage Player Machines
and Groupsdialog box displays.

Select agroup in the All Player Machines and Groupslist tree and click Selected>Edit. The Edit
Group dialog box displays.

Usethefieldsin thisdialog box to change the Group Name or Description.

To add a Player Machineto the group, click Add to display the Add Player Machines dialog box.
Use the procedures for adding a Player Machine.

To remove a Player Machine from the group, select the Player Machine in the Player Machinesin
Group panel, then click Remove.

Click Apply to save your changes, then click OK to return to the Manage Players and Machines
dialog box.
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Running a Test

Running a Load Test

After validating a script using one of the methods described in Validating Scripts, it is safeto run aload test
with that script. See the following topics for more information:

! Preparing for aLoad Test
! Monitoring a Load Test
I Sopping aload Test

To start a load test:

Click the Run button E on the configuration and setup toolbar, or from the Conductor’s Run menu,
choose Start Test. Whileatest isrunning, the Conductor'sInterface changesto provide you with real-time
test options.

El Note: While any window on the desktop isre-sizing or re-positioning, all Windows applications pause. Do
not click and hold on a window caption or border for extended periods during a load test because it delays
message handling and may have an impact on test results.

While aload test isrunning, the Conductor’stoolbar changes from the Configuration and Setup Toolbar to
the Runtime Toolbar. The Runtime Toolbar buttonslet you control the test and access detailed

information about the test while it isrunning. For more information about what to expect from the
QALoad Conductor whileatest isrunning — including descriptions of the Runtime Toolbar buttons — see
Monitoring a Load Test.

Running a Series of Tests

You can also run a series of tests — a batch test. A batch test comprises multiple session ID files. When you
run abatch test, the session files are executed sequentially until all of them are executed. The Conductor
enablesyou to run multiple batch testswithout operator intervention.

Checking Out Virtual User Licenses

If you are licensed to run multiple copies of the Conductor, for example so different work groups have
accessto QALoad, you can check out virtual user licenses before running aload test to ensure that enough
are available for your test run.

If you do not choose to check out your licenses before starting atest, QALoad promptsyou after you start
thetest and attemptsto check out the appropriate number of licenses. We recommend that you check
your licenses out manually before starting so you can be sure you have enough virtual users available
before beginning your test run.

To check out virtual user licenses:

1. From the Conductor menu, select Tools>Licensing. The License Information dialog box appears.

I If you arelicensed for concurrent licensing (multiple Conductors) the Conductor queries
your license server to determine how many licenses are currently available, and returnsthe
resultsto thisdialog box. Go to step 2.
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I If you have anode-locked license (a single Conductor), then most of the optionson this
dialog box are unavailable, asyou will not need to, or be able to, check out virtual user
licenses. All virtual usersfor which you are licensed are available only to this Conductor.

Click Close to return to your test setup.
2. IntheLicensing Operationsarea, type how many virtual user licenses you want to check out in the
Number of Licensesfield.
Click Check Out. The licenses are checked out to your Conductor, and are unavailable to any other
Conductor workstations on the network.
When you are done using your licensed virtual users, check them back in so they are once again available
to other Conductor workstations on your network.

To check in virtual user licenses:
From the Conductor menu, choose Tools>Licensing. The License Information dialog box appears.

1.

2. If you have licenses checked out, the Check in Virtual User License option isautomatically selected
for you.

3. Click Check In. Thelicenses are made available to other Conductor workstations on the network.

Dialing Up/Down Virtual Users

QALoad'sdial-up/dial-down featurein Conductor allowsyou to dynamically add or reduce virtual usersto
your test at the script or Player level while your test isrunning. Thisenablesyou to adjust your running
test according to test behavior on-the-fly, rather than stopping to re-configure playback criteria.

To usethedial-up/dial-down feature, you must:
! belicensed for at least the number of virtual usersrequested

I configure aramp-up session beforerunning the test
Notes:

If you have not configured aramp-up session, you will not be allowed to add or suspend virtual
userswhilethetest isrunning. For information about configuring aramp-up session, see

Configuring aramp-up session.
Ramp-up isnot supported for amachine assignment entry that isusing a player group.

When your test isrunning, the bottom of the Test Information window turnsinto the dockable Runtime
Control Panel, a portion of which isshown below:

Script Optiong - lottagtuff
Errar Handling:

IFiestart j Running

Sleep [%]: Pacing [hh:mom:zs.mz); I 3 |ﬂ|
[too =] |oo:00.01.000 f ; Carcel |

| Test Time: 00:04:57 | Last Update: 00:04:55 | &l wirtial users have Synched. 5

If you click on a Player or script icon in thetest'stree-view, the Runtime Control Panel will indicate how
many virtual usersare currently running on the selected Player machine or script. You can changethe
number of running virtual users per script or per Player by selecting the appropriate script or Player
machine in the tree-view, and then typing anew number in the Running field (or by using the dial

control).
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To dial up or down (add or subtract) virtual usersduring a test:

1. When your test isrunning, click on the script or Player workstation in the Runtime Window's tree-
view for which you want to add or subtract virtual users. The Running column in the top pane
shows how many virtual users are currently running on that script or Player.

2. In the Runtime Control Panel, type anew number in the Running field or drag the dial control to
changethe number.

3. When you are done, click Apply. The Conductor will release or suspend the specified number of
virtual users.

Your change do not take effect until you click Apply.

Increase/ Decrease Runtime Timing Updates

While atest isrunning, you can change the frequency at which timing updates are sent from the Playersto
the Conductor. Decreasing the update interval will reduce the amount of overhead incurred in large load
testsdueto the communications between the Conductor and large numbers of virtual users.

In Conductor, on the Runtime Control Panel (bottom pane), choose from the following options:

No Updates: Choose thisoption to stop sending timing datawhilethe test isrunning. Data will still be
collected at the end of the test.

Send All: Choose thisoption to send all timing data asit iscompiled.

Periodic Updates: Choose thisoption to specify atimeinterval for sending updates, then typethetime
interval (in seconds) below.

Any change takes effect immediately, and appliesto all scriptsin the test.

Removing Used Datapool Records After a Test

You can remove used datapool records after atest by setting the Srip Datapool function before you run the
test. Use thisfunction when running atest where you have datain the external datapool which can only
be used once by onevirtual user at atime. (For example, when running transactionsthat have unique data
constraints.) When activated, the Srip Datapool function will mark each piece of datain the datapool that
isused during your test. When thetest isover, the Srip Datapool function promptsyou to removethe
identified used data from the datapool. If you run thetest again, only new data will be used for your
subsequent test.

To use the Strip Datapool function:

1. With thecurrent test's session ID file open in the Conductor, select the Script Assignment tab.
2. Click the External Data button. The External Data dialog box appears.

3. In the Central Datapool area, select the Strip check box. Click OK.
4

At the end of your test, a Srip Datapools prompt will appear asking if you wish to go to the Srip
Datapools screen. Click Yes.

o

The Srip Data Pool dialog box appears. Click the Strip button.

When you are finished, click Close.

24



Conductor

Stopping a Load Test

A load test iscomplete when all virtual usersexit. A virtual user automatically exitswhen one of the
following occurs:

I Ascript encountersan EXIT command.

I Ascript completesitstransaction loop.

To stop aload test, click the Exit button.

Adding Post-test Comments

If you selected the Display Post Test Commentsoption on the General tab of the Optionsdialog box
when you configured the Conductor, the Post Test Commentswindow openswhen you click the Quit
button. Type any comments, which are saved to the test’s Summary Report, which can be viewed in
QALoad Analyze.
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Running a Series of Tests (Batch)

Running a Batch Test

By setting the appropriate optionsin the Conductor, you can elect to run a series of tests as a batch, rather
than oneat atime. A batch test comprises multiple session ID filesthat are executed sequentially.

You can create a batch test by adding a number of session ID filesto a batch file. Before you can add a
session ID to a batch file, the following conditions must be true:

I Thesession must include a defined number of transactions. Sessions of unlimited transactions
cannot be used in a batch test.

I All scriptsto beincluded must exist before starting the batch test. Thismeansthe .c files referenced
in the selected session ID filesmust be present in the scriptsdirectory.

To run a batch test:

1. Select Run>Batch Test.
2. Addtherequired session ID filesto the Batch List using Add or Load.
3. Click Start to initiate the batch.

The Conductor then executes each of the session ID filesin sequence.

Adding Sessionsto a Batch Test

Before a session isadded, the following conditions must be true:

I Thesession must include adefined number of transactions. Sessions of unlimited transactions
cannot beused in abatch test.

I All scriptsmust exist prior to starting the batch test. Thismeansthat the filesreferenced in the
selected session ID files are present in the script directory.

A session can be placed in a batch multipletimes. Thisfeature might be used to re-run atest or to perform
housekeeping chores, such aslogging usersin or out of ahost or database.

To add a session:

1. From the Run menu, choose Batch Test.
2. In the Session Files(.id) box, highlight the session you want to add, and click the Add button.

If you want to run a previously defined batch, click the Load button to navigate to the directory
where the batch file (.run) resides. Select it, and click OK.

The session isadded to the Batch List on theright side of the dialog box.

Removing a Session from a Batch Test
1. Select Run>Batch Test.

2. Highlight the session to remove in the Batch List and click Remove.
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Terminating a Batch Test

Sop abatch of teststhe same way you would stop a single session test, by clicking the Abort or Exit

toolbar buttons. When the Conductor process stops for any reason during a load test, the associated
Player processes automatically terminate.
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Monitoring a Running Test

Monitoring CPU Usage

To help you monitor the impact of running aload test on a server, QALoad can collect data from selected
Players about CPU usage during aload test. The statistics collected during the test are merged into the test's
timing file so you can view them in Analyze after the test.

When the Top Process Monitoring counter isenabled for a Server Analysis Agent machine, information is
collected periodically during the load test about which processes are using the most CPU. Counter datais
written to your test'stiming file, which you can open in Analyze after your test.

Note: During a load test, if the CPU idle time of your machine falls below 25%, check the individual
processes on your machine. If the Players and virtual users are utilizing most of the active CPU time, you
should use additional Player machines and fewer virtual users per Player to conduct your load test.

To collect Top Processes data:

1. IntheMonitoring Optionstab, click the Set up monitoring link.

2. Select Set up anew monitoring task, and click OK. The New Monitoring Task Wizard opens.
3. In theDefine Monitor dialog box, select Server Analysis Agentsin the Monitor Type field.
4

In the Choose Countersdialog box, click the Counterstab, then select Top Process Monitoring
and add it to the Selected Items pane.

5. Completethe stepsin the wizard to save the monitoring task.

When your test isfinished, the Top Processes data collected will beincluded in your test'stiming file which
you can open in QALoad Analyze.

Watching a Script Execute

Use the Debug window in the Details view of the runtime Conductor to view the executing script. Note
that it ispossible that you will not see the execution of every statement, in order to minimize network
traffic between the Conductor and the Players. The QALOAD.INI file’s debug messages-per-sec parameter
determines how frequently the Player sendsits script debug statusto the Conductor. At its default value of
one message per second, the Player can execute several statementswithout sending a debug message to the
Conductor.

To open the Debug window, select a workstation in the global control window and click the Debug
toolbar button.

Note: The Conductor highlightsthe script line that it is currently executing.

Viewing Datapool Usage

Highlight a script in the global control window and click the Datapool button to open the Datapool
window. Asthe script executes Get_Data commands, the Datapool window reflectsthe current datapool
record being used by the script.
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Graphing Checkpoints

Usethe Graphsview of the runtime Conductor to create real-time graphs of checkpoint response times
during script execution. Smilar graphs are also available for post-test analysisin QALoad Analyze.

Selecting Checkpointsto Graph

Before you can review checkpoint response timesin graph form, you must select the checkpoint counters
to include. Checkpointsare listed in the tree view on the left side of the Graphsview of theruntime
Conductor, as shown in the example below. Both automatic and user-defined checkpointsappear in the
Response Times folder of each running script.
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EI_| Auto Checkpoints
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- Line 138: "Standard HT kL E=ample"
- Line 148: QaLoad Wi Capture Examples
- Line 158: The page cannot be found
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Creating a Graph of Checkpoint Response Times

To choose a checkpoint that should appear in agraph, highlight the checkpoint name, right-click and
choose either Add Graph to create anew graph or Add Plot To to add a data plot to an existing graph.

If you choose the Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

To better identify problem checkpoints, you can set thresholds on plotsor graphsthat indicate the number
of timesthe datarecord for that checkpoint has gone above or below the number you set. Thresholds can
be set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to see individual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

Saving Checkpoint Graphsto a Session ID

Checkpoint graphsthat are created in the Conductor are automatically saved to the current session ID file.
To remove all graphsyou added, click Graph>Restore Default Graph Layout.
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Graphing Counter Data

Usethe Graphsview of the runtime Conductor to create real-time graphs of counter data during script
execution. Smilar graphs are also available for post-test analysisin QALoad Analyze.

Selecting Countersto Graph

All counter datathat isavailable for graphing islocated in the tree view on the left side of the of the
Graphsview Data window, as shown below.
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Scripts of any middleware type collect the following default counter data, which isavailablein the
Conductor for real-time graphing:

! Global counters: Running VU%, total running VUs, and errors
I Script counters: Running VUs, response times, and transactions

I Player machine health: % processor, % memory used, % disk space, %disk time, % paging file
Additional middleware-based graphs are also generated by default and vary by middleware. For example,
for the WWW middleware, several performance-based counters are automatically collected and available

for graphing, including server responses and WWW traffic. You can monitor thisdatato determinethe
optimum rate of performance of the application that isrunning.

Graphing Counter Statistics

To choose a counter that should appear in a graph, highlight the checkpoint counter name or group of
counters (folder), right-click and choose either Add Graph to create a new graph or Add Plot To to add a
data plot to an existing graph.

If you choose the Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

To better identify problemsin thetest, you can set thresholdson plotsor graphsthat indicate the number
of timesthe datarecord for that counter has gone above or below the number you set. Thresholds can be
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set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to seeindividual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

Saving Counter Data Graphsto a Session ID

Counter data graphsthat are created in the Conductor are automatically saved to the current session 1D
file. To remove all graphsyou added, click Graph>Restore Default Graph Layout.
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Recording and Playing a Test

Recording a Test

Load tests can berecorded by selecting the Record Load Test option from the Conductor. When this
option isactivated and the load test begins, a prompt appears for you to specify afile name for the
recording. When the load test iscompleted, you can replay the test.

To set the Conductor to record a load test:

1. OntheTest Information tab of the Conductor's main window, select the Enable Test Recording
check box.

2. Sart theload test. The Record dialog box appears.
3. Typeaname for the record file. Click OK.

Replaying a Test

If you set the Conductor to record load tests, you can play them back after the test completes. Replaying a
recorded load test does not perform the actual load test. A replay provides a visual re-enactment of the
eventsthat took place during the load test.

To replay arecorded load test:

1. From the Conductor'sRun menu, choose Test Recording>Replay a Load Test. The Open Record
File dialog box appears.

2. Browse for therecording file (filename.rec) that you saved when the load test started. Click Open.

3. Thetest will play back in aviewer that contains a playback toolbar. Use the toolbar buttons
described in thefollowing table to control the playback.

P

Restartsthe test replay from the
beginning

Replaysthetest at normal speed

Replaysthe test twice as fast as
normal

Iil;l_

Replaysthe test four times asfast as
normal

k2

Pausesthereplay at the current
snapshot

Ii

Exitstest replay and opensthe
Conductor test setup window

TH
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Expert User

Overview of Expert User

Expert User provides an easy, logical guide for drilling down to the root performance problemsfor
applications. It enablesyou to break web pages down into their individual components, providing more
detailed response time data. Response time for each component isbroken into network and server time.

More detailed information helpstroubleshoot application performance problems. The ability to see timing
fileson acomponent level can spotlight where the majority of time isbeing spent. A breakdown of
network and server times per component can identify areas for improvement in either the network or
server hardware or configuration, or in application performance.

The main functionality is provided by a special virtual user (VU). When you enable the Expert User, this
VU collects more detailed information about requeststhat are made while the script isrunning. Every
main request and subrequest logsthe amount of server and network time used. Thishelps diagnose why
page loads may be taking longer than expected. For example, a particular subrequest, such as css, gif, html,
and so forth, may betaking moretimeto download from the server than other requests. Expert User data
can show you this. It also can help you determine whether the problem isanetwork or a server problem.

You enable Expert User from the Conductor, either before or during aload test. Expert User usesthe
existing custom counter support so Conductor can graph the custom counter information.

Oncetheload test iscomplete, you can view the datain Analyze. The Analyze Workspace includes an
Expert User tab, from which you can access detail reportsand graphson server and network data. The pre-
defined reportsinclude an Expert User report.

&l Note: Currently, Expert User capability is provided only for the WWW middleware.

Enabling Expert User

You can enable or disable the Expert User for each load test on a script, either before or during the load
test.

To enable Expert User before the load test begins:

1. In Conductor, click the Machine Assignment tab.

2. Clickin theMiddleware column to enable the Browse (...) button. Then, click Browse. The Expert
User Optionsdialog box displays.

Click Enable Expert User timings.
4. Typethe Virtual User (VU) number to represent the Expert User. The default VU number is zero (0).
5. Click OK.

To enable Expert User during the load test:

1. Select the script and any optionsfor the test.

2. From the Machine Assignment tab, and click the Run button, or click Run>Start Test. The Test
beginsand the Test menusdisplay.

3. Click Test Options>Expert User Options. The Update Expert User Options dialog box displays
listing all the scriptsthat support Expert User counters.
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4. Click the scriptsin which you want to enable Expert User, then click OK.
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Analyzing Load Test Data

Analyzing Load Test Data

By default, load test timing datais sent from the Conductor to Analyze at the end of aload test. Any
appropriate server monitoring data isalso sent to Analyze and merged into your timing file (.tim).

You can set an option in the Conductor to automatically launch Analyze at the end of aload test (details),
or you can open Analyze manually from the Conductor toolbar or your QALoad program group.

Creating a Timing Fle (.tim)

Once all workstations stop executing, click the Quit toolbar button @l to completethetest and
automatically create the timing file (.tim).

Viewing Test Statistics

Compute test statistics by choosing Launch Analyze from the Conductor’'s Toolsmenu or by clicking on
the Analyze Mtoolbar button.
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Integration and Server Monitoring

Server and Performance Monitoring

QALoad integrates several mechanismsfor merging load test response time data with server utilization data
and performance metrics. Select the method that best suitsyour needs, or for which you are licensed (if
applicable). Most methods produce datathat isincluded in your load test timing results and processed in
QALoad Analyze. The only exception is Application Vantage. Data captured from ApplicationVantage can
be opened in Application Vantage, but not in QALoad.

This section briefly describes each method, and provideslinksto more detailed information about setting
up atest that includesthe appropriate method.

I Remote Monitoring — allowsyou to monitor server utilization statistics from aremote machine
without installing any software on the remote machine.

I Server Analysis Agents— must beinstalled on each applicable machine.

I ServerVantage — integrates with your existing ServerVantage installation. You must be licensed for
and haveinstalled and configured the appropriate product in order to integrate with QALoad .

I ApplicationVantage — collectstest datathat you can open in Application Vantage.

Integration and Monitoring Requirements

Integration Requirements
ApplicationVantage

I QALoad supportsintegration with ApplicationVantage 10.0.

I Integration with ApplicationVantageis supported on the Windows platform only.
ServerVantage

I QALoad supportsintegration with ServerVantage (SVI Monitoring) 9.9 and 10.0.

I QALoad supportsintegration with ServerVantage (Remote Monitoring) 10.0 only.

ClientVantage
QALoad supportsintegration with ClientVantage 10.0.

Monitoring Requirements

In addition to the integration requirements, your system may need to meet specific requirementsto
support remote monitoring.

Server Analysis Agent Requirements
TCP/IP communications.

The Server Analysis Agent must be installed on the same Workstation/Server asthe QALoad Player and
therefore sharesthe same system requirements. However, Compuware recommendsthat you do not run
both the Server Analysis Agent and QALoad Player simultaneously on the same workstation, to make load
test management easier.
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MM Requirements

Oracle AS, SAP, WebLogic, WebSphere, and WebSphere MQ monitoring all require Java Virtual Machine
(VM) installed on the Conductor machine.

I For Oracle ASmonitoring, if monitoring Oracle AS10g, use VM 1.4 or later.

! For WebLogic monitoring version 7 and earlier versions, use M 1.3. For WebLogic version 8, you
must use WM 1.4 or later. You may also use the VM that isdistributed with the WebLogic
Application Server.

I For WebSphere monitoring, use the VM provided with the WebSphere client or server.
I For WebSphere MQ monitoring, you must use M 1.4 or later.
I For SAP monitoring, you must use M 1.4 or later.

Fle Installation Requirements

Oracle AS, SAP, WebLogic, WebSphere, and WebShere MQ, WMI, and Cold Fusion monitoring requirethe
following filesinstalled on the Conductor machine.

Oracle AS

For Oracle AS10g, you must store copies of the dms.jar, xmlparserv2.jar, ons.jar, and optic.jar files
from the monitored Oracle ASserver on the Conductor machine.

SAP Monitoring

The SAPfileslisted below must be placed on the Conductor machine:

o librfc32.dll
0 sapjco.jar
0 sapjcorfc

To obtain thesefiles, install the SAP Java Connector package (JCo) on the Conductor machine. The
JCo package is available from SAP. Add the location of thefiles, to the Path System Variable of the
Conductor machine. For moreinformation, refer to the Requirements for SAP Remote Monitoring
topicin the ServerVantage Reconfigure Agent Online Help.

WebLogic Monitoring

The weblogic.jar file must be placed in the Conductor machine. Copy thejar file from thelib directory
of the WebLogic application server to a separate directory in the Conductor machine. If you are
monitoring WebLogic version 8.1, copy the webservices.jar fileto the same directory. For more
information, refer to Requirements for WebLogic Remote Monitoringin the ServerVantage Reconfigure
Agent Online Help.

WebShere Monitoring

The WebSohere client filesmust be installed on the Conductor machine. Installing the WebSphere
Application Server Admin Server software on the Conductor machine providesthe necessary client
files. Note the directory path of the WebSphere\ AppServer\ Java files. For more information, refer to
Requirements for WebSphere Remote Monitoringin the ServerVantage Reconfigure Agent Online
Help.

WebSphere MQ Monitoring
The WebSphere client fileslisted below must be placed in adirectory in the Conductor machine.

0 com.ibm.mgq.jar
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0 com.ibm.mq.pcf.jar
0 connector.jar

Thefilesmay be obtained from theinstallation of the WebSphere Application Server Admin Server
software on the Conductor machine. If the installation doesnot include the com.ibm.mq.pcf.jar file,
obtain thefile from the IBM Support Pac M SOB. See "http://www-
l.ibm.com/support/docview.wss?rs=171& uid=swg24000668&loc=en_US& cs=utf-8&lang=en".

For more information, refer to Configuring WebSphere MQ for Remote Monitoringin the
ServerVantage Reconfigure Agent Online Help.
WMI Monitoring

WM security must be enabled on the monitored server machine and the WM service must be started.
For more information, refer to Configuring WM for Remote Monitoringin the ServerVantage
Reconfigure Agent Online Help.

Cold Fusion Monitoring

Performance Monitoring must be enabled from the Cold Fusion Administrator Page — Debugging
Settings of the monitored server machine. Cold Fusion is available under Windows Registry
monitoring.

Java Virtual Machine (VM) Monitoring

QALoad usesthe M X agent. To enable and configure the M X agent, you must set certain system
propertieswhen you start the WM. The following isan example of the system properties set for VM
monitoring without authentication:

0 Dcom.sun.management.jmxremote.port=1090
0 Dcom.sun.management.jmxremote.ssl=false
0 Dcom.sun.management.jmsremote.authenticate=false

To turn on java authentication, set up the parameter Dcom.sun.management.jmsremote.authenticate
astrue.

For more information, go to
http://java. sun.conlj2se/1.5. 0/ docs/ gui de/ managenent / agent . ht ml #properties

Host Verification for QALoad Monitoring

I Ensure host accessibility. Add an entry for the monitored machine to the system hosts file of the
Conductor machine. Consult the network administrator for more information.

I Test host availability. Type the following command at the Run command: ping <noni t or ed
machi ne nane>.

Remote Monitoring

Overview of Remote Monitoring

Remote Monitoring enables you to extract data from Windows Registry, Oracle Application Server (AS),
SAP, SNMP, WebLogic, WebSphere, WebSphere MQ, and WMI counterson the serversunder stress without
installing any software on the servers.

Note: Select counters for monitor typesin the application.

To use Remote Monitoring:
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I You must have login accessto the machinesyou want to monitor.

I You must select the serversand countersto monitor on the machinesyou identify using the
monitoring optionson Conductor's Monitoring Optionstab.

I To collect SNMP counters, SNMP must be enabled on the Remote Monitor machine. Refer to your
operating system help for information about enabling SNMP.

I To collect Windows registry counters, you must have avalid sign-on for the serversunder test.

I Forrequirementsfor Oracle AS, SAP, WebLogic, WebShere, WebSphere MQ, and WM, see
Integration and Monitoring Requirements.

QALoad uses default portswhen it communicateswith the ServerVantage agent and client:
I For ServerVantage Java clients - QALoad uses 7790.
I For ServerVantage NT agents - QALoad uses 7788

You can override the default portsif your ServerVantage installation requiresit.

While your test isrunning, QALoad collectsthe appropriate counter data and writesit to your timing file
whereyou can view it in Analyze after the test. What counters are available?

You can simplify the configuration process by creating or applying pre-defined monitoring templates. A
monitoring templateisa predefined group of counters not associated with a specific machine.

To set up Remote Monitoring, see Creating a New Monitoring Task.

Monitoring Counters
About Counters and Instances

You use countersand, in some cases, specific instances of counters when you monitor servers.

Counters

Countersarethe numeric data valuesthat are collected when monitoring servers. Counters exist for
componentssuch as processor, memory, processes, hard disk, and cache, with a set of countersthat
measure statistical information. For Windows, a large number of performance counters are provided by
the operating system registry and Windows server applications. Registry counters can monitor external
componentsof the environment such as databases, applications, and printers.

Many of the countersthat are collected are pointsin time data values, such as Process\ thread count. Some
counters are cumulative, such as server logon errors, and some are averages, such asthe page faults per
second in Job Object Details.

In addition to the numeric value counters, a set of extended data countersis provided for a number of key
performance indicators. These extended data counters can provideintelligent data pointsthat have
associated textual data for the numeric value. For example, the extended CPU usage counter'sintelligent
datapoint showsthe top 10 processes consuming CPU at that time.

Instances

When you select a counter to monitor, the available instances, or occurrences, for that counter appear.
Counters can have several instances or no instances. For example, if a system has multiple processors, then
the Processor counter has multiple instances. For counterswith multipleinstances, alist of the available
instances for that counter is presented. Many countersalso have an instance called _Total, which isan
aggregate of the individual instances.

Countersfor an object, such as processor, have instancesthat are numbered, beginning with 0 (zero). A
machine with a single processor has an instance of _Total and 0. A dual-processor machine hasinstances of
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_Total, 0, and 1. Other instances are based on what iscurrently running on the server, and the instance list
displaysthese for each processname or service name that is active.

Some instances represent the most recent value for the resource, for example, Processes. Thisisthe number
of processesin the computer at the time of data collection. Other instances are average values between the
last two measurements.

Counter Types

Countersarethe numeric data valuesthat are collected when you monitor servers. Counters exist for
componentssuch as processor, memory, processes, hard disk, and cache, with a set of countersthat
measure statistical information.

A set of extended data countersisprovided for anumber of key performance indicators. These extended
data counterscan provideintelligent data pointsthat have associated textual data for the numeric value.
For example, the extended CPU usage counter'sintelligent datapoint showsthetop 10 processes
consuming CPU.

QALoad's Remote Monitor Agents can monitor the following counter types:
Windows Win2K Registry Counters
Windows NT Registry Counters
Oracle Application Server Counters
VM Counters

SAP Counters

SNMP Counters

WebLogic Counters

WebShere Counters

WebSphere MQ Counters

WMI Counters

Windows NT Registry Counters

Windows NT Registry Server Counters

QALoad supportsthe following MSWindows NT Server counter categories:

Counter Category Description

Active Server Pages This object type handlesthe Active Server Pages device on your
system.

Browser This object type displays Browser Satistics.

Cache The Cache object type manages memory for rapid accessto files. Files

on Windows NT are cached in main memory in units of pages. Main
memory not being used in the working sets of processesis available to
the Cache for this purpose. The Cache preservesfile pagesin memory
for aslong as possible to permit accessto the datathrough the file
system without accessing the disk.

Context Index This object type handlesthe Content Index.

Context Index Flter This object type handlesthe Content Index Flter.
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ICMP

The ICMP object type includesthe countersthat describe the ratesthat
ICMP Messages are received and sent by a certain entity using the
ICMP protocol. It also describes various error countsfor the ICMP
protocol.

This object type includesthose countersthat describe the ratesthat IP
datagrams are received and sent by a certain computer using the IP
protocol. It also describes various error countsfor the IP protocol.

LogicalDisk

A LogicalDisk object type isa partition on a hard or fixed disk drive
and assigned a drive letter, such as C. Disks can be partitioned into
distinct sectionswhere they can store file, program, and page data. The
disk isread to retrieve these items and written to record changesto
them.

Memory

The Memory object type includesthose countersthat describe the
behavior of both real and virtual memory on the computer. Real
memory isallocated in units of pages. Virtual memory can exceed real
memory in size, causing page traffic asvirtual pages are moved
between disk and real memory.

Network Interface

The Network Interface Object Type includesthose countersthat
describe the ratesthat bytes and packets are received and sent over a
Network TCP/IP connection. It also describes various error counts for
the same connection.

Objects

The Objects object type is a meta-object that containsinformation
about the objectsin existence on the computer. Thisinformation can
be used to detect the unnecessary consumption of computer resources.
Each object requires memory to store basic information about the
object.

Paging File

This object displaysinformation about the system's Page File(s).

PhysicalDisk

A PhysicalDisk object type isahard or fixed disk drive. It contains 1 or
more logical partitions. Disks are used to store file, program, and
paging data. The disk isread to retrieve these items and written to
record changesto them.

Process

The Process object typeis created when a program isrun. All the
threadsin a process share the same address space and have accessto
the same data.

Process Address Space

Process Address Space object type displays details about the virtual
memory usage and allocation of the selected process.

Processor

The Processor object type includes asinstances all processors on the
computer. A processor isthe part in the computer that performs
arithmetic and logical computations, and initiates operations on
peripherals. It executes (such asruns) programson the computer.

Redirector

The Redirector isthe object that manages network connectionsto
other computersthat originate from your own computer.

Server

The Server object typeisthe processthat interfaces the services from
thelocal computer to the network services.
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Server Work Queues The Server Work Queues object type handles explain text performance
data.

SMTP Server This object type handlesthe counters specific to the SMTP Server.

System This object type includesthose countersthat apply to all processorson

the computer collectively. These countersrepresent the activity of all
processorson the computer.

TCP The TCP object typeincludesthe countersthat describe theratesthat
TCP Segments are received and sent by a certain entity using the TCP
protocol. In addition, it describesthe number of TCP connectionsin
each possible TCP connection state.

Telephony This object type handlesthe Telephony System.

Thread The Thread object type isthe basic object that executesinstructionsin
a processor. Every running process has at least one thread.

UDP The UDP object typeincludesthe countersthat describe the ratesthat
UDP datagrams are received and sent by a certain entity using the UDP
protocol. It also describes various error countsfor the UDP protocol.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows NT. This object type handlesthese registry
counters:

Debugging Requests Requests Rejected
Errors During Script Runtime Requests Succeeded
Errors From ASP Preprocessor Requests Timed Out
Errors From Script Compilers Requests Total
Errors/Sec Script Engines Cached
Memory Allocated Session Duration
Request BytesIn Total Sessions Current
Request Bytes Out Total Sessions Timed Out
Request Execution Time Sessions Total

Request Wait Time Template Cache Hit Rate
Requests/ Sec Template Notifications
Requests Disconnected Templates Cached
Requests Executing Transactions/ Sec
Requests Failed Total Transactions Aborted
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Requests Not Authorized Transactions Committed
Requests Not Found Transactions Pending
Requests Queued Transactions Total

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows NT. This object type handlesthese registry counters:

Announcements Domain/sec Mailslot Allocations Failed
Announcements Server/sec Mailslot Opens Failed/sec
Announcements Total/sec Mailslot Receives Failed

Duplicate Master Announcements Mailslot Writes/sec

Election Packets/sec Mailslot Writes Failed

Enumerations Domain/sec Missed Mailslot Datagrams
Enumerations Other/sec Missed Server Announcements
Enumerations Server/sec Missed Server List Requests
Enumerations Total/sec Server Announce Allocations Failed/sec
Illegal Datagrams/sec Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Cache Counters

QALoad supportsthe Cache category for Windows NT. This object type handlesthese registry counters:

Async Copy Reads/sec Fast Reads/sec

Async Data Maps/sec Lazy Write Hushes/sec
Async Fast Reads/sec Lazy Write Pages/sec
Async MDL Reads/sec MDL Read Hits %
Async Pin Reads/sec MDL Reads/sec

Copy Read Hits % Pin Read Hits %

Copy Reads/sec Pin Reads/sec
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Data Hush Pages/sec
Data Hushes/sec
Data Map Hits %
Data Map Pins/sec

Data Maps/sec

Read Aheads/sec
Sync Copy Reads/sec
Sync Data Maps/sec
Sync Fast Reads/sec

Sync MDL Reads/sec

Conductor

Fast Read Not Possibles/sec Sync Pin Reads/sec

Fast Read Resource Misses/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Filter Counters

QALoad supportsthe Content Index Filter category for Windows NT. Thisobject type handlesthese
registry counters:

Binding time (msec) Total filter speed (MBytes/hr)

Filter speed (MBytes/hr)

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Counters

QALoad supportsthe Content Index category for Windows NT. This object type handlesthese registry
counters:

# documentsfiltered Running queries
Flesto befiltered Total # documents
Index size (MBytes) Unique keys
Merge progress Wordlists

Persistent indexes

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

ICMP Counters
QALoad supportsthe ICMP category for Windows NT. This object type handlesthese registry counters:
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M essages/ sec

M essages Outbound Errors
M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec
Received Parameter Problem
Received Redirect/sec
Received Source Quench

Received Time Exceeded

Received Timestamp/sec
Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded

Sent Timestamp/sec

Sent Timestamp Reply/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows NT. This object type handlesthese registry counters:

Datagrams/sec Datagrams Received Unknown Protocol
Datagrams Forwarded/sec Datagrams Sent/sec
Datagrams Outbound Discarded Fragment Re-assembly Failures
Datagrams Outbound No Route Fragmentation Failures
Datagrams Received/sec Fragmented Datagrams/sec
Datagrams Received Address Errors Fragments Created/sec
Datagrams Received Delivered/sec Fragments Re-assembled/sec
Datagrams Received Discarded Fragments Received/sec

Datagrams Received Header Errors
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

LogicalDisk Counters

QALoad supportsthe LogicalDisk category for Windows NT. This object type handlesthese registry

counters:

% Disk Read Time

% Disk Time

% Disk Write Time

% Free Space

Avg. Disk Bytes/Read

Avg. Disk Bytes/ Transfer
Avg. Disk Bytes/Write

Avg. Disk Queue Length

Avg. Disk Read Queue Length
Avg. Disk sec/Read

Avg. Disk sec/Transfer

Avg. Disk sec/Write

Avg. Disk Write Queue Length
Current Disk Queue Length
Disk Bytes/sec

Disk Read Bytes/sec

Disk Reads/sec

Disk Transfers/sec

Disk Write Bytes/sec

Disk Writes/sec

Free Megabytes

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Memory Counters

QALoad supportsthe Memory category for Windows NT. This object type handles these registry counters:

% Committed BytesIn Use
Available Bytes

Cache Bytes

Cache Bytes Peak

Cache Faults/sec

Commit Limit

Committed Bytes

Demand Zero Faults/sec

Free System Page Table Entries

Pages Output/sec

Pool Nonpaged Allocs

Pool Nonpaged Bytes

Pool Paged Allocs

Pool Paged Bytes

Pool Paged Resident Bytes
System Cache Resident Bytes
System Code Resident Bytes

System Code Total Bytes
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Page Faults/sec
Page Reads/sec
Page Writes/sec

Pages/sec

System Driver Resident Bytes
System Driver Total Bytes
Transition Faults/sec

Write Copies/sec

Pages Input/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows NT. This object type handlesthese registry
counters:

Bytes Received/sec Packets Received Discarded

Bytes Sent/sec Packets Received Errors
Bytes Total/sec Packets Received Non-Unicast/sec
Current Bandwidth Packets Received Unicast/sec
Output Queue Length Packets Received Unknown
Packets/sec Packets Sent/sec
Packets Outbound Discarded Packets Sent Non-Unicast/sec
Packets Outbound Errors Packets Sent Unicast/sec

Packets Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Object Counters

QALoad supportsthe Objects category for Windows NT. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Paging File Counters

QALoad supportsthe Paging File category for Windows NT. This object type handlesthese registry
counters:

% Usage % Usage Peak

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Physical Disk Counters

QALoad supportsthe Physical Disk category for Windows NT. Thisobject type handlesthese registry
counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
Avg. Disk Bytes/Read Disk Bytes/sec

Avg. Disk Bytes/Transfer Disk Read Bytes/sec

Avg. Disk Bytes/Write Disk Reads/sec

Avg. Disk Queue Length Disk Transfers/sec

Avg. Disk Read Queue Length Disk Write Bytes/sec

Avg. Disk sec/Read Disk Writes/sec

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Address Space Counters

QALoad supportsthe Process Address category for Windows NT. This object type handlesthese registry
counters:

Bytes Free Mapped Space Read Only

Bytes Image Free Mapped Space Write Copy
Bytes Image Reserved Reserved Space Exec Read/Write
Bytes Reserved Reserved Space Exec Read Only
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ID Process

Image Sace Exec Read/Write
Image Sace Exec Read Only
Image Sace Exec Write Copy
Image Sace Executable

Image Space No Access

Image Sace Read/Write

Image Sace Read Only

Image Sace Write Copy
Mapped Space Exec Read/Write
Mapped Space Exec Read Only
Mapped Space Exec Write Copy
Mapped Space Executable
Mapped Space No Access

Mapped Space Read/Write

For information on theregistry countersrefer to the documentation or developer network for that product

Reserved Space Exec Write Copy
Reserved Space Executable
Reserved Sace No Access

Reserved Space Read/Write
Reserved Sace Read Only
Reserved Space Write Copy
Unassigned Space Exec Read/Write
Unassigned Space Exec Read Only
Unassigned Sace Exec Write Copy
Unassigned Space Executable
Unassigned Space No Access
Unassigned Sace Read/Write
Unassigned Space Read Only

Unassigned Space Write Copy

or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Counters

QALoad supportsthe Process category for Windows NT. This object type handlesthese registry counters:

% Privileged Time

% Processor Time (See Note below)
% User Time

Elapsed Time

Handle Count

ID Process

Page Faults/sec

Page File Bytes

Page File Bytes Peak
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Pool Nonpaged Bytes
Pool Paged Bytes
Priority Base

Private Bytes

Thread Count
Virtual Bytes

Virtual Bytes Peak
Working Set

Working Set Peak



Conductor

Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or more
occurrences of the event. The CPU consumption for the first datapoint sample is artificially high because the

agent is starting the task.

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Processor Counters

QALoad supportsthe Processor category for Windows NT. This object type handlesthese registry counters:

% DPC Time

% Interrupt Time
% Privileged Time
% Processor Time

% User Time

APC Bypasses/sec
DPC Bypasses/sec
DPC Rate

DPCs Queued/sec

Interrupts/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Redirector Counters

QALoad supportsthe Redirector category for Windows NT. This object type handlesthese registry counters:

Bytes Received/sec

Bytes Total/sec

Bytes Transmitted/sec
Connects Core

Connects Lan Manager 2.0
Connects Lan Manager 2.1
Connects Windows NT
Current Commands

File Data Operations/sec
File Read Operations/sec
File Write Operations/sec
Network Errors/sec
Packets/sec

Packets Received/sec

Read Operations Random/sec
Read Packets/sec

Read Packets Small/sec

Reads Denied/sec

Reads Large/sec

Server Disconnects

Server Reconnects

Server Sessions

Server Sessions Hung

Write Bytes Cache/sec

Write Bytes Network/sec
Write Bytes Non-Paging/sec
Write Bytes Paging/sec

Write Operations Random/sec

51



QALoad 05.06 Using the Conductor

Packets Transmitted/sec Write Packets/sec

Read Bytes Cache/sec Write Packets Small/sec
Read Bytes Network/sec Writes Denied/sec

Read Bytes Non-Paging/sec Writes Large/ sec

Read Bytes Paging/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Counters

QALoad supportsthe Server category for Windows NT. This object type handles these registry counters:

Blocking Requests Rejected Logon Total

Bytes Received/sec Pool Nonpaged Bytes
Bytes Total/sec Pool Nonpaged Failures
Bytes Transmitted/sec Pool Nonpaged Peak
Context Blocks Queued/sec Pool Paged Bytes
Errors Access Permissions Pool Paged Failures
Errors Granted Access Pool Paged Peak
Errors Logon Server Sessions
Errors System Sessions Errored Out
File Directory Searches Sessions Forced Off
Files Open Sessions Logged Off
Files Opened Total Sessions Timed Out
Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows NT. This object type handles these registry
counters:

Active Threads Queue Length
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Available Threads
Available Work Items
Borrowed Work Items
Bytes Received/sec

Bytes Sent/sec

Bytes Transferred/sec
Context Blocks Queued/sec

Current Clients

Conductor

Read Bytes/sec
Read Operations/sec
Total Bytes/sec
Total Operations/sec
Work Item Shortages
Write Bytes/sec

Write Operations/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP Server Counters

QALoad supportsthe SMTP Server category for Windows NT. This object type handlesthese registry

counters:

% Recipients Local

% Recipients Remote

Avg Recipients/msg Received
Avg Recipients/msg Sent

Avg Retriesymsg Delivered

Avg Retriesymsg Sent

Base % Recipients Local

Base % Recipients Remote
Base Avg Recipients/msg Received
Base Avg Recipients/msg Sent
Base Avg Retriesymsg Delivered
Base Avg Retriessmsg Sent
Bytes Received/sec

Bytes Received Total

Bytes Sent/sec

Bytes Sent Total

M essage Bytes Received/sec

M essage Bytes Received Total

M essage Bytes Sent/sec

M essage Bytes Sent Total

M essage Bytes Total

M essage Bytes Total/sec

Message Delivery Retries

M essage Received/sec

Message Send Retries

M essages Delivered/sec

Messages Delivered Total

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects
M essages Refused for Sze

M essages Retrieved/sec
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Bytes Total

Bytes Total/sec

Connection Errors/sec
Directory Drops/sec

Directory Drops Total
Directory Pickup Queue Length
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
Inbound Connections Total
Local Queue Length

Local Retry Queue Length

M essages Retrieved Total

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open
Number of QueueFiles Open
Outbound Connections Current
Outbound Connections Refused
Outbound Connections Total
Remote Queue Length

Remote Retry Queue Length
Routing Table Lookups/sec
Routing Table Lookups Total

Total Connection Errors

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

System Counters

QALoad supportsthe System category for Windows NT. This object type handlesthese registry counters:

% Registry Quotaln Use
% Total DPC Time

% Total Interrupt Time
% Total Privileged Time
% Total Processor Time
% Total User Time
Alignment Fixups/sec
Context Switches/sec
Exception Dispatches/sec

File Control Bytes/sec
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File Read Operations/sec
File Write Bytes/sec

File Write Operations/sec
Hoating Emulations/sec
Processor Queue Length
System Calls/sec

System Up Time

Total APC Bypasses/sec
Total DPC Bypasses/sec

Total DPC Rate



Conductor

File Control Operations/sec Total DPCs Queued/sec
File Data Operations/sec Total Interrupts/sec

File Read Bytes/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

TCP Counters

QALoad supportsthe TCP category for Windows NT. This object type handlesthese registry counters:

Connection Failures Segments/sec

Connections Active Segments Received/sec
Connections Established Segments Retransmitted/sec
Connections Passive Segments Sent/sec

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Telephony Counters

QALoad supportsthe Telephony category for Windows NT. This object type handlesthese registry
counters:

Active Lines Incoming Calls/sec
Active Telephones Lines

Client Apps Outgoing Calls/sec
Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Thread Counters

QALoad supportsthe Thread category for Windows NT. This object type handlesthese registry counters:

% Privileged Time ID Thread

% Processor Time Priority Base
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% User Time Priority Current
Context Switches/sec Sart Address
Elapsed Time Thread Sate

ID Process Thread Wait Reason

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

UDP Counters

QALoad supportsthe UDP category for Windows NT. This object type handles these registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Windows Win2K Registry Counters

WindowsWin2K Server Registry Counters

Remote Monitoring Agents can monitor the same Windows registry counters as PERFMON, the
performance monitoring application available with the Windows operating system. The Windows registry
option monitors machinesthat run Windows 2000 and XP. To retrieve Windows Registry Counters, you
must have access, viaa user name and password, to the remote machine.

QALoad supportsthe following MSWindows counter categories:

Counter Category Description

ACYRSVP Service RSVP or ACSservice performance counters.

Active Server Pages This object type handlesthe Active Server Pages device on your
system.

Browser The Browser performance object consists of countersthat measure the

rates of announcements, enumerations, and other Browser
transmissions.

Cache The Cache performance object consists of countersthat monitor the
file system cache, an area of physical memory that storesrecently used
data aslong as possible to permit accessto the data without reading
from the disk. Because applicationstypically usethe cache, the cache
ismonitored as an indicator of application I/O operations. When
memory is plentiful, the cache can grow, but when memory is scarce,
the cache can become too small to be effective.

56



IAS Accounting Clients

Conductor

IAS Accounting Clients

IAS Accounting Server

IAS Accounting Server

IAS Authentication Clients

IAS Authentication Clients

IAS Authentication Server

IAS Authentication Server

ICMP

The ICMP performance object consists of countersthat measure the
rates at which messages are sent and received by using ICMP
protocols. It also includes countersthat monitor ICMP protocol errors.

The IP performance object consists of countersthat measure the rates
at which IP datagrams are sent and received by using IP protocols. It
also includes countersthat monitor IP protocol errors.

LogicalDisk

The Logical Disk performance object consists of countersthat monitor
logical partitions of ahard or fixed disk drives. Performance Monitor
identifies logical disks by their adrive letter, such asC.

Memory

The Memory performance object consists of countersthat describe the
behavior of physical and virtual memory on the computer. Physical
memory isthe amount of random access memory on the computer..
Virtual memory consists of the space in physical memory and on disk.
Many of the memory counters monitor paging, which isthe
movement of pages of code and data between disk and physical
memory. Excessive paging, a symptom of amemory shortage, can
cause delayswhich interfere with all system processes.

NBT Connection

The NBT Connection performance object consists of countersthat
measure the rates at which bytes are sent and received over the NBT
connection between thelocal computer and aremote computer. The
connection isidentified by the name of the remote computer.

Network Interface

The Network Interface performance object consists of countersthat
measure the rates at which bytesand packets are sent and received
over a TCP/IP network connection. It includes countersthat monitor
connection errors.

Objects

The Object performance object consists of countersthat monitor
logical objectsin the system, such as processes, threads, mutexes, and
semaphores. Thisinformation can be used to detect the unnecessary
consumption of computer resources. Each object requires memory to
store basic information about the object.

Paging File

The Paging File performance object consists of countersthat monitor
the paging file(s) on the computer. The paging fileis areserved space
on disk that backs up committed physical memory on the computer.

PhysicalDisk

The Physical Disk performance object consists of countersthat
monitor hard or fixed disk drive on a computer. Disks are used to store
file, program, and paging data and areread to retrieve these items, and
written to record changesto them. The values of physical disk
countersare sums of the values of the logical disks (or partitions) into
which they are divided.
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Print Queue

Displays performance statistics about a Print Queue.

Process

The Process performance object consists of countersthat monitor
running application program and system processes. All the threadsin
aprocess share the same address space and have accessto the same
data.

Process Address Sace

The Process Address Space performance object consists of counters
that monitor memory allocation and use for a selected process.

Processor

The Processor performance object consists of countersthat measure
aspects of processor activity The processor isthe part of the computer
that performsarithmetic and logical computations, initiates
operationson peripherals, and runsthe threads of processes. A
computer can have multiple processors. The processor object
represents each processor as an instance of the object.

Redirector

The Redirector performan ce object consists of counter that monitor
network connectionsoriginating at the local computer.

Server

The Server performance object consists of countersthat measure
communication between thelocal computer and the network.

Server Work Queues

The Server Work Queues performance object consists of countersthat
monitor the length of the queues and objectsin the queues.

SMTP NTFS Sore Driver

This object represents global counters for the Exchange NTFS Sore
driver.

SMTP Server The counters specific to the SMTP Server.

System The System performance object consists of countersthat apply to
more than oneinstance of acomponent processors on the computer.

TCP The TCP performance object consists of countersthat measure the
rates at which TCP Segments are sent and received by using the TCP
protocol. It includes countersthat monitor the number of TCP
connectionsin each TCP connection state.

Telephony The Telephony System.

Thread The Thread performance object consists of countersthat measure
aspects of thread behavior. A thread isthe basic object that executes
instructionson aprocessor. All running processes have at least one
thread.

UDP The UDP performance object consists of countersthat measure the

rates at which UDP datagrams are sent and received by using the UDP
protocol. It includes countersthat monitor UDP protocol errors.

ACSRSVP Service Counters

QALoad supportsthe ACSRSVP Service category for Windows. This object type handlesthese registry

counters:
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API notifications Interfaces

APl sockets Network sockets
Bytesin API notifies PATH from API

Failed API requests RESV from API

Failed APl sends RSVP msg buffersin use
GQOSsessions Timers

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows. This object type handlesthese registry
counters:

Debugging Requests Requests Succeeded
Errors/Sec Requests Timed Out
Errors During Script Runtime Requests Total

Errors From ASP Preprocessor Script Engines Cached
Errors From Script Compilers Session Duration
Request BytesIn Total Sessions Current
Request Bytes Out Total Sessions Timed Out
Request Execution Time Sessions Total

Request Wait Time Template Cache Hit Rate
Requests/ Sec Template Notifications
Requests Disconnected Templates Cached
Requests Executing Transactions/ Sec
Requests Failed Total Transactions Aborted
Requests Not Authorized Transactions Committed
Requests Not Found Transactions Pending
Requests Queued Transactions Total
Requests Rejected
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows. This object type handlesthese registry counters:

Announcements Domain/sec Mailslot Allocations Failed
Announcements Server/sec Mailslot Opens Failed/sec
Announcements Total/sec Mailslot Receives Failed

Duplicate Master Announcements Mailslot Writes/sec

Election Packets/sec Mailslot Writes Failed

Enumerations Domain/sec Missed Mailslot Datagrams
Enumerations Other/sec Missed Server Announcements
Enumerations Server/sec Missed Server List Requests
Enumerations Total/sec Server Announce Allocations Failed/sec
Illegal Datagrams/sec Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Cache Win2K Counters

QALoad supportsthe Cache category for Windows. This object type handlesthese registry counters:

Async Copy Reads/sec Fast Reads/sec

Async Data Maps/sec Lazy Write Hushes/sec
Async Fast Reads/sec Lazy Write Pages/sec
Async MDL Reads/sec MDL Read Hits %
Async Pin Reads/sec MDL Reads/sec

Copy Read Hits % Pin Read Hits %

Copy Reads/sec Pin Reads/sec

Data Fush Pages/sec Read Aheads/sec

Data FHushes/sec Sync Copy Reads/sec
Data Map Hits % Sync Data Maps/sec
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Data Map Pins/sec
Data Maps/sec
Fast Read Not Possibles/sec

Fast Read Resource Misses/ sec

Conductor

Sync Fast Reads/sec
Sync MDL Reads/sec

Sync Pin Reads/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Accounting Clients Counters

QALoad supportsthe IASAccounting Clients category for Windows. This object type handlesthese registry

counters:

Accounting-Requests
Accounting-Requests/sec
Accounting-Responses
Accounting-Responses/sec

Bad Authenticators

Bad Authenticators/sec
Dropped Packets

Dropped Packets/sec

Duplicate Accounting-Requests

Duplicate Accounting-Requests/sec

Malformed Packets
Malformed Packets/sec
No Record

No Record/sec

Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Accounting Server Counters

QALoad supportsthe IAS Accounting Server category for Windows. This object type handlesthese registry

counters:

Accounting-Requests
Accounting-Requests/sec
Accounting-Responses

Accounting-Responses/sec

Malformed Packets

Malformed Packets/sec

No Record

No Record/sec
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Bad Authenticators Packets Received
Bad Authenticators/sec Packets Received/sec
Dropped Packets Packets Sent
Dropped Packets/sec Packets Sent/sec
Duplicate Accounting-Requests Server Reset Time
Duplicate Accounting-Requests/sec Server Up Time
Invalid Requests Unknown Type
Invalid Requests/sec Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Clients Win2K Counters

QALoad supportsthe IAS Authentication Clients category for Windows. This object type handlesthese
registry counters:

Access-Accepts Dropped Packets/sec
Access-Accepts/ sec Duplicate Access-Requests
Access-Challenges Duplicate Access-Requests/sec
Access-Challenges/sec Malformed Packets
Access-Rejects Malformed Packets/sec
Access-Rejects/sec Packets Received
Access-Requests Packets Received/sec
Access-Requests/sec Packets Sent

Bad Authenticators Packets Sent/sec

Bad Authenticators/sec Unknown Type

Dropped Packets Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Server Counters

QALoad supportsthe IAS Authentication Server category for Windows. This object type handlesthese
registry counters:
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Access-Accepts
Access-Accepts/ sec
Access-Challenges
Access-Challenges/sec
Access-Rejects
Access-Rejects/sec
Access-Requests
Access-Requests/sec
Bad Authenticators
Bad Authenticators/sec
Dropped Packets
Dropped Packets/sec

Duplicate Access-Requests

Conductor

Duplicate Access-Requests/sec
Invalid Requests
Invalid Requests/sec
Malformed Packets
Malformed Packets/sec
Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec

Server Reset Time
Server Up Time
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

ICMP Counters

QALoad supportsthe ICMP category for Windows. This object type handlesthese registry counters:

M essages/ sec

M essages Outbound Errors

M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec

Received Parameter Problem

Received Timestam p/sec
Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded
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Received Redirect/sec Sent Timestam p/sec
Received Source Quench Sent Timestamp Reply/sec

Received Time Exceeded

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows. This object type handlesthese registry counters:

Datagrams/sec Datagrams Received Unknown Protocol
Datagrams Forwarded/sec Datagrams Sent/sec

Datagrams Outbound Discarded Fragment Re-assembly Failures
Datagrams Outbound No Route Fragmentation Failures

Datagrams Received/sec Fragmented Datagrams/sec

Datagrams Received Address Errors Fragments Created/sec

Datagrams Received Delivered/sec Fragments Re-assembled/sec
Datagrams Received Discarded Fragments Received/sec

Datagrams Received Header Errors

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

LogicalDisk Counters

QALoad supportsthe LogicalDisk category for Windows. This object type handlesthese registry counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
% Free Ypace Disk Bytes/sec

% Idle Time Disk Read Bytes/sec

Avg. Disk Bytes/Read Disk Reads/sec

Avg. Disk Bytes/ Transfer Disk Transfers/sec

Avg. Disk Bytes/Write Disk Write Bytes/sec
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Avg. Disk Queue Length
Avg. Disk Read Queue Length
Avg. Disk sec/Read

Avg. Disk sec/Transfer

Conductor

Disk Writes/sec
Free Megabytes

Split 10/Sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Memory Counters

QALoad supportsthe Memory category for Windows. This object type handles these registry counters:

% Committed BytesIn Use
Available Bytes

Cache Bytes

Cache Bytes Peak

Cache Faults/sec

Commit Limit

Committed Bytes

Demand Zero Faults/sec
Free System Page Table Entries
Page Faults/sec

Page Reads/sec

Page Writes/sec

Pages/sec

Pages Input/sec

Pages Output/sec

Pool Nonpaged Allocs

Pool Nonpaged Bytes

Pool Paged Allocs

Pool Paged Bytes

Pool Paged Resident Bytes

System Cache Resident Bytes
System Code Resident Bytes
System Code Total Bytes

System Driver Resident Bytes
System Driver Total Bytes

System VLM Commit Charge
System VLM Commit Charge Peak
System VLM Shared Commit Charge
Transition Faults/sec

Write Copies/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

NBT Connection Counters

QALoad supportsthe NBT Connection category for Windows. This object type handlesthese registry

counters:
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Bytes Received/sec Bytes Total/sec

Bytes Sent/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows. This object type handlesthese registry
counters:

Bytes Received/sec Packets Received Discarded

Bytes Sent/sec Packets Received Errors

Bytes Total/sec Packets Received Non-Unicast/sec
Current Bandwidth Packets Received Unicast/sec
Output Queue Length Packets Received Unknown
Packets/sec Packets Sent/sec

Packets Outbound Discarded Packets Sent Non-Unicast/sec
Packets Outbound Errors Packets Sent Unicast/sec

Packets Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Objects Counters

QALoad supportsthe Objects category for Windows. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Paging File Counters

QALoad supportsthe Paging File category for Windows. This object type handlesthese registry counters:

% Usage % Usage Peak
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

PhysicalDisk Counters

QALoad supportsthe PhysicalDisk category for Windows. Thisobject type handlesthese registry counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
% ldle Time Disk Bytes/sec

Avg. Disk Bytes/Read Disk Read Bytes/sec

Avg. Disk Bytes/ Transfer Disk Reads/sec

Avg. Disk Bytes/Write Disk Transfers/sec

Avg. Disk Queue Length Disk Write Bytes/sec

Avg. Disk Read Queue Length Disk Writes/sec

Avg. Disk sec/Read Slit 10/Sec

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Print Queue Counters

QALoad supportsthe Print Queue category for Windows. This object type handlesthese registry counters:

Add Network Printer Calls Max References
Bytes Printed/sec Not Ready Errors
Enumerate Network Printer Calls Out of Paper Errors
Job Errors Referen ces

Jobs Total Jobs Printed
Jobs Sooling Total Pages Printed

Max Jobs Spooling

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Process Address Space Counters

QALoad supportsthe Process Address Space category for Windows. This object type handles these registry

counters:

Bytes Free

Bytes Image Free

Bytes Image Reserved

Bytes Reserved

ID Process

Image Sace Exec Read/Write
Image Sace Exec Read Only
Image Sace Exec Write Copy
Image Sace Executable

Image Space No Access

Image Sace Read/Write

Image Sace Read Only

Image Space Write Copy
Mapped Space Exec Read/Write
Mapped Space Exec Read Only
Mapped Space Exec Write Copy
Mapped Space Executable
Mapped Space No Access

Mapped Space Read/Write

For information on theregistry countersrefer to the documentation or developer network for that product

Mapped Space Read Only

Mapped Space Write Copy
Reserved Space Exec Read/Write
Reserved Space Exec Read Only
Reserved Space Exec Write Copy
Reserved Space Executable
Reserved Space No Access

Reserved Space Read/Write
Reserved Sace Read Only
Reserved Space Write Copy
Unassigned Space Exec Read/Write
Unassigned Space Exec Read Only
Unassigned Sace Exec Write Copy
Unassigned Space Executable
Unassigned Space No Access
Unassigned Sace Read/Write
Unassigned Space Read Only

Unassigned Space Write Copy

or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Process Counters

QALoad supportsthe Process category for Windows. This object type handles these registry counters:

% Privileged Time

% Processor Time (See Note below.)

% User Time
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Creating Process ID
Elapsed Time
Handle Count

ID Process

10 Data Bytes/sec

IO Data Operations/sec

1O Other Bytes/sec

IO Other Operations/sec

IO Read Bytes/sec

Page File Bytes Peak

Pool Nonpaged Bytes

Pool Paged Bytes
Priority Base
Private Bytes
Thread Count
Virtual Bytes
Virtual Bytes Peak

Working Set

Conductor

IO Read Operations/sec Working Set Peak

10 Write Bytes/sec

=] Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or
more occurrences of the event. The CPU consumption for the first datapoint sample is artificially high
because the agent is starting the task.

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Processor Counters

QALoad supportsthe Processor category for Windows. This object type handlesthese registry counters:;

% DPC Time APC Bypasses/sec
% Interrupt Time DPC Bypasses/sec
% Privileged Time DPC Rate

% Processor Time DPCs Queued/sec
% User Time Interrupts/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Redirector Counters

QALoad supportsthe Redirector category for Windows. This object type handlesthese registry counters:

Bytes Received/sec Read Operations Random/sec

Bytes Total/sec Read Packets/sec
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Bytes Transmitted/sec
Connects Core

Connects Lan Manager 2.0
Connects Lan Manager 2.1
Connects Windows NT
Current Commands

File Data Operations/sec
File Read Operations/sec
File Write Operations/sec
Network Errors/sec
Packets/sec

Packets Received/sec
Packets Transmitted/sec
Read Bytes Cache/sec

Read Bytes Network/sec
Read Bytes Non-Paging/sec

Read Bytes Paging/sec

Read Packets Small/sec
Reads Denied/sec

Reads Large/sec

Server Disconnects

Server Reconnects

Server Sessions

Server Sessions Hung

Write Bytes Cache/sec
Write Bytes Network/sec
Write Bytes Non-Paging/sec
Write Bytes Paging/sec
Write Operations Random/sec
Write Packets/sec

Write Packets Small/sec
Writes Denied/sec

Writes Large/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Counters

QALoad supportsthe Server category for Windows. This object type handles these registry counters:

Blocking Requests Rejected
Bytes Received/sec

Bytes Total/sec

Bytes Transmitted/sec
Context Blocks Queued/sec
Errors Access Permissions

Errors Granted Access
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Pool Nonpaged Bytes
Pool Nonpaged Failures
Pool Nonpaged Peak
Pool Paged Bytes

Pool Paged Failures
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Errors Logon Server Sessions
Errors System Sessions Errored Out
File Directory Searches Sessions Forced Off
Files Open Sessions Logged Off
Files Opened Total Sessions Timed Out
Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows. This object type handlesthese registry
counters:

Active Threads Queue Length
Available Threads Read Bytes/sec
Available Work Items Read Operations/sec
Borrowed Work Items Total Bytes/sec

Bytes Received/sec Total Operations/sec
Bytes Sent/sec Work Item Shortages
Bytes Transferred/sec Write Bytes/sec
Context Blocks Queued/sec Write Operations/sec

Current Clients

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP NTFS Store Drive Counters

QALoad supportsthe SMTP NTFS Sore Drive category for Windows. This object type handlesthese registry
counters:

M essages allocated Messagesin the queue directory
M essages deleted Open message bodies
M essages enumerated Open message streams
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP Server Counters

QALoad supportsthe SMTP Server category for Windows. This object type handlesthese registry counters:

% Recipients Local

% Recipients Remote

Avg Recipients/msg Received

Avg Recipients/msg Sent

Avg Retriesymsg Delivered

Avg Retriesymsg Sent

Badmailed Messages (Bad Pickup File)
Badmailed Messages (General Failure)

Badmailed Messages (Hop Count
Exceeded)

Badmailed Messages (NDR of DSN)
Badmailed Messages (No Recipients)
Badmailed Messages (Triggered via Event)
Base % Recipients Local

Base % Recipients Remote

Base Avg Recipients/msg Received
Base Avg Recipients/msg Sent

Base Avg Retriesymsg Delivered

Base Avg Retriesymsg Sent

Bytes Received/sec

Bytes Received Total

Bytes Sent Total

Bytes Sent/sec

Bytes Total

Bytes Total/sec

Categorizer Queue Length
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Local Retry Queue Length

M essage Bytes Received/sec
M essage Bytes Received Total
M essage Bytes Sent/sec
Message Bytes Sent Total

M essage Bytes Total

M essage Bytes Total/sec
Message Delivery Retries

M essage Received/sec

Message Send Retries

Messages Currently Undeliverable
M essages Delivered/sec

Messages Delivered Total
Messages Pending Routing

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects
M essages Refused for Sze

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open
Number of QueueFiles Open
Outbound Connections Current

Outbound Connections Refused



Connection Errors/sec

Current Messagesin Local Delivery
Directory Drops/sec

Directory Drops Total
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
Inbound Connections Total

Local Queue Length

Conductor

Outbound Connections Total

Pickup Directory M essages Retrieved/sec
Pickup Directory Messages Retrieved Total
Remote Queue Length

Remote Retry Queue Length

Routing Table Lookups/sec

Routing Table Lookups Total

Total Connection Errors

Total DSN Failures

Total messages submitted

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

System Counters

QALoad supportsthe System category for Windows. This object type handles these registry counters:

% Registry Quotaln Use
Alignment Fixups/sec
Context Switches/sec
Exception Dispatches/sec
File Control Bytes/sec

File Control Operations/sec
File Data Operations/sec
File Read Bytes/sec

File Read Operations/sec

File Write Bytes/sec

File Write Operations/sec
Hoating Emulations/sec
Processes

Processor Queue Length
System Calls/sec

System Up Time

Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

TCP Counters

QALoad supportsthe TCP category for Windows. This object type handlesthese registry counters:
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Connection Failures Segments/sec

Connections Active Segments Received/sec
Connections Established Segments Retransmitted/sec
Connections Passive Segments Sent/sec

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Telephony Counters

QALoad supportsthe Telephony category for Windows. This object type handlesthese registry counters:

Active Lines Incoming Calls/sec
Active Telephones Lines

Client Apps Outgoing Calls/sec
Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Thread Counters

QALoad supportsthe Thread category for Windows. This object type handlesthisregistry counter:

User PC

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

UCP Counters
QALoad supportsthe UCP category for Windows. This object type handles these registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SAP Counters

SAP R/3 Remote Extended Counters

The following extended SAP R/3 remote counters are provided. These counters extend the monitoring of
your SAP R/3 system:

Active Servers Page/Roll Area
Active Users Page/Roll Area M ax
Alerts Process Monitoring
Buffer Satistics Sool Queue
CCMSMonitoring System Log Entries
Connection Test (SM59) Top CPU Utilization
CPU Consumption Top Load

Itemized Active Users User Function Call
Itemized Job Satus Workload Statistic
Itemized Spool Queue Work Processes
Job Satus

Memory Usage

Number of Dumps

SAP Active Servers

Thiscounter returnsthe active SAP application servers for a specified SAP R/3 instance.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Server Count

Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Data Point

Primary Data Point

The primary data point (PDP) is the number of active SAP application servers in the specified SAP instance.
If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each server:
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Name Full application server name.
Hostname Name of application server host.
Type Service name.
IP Application server host IP address.
Num Services Service port number.

Interval

Recommended minimum is5 minutes.

SAP Active Users

This counter returns all SAP users connected to either a specific SAP R/3 instance or system-wide.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. Enter an instance name asastringin
the format:

<Syst em name>- <Appl i cati on server name>-<R/ 3 system nunber>-<d i ent nunber>

For example:
Cl1- sapappserver-01-001

SAP User Count
Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Leve

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

Selected instance only (default) Only usersin theinstance specified by the SAP
Instance parameter are reported.

All instancesin the system All users of any instance available through the
specified instance are reported.

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Level parameter impactsthe number of serversthat will be scanned. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Sysname Full application server name.
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TerminallD Terminal identification.
Client User’slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.

SAP Alerts

Thiscounter returns a description of all the SAP alerts for the specified severity level.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set

Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor

Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select valuesfrom the discovered list, or enter values manually.

Severity

Alert severity level you want to monitor. This parameter is pre-defined and multi-selectable. Possible
values are:

Error - Red (default)

Warning - Yellow

Pattern

Pattern to search for in result. The default isall (* wildcard). You can either accept the default or enter a
string. Wildcard characters cannot beincluded in the string.

Show Alert Text

Soecify whether to show the alert'stext. Thisparameter ispre-defined and single-selectable. Possible
values are:
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Yes

No (default)

Alert Type

Select whether datareturned presentsonly current alert activity or presentsa history of activity. This
parameter is pre-defined and multi-selectable. Possible values are:

Active alerts (default)

Alert history

Show last minutes

Number of minutes of data history to return.
Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
number of alerts of the specified type. If an error isencountered during data collection, the counter
returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Color Red for errors and yellow for warnings

Severity Severity of alert

Date/Time Alert timestamp

Alert Unique ID Alert ID

Status Satus (for example: active, cone, auto
completed)

System MTE system name

Context MTE context

Object MTE object

Short Name MTE short name

Alert Text Alert text, if any.

Interval

Recommended minimum is5 minutes.

SAP Buffer Statistic
This counter returns statistics for the specified SAP R/3 buffers.
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The primary data point returnsthe buffer hit ratio, which isan indicator of how efficiently the buffer is
being used. For a frequently accessed buffer, the hit ratio should exceed 95%.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Buffer Name

Name of the SAP R/3 buffer you want to monitor. You can specify one or more buffers. In any
combination, select values from the discovered list, or enter values manually.

Satistic Name

The SAP R/3 buffer statistic to be used for the primary data point. This parameter is predefined and
single-selectable. Possible values are:

% of active objects

% of free objects

Free Size (%)

Free Size (KB)

Hit rate SAP buffer (%) (default)
Maximum no. of objects

No. of active objects

No. of database accesses

No. of free objects

No. of objects swapped

Size of allocated address space (KB)
Storage space available (KB)
Used size (%)

Used size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The primary data point is
the value for the statistic specified in the Satistic Name parameter. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) liststhe valuesreturned for all statistics.

Interval
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Recommended minimum is5 minutes.

SAP CCMSMonitoring

The Computer Center Management System (CCMS) Monitoring counter returnsthe value of the R/3 CCMS
Monitoring Tree Element (MTE) asin R/3 transaction RZ20. The performance, statusand log attributes are
distinguished. Each MTEin CCMSisrepresented using four elements: system name, context, object and
name. For example, CW2\ Database\ Tablespaces\ ...\ PSAPTABD.

The counter ignores any relationshipswithin RZ20’stree for the monitor set-monitor pair. Instead, it
allowsyou to select each of these four elementsusing the parameter dependency feature. That is, after a
monitor set is selected, the monitor list hasonly monitorsbelonging to that monitor set. After the monitor
is selected, the system name parameter only hasvaluesthat belong to the combination of monitor set-
monitor, etc.

Performance attributes show a numeric value asthe primary datapoint and any other messages as an
extended datapoint.

Satusand log attributes show their statusvalue —green, yellow, red and white (hormal, warning, critical
and no datareported, respectively). The primary datapoint isshown as 1, 2, 3 and 0 respectively. The
intelligent datapoint is available as explanation of returned status.

Thiscounter enables monitoring of any parts of R/3 of SAP modules, which supply datato CCMS
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set

Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor

Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select values from the discovered list, or enter values manually.

System ID

The system ID (or system name) of the monitoring system. You can specify one or more systems. In
any combination, select values from the discovered list, or enter values manually.

Context

The monitored context within the system ID. You can specify one or more contexts. In any
combination, select values from the discovered list, or enter values manually.

Object

The monitored object within the specified context. You can specify one or more objects. In any
combination, select values from the discovered list, or enter values manually.

Name

Name of MTE from R/3’s RZ20 transaction. You can specify one or more names. In any combination,
select values from the discovered list, or enter values manually.
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Sat Type
Select what type of dataisreturned. Thisparameter is pre-defined and single-selectable. Possible values
are:
Active alerts returns number of alerts
Alert history returns number of alerts
Value (default) returns MTE value

Show last minutes

Number of minutes of data history to return.
Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
MTE value or number of alerts, depending on the selection in the Sat type parameter. If an error is
encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) providesthe following information:
I MTE status
I Timestamp

! MTE Name

Interval

Not applicable.

SAP Connection Test (SM59)

Thiscounter teststhe connection to the selected remote system, as described in R/3. Thisisthe same
connection test asthe R/3 transaction SM59.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Connection Name

Name of the connection described in SM59. Enter a string. There isno default value.
Data Point

Primary Data Point
The primary data point (PDP) is one of the following values:

! 0 if the test fails
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! 1 if the test is successful

I 999 if the counter experiences an error during data collection

Intelligent Data Point
Theintelligent data point (IDP) returnsone of the following messages:
! Failure reason if the test failed
I "Connection tested OK” message if the test succeeded

! Error message if the counter encounters an error during data collection

Interval

Recommended minimum is5 minutes.

SAP CPU Consumption

This counter monitors CPU consumption for the specific users or transactions.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

User Name

The user name to monitor. The default isall (* wildcard). You can either accept the default or enter a
specific name. Wildcard characters cannot beincluded in the name.

TCode/Program

The user transaction code or report code to monitor. The default isall (* wildcard). You can either
accept the default or enter a specific name. Wildcard characters cannot be included in the name.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
percentage of SAP CPU consumption. If an error isencountered during data collection, the counter
returns 999.

If you do not specify values for the User Name or TCODE/Program parameters, the value returned is
always 100%.

Intelligent Data Point

Theintelligent data point (IDP) providesthe following information:

Username Name of the user.
Tcode/ Program Name of transaction code or report.
CPU (ms) Current CPU consumption in milliseconds.
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CPU (%) Current CPU consumption in percentage.
WP-Type Number of user sessions.
Interval

Recommended minimum is5 minutes.

SAP Itemized Active Users

Thiscounter returnsthe SAP users connected to the specified SAP instance and application servers. It is
similar to the SAP active users counter, with the addition of the Application Server Name parameter (multi-
selectable and wildcard enabled).

Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count
Maximum number of serverson which to report data. The default is10. The instance number can
range between 00 and 100.

Apply Operation

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

None A primary data point isreturned for each server specified in the Application
Server parameter.

Sum The primary data point isa sum for all servers specified in the Application
Server parameter.

Application Server
Name of the application server you want to monitor. You can specify one or more names. In any
combination, select valuesfrom the discovered list, or enter values manually.

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Apply Operation parameter determineswhether the counter returnsa summary data point or
individual data points. If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Sysname Full application server name.

TerminallD Terminal identification.

83



QALoad 05.06 Using the Conductor

Client User’'slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.

SAP Itemized Job Status

Thiscounter reportsthe status of jobsthat meet the specified criteria. It issimilar to the SAP Job Satus
counter, with the addition of the Apply Operation parameter and the all (* wildcard) default setting for the
Job Satus parameter.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter aname.

Job Satus

The statuses you want to monitor. This parameter is predefined and multi-selectable. Possible values
are:

* (all - default)
Active
Canceled
Finished
Ready
Released

Scheduled

Event Name
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Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch

jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Sart Time

Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Apply Operation

The monitoring level. This parameter is predefined single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the Job
Status parameter.

Sum (default) The primary data point isa sum for all statustypes specified in the Job
Satus parameter.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of jobs. The Apply Operation parameter determines

whether the counter returnsa summary data point or individual data points. If an error is encountered
during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) liststhe following information for each job status:

! Total jobsfound

I Sheduled

| Released

I Ready

I Active

! FHnished

I Cancelled

The IDP also includes atable with the following information, organized by job status:
Jobname Name of the job.
Job-count Internal job ID.
Status Job status.
Log Short log messages.

Interval
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Recommended minimum is5 minutes.

SAP Itemized Spool Queue

This counter returnsthe current number of entriesin the SAP spool queue that match the specified criteria.
It issimilar to the SAP Sool Queue counter, with the addition of the Apply Operation parameter and the
all default setting for the Request Satus parameter.

Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Request Satus

Request statusthat you want to monitor. This parameter is predefined and multi-selectable. Possible
values are:

* (all - default)
Problem
Processing
Succeeded

Without
Apply Operation
The monitoring level. This parameter is predefined and single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the
Request Satus parameter.

Sum (default) The primary data point isa sum for all statustypes specified in the Request
Satus parameter.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of current entriesin the SAP spool queue. The Apply
Operation parameter determines whether the counter returnsa summary data point or individual data
points. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) isthe number of entriesin the spool queue for each request status.

Interval

Recommended minimum is5 minutes.
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SAP Job Status

Thiscounter reportsthe number of jobsthat are selected that meet the criteria you specify.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter a name.

Job Satus

The job statusyou want to monitor. This parameter is predefined and single-selectable. Possible values
are:

* (all)
Active
Canceled
Finished
Ready
Released

Scheduled (default)

Event Name

Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch
jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Sart Time

Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The number returned is
the number of jobs. If an error is encountered during data collection, the counter returns 999.
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Intelligent Data Point
Theintelligent data point (IDP) liststhe following information:
I Total jobsfound
I Scheduled
I Released
! Ready
I Active
! Hnished
I Cancelled

TheIDP also includes atable with the following information, organized by job status:

Jobname Name of the job.

Job-count Internal job ID.

Status Job status.

Log Short log messages.
Interval

Recommended minimum is5 minutes.

SAP Memory Usage

This counter returnsthe total memory usage for the specified number of SAP usersin the SAP system.
Param eters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count

Maximum number of usersfor which the counter isto report memory utilization values. Secify a
value from 0 to 100. The default is10. Thisnumber isthe number rows of information that isreported
in thelIntelligent Data Point (IDP) table (described below).

Metrics

Unitsin which you want memory usage returned. This parameter is predefined and single-selectable.
Possible values are:

bytes
KB
MB

Data Point
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Primary Data Point
The primary data point (PDP) isthe total memory utilization. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) isatable with the following information, organized by user:

Client Client number.

User User name or owner of the job.

TransCode Transaction code name.

Roll Area Sze of roll area.

Page Area Sze of page area.

Shared Memory Sze of shared memory.

Heap Memory Sze of heap memory.

Summary Memory Summary of all types of memory.

TerminallD Terminal identification number.
Interval

Recommended minimum is5 minutes.

SAP Number of Dumps

This counter returnsthe number of dumps generated by the target system in the current day (since
midnight on the SAP system).

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Expression

Pattern to use to match dump’sshort text. The default is all
Data Point

Primary Data Point

The primary data point (PDP) isthe number dumps. If an error is encountered during data collection, the
counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) liststhe following information for each dump:
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Time Time dump was created.

Application Host Application host name.

User User name.

Client Client number.

Short Text Dump description.
Interval

Recommended minimum is 15 minutes.

SAP Page/ Roll Area

Thiscounter monitorsthe page or roll area statistics.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics
The page and roll area metrics. This parameter is pre-defined and multi-selectable. Possible values are:

Maximum Paging Area Used (%)

Maximum Paging Area Used (KB)

Maximum Roll Area Used (%)

Maximum Roll Area Used (KB)

Size of the Paging Area (KB)

Size of the Paging Areain the Shared Memory (KB)
Size of the Paging File (KB)

Size of the Roll Area (KB)

Size of the Roll Areain the Shared Memory (KB)
Size of the Roll File (KB)

Size of the Work Process-Local Paging Buffer (KB)
(default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)
Used Roll Area (KB)
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Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The valuereturned isthe
value of the specified metric (KB or %). The counter returns 999 if it encountersan error during data
collection.

Intelligent Data Point
Theintelligent data point (IDP) liststhe statistics for all page and roll metrics.

Interval

Recommended minimum is5 minutes.

SAP Page/ Roll Area Max

Thiscounter returnsthe maximum page or roll area statistics for the specified task interval.

Determining a Satistic's Maximum Value

A Remote Function Call (RFC) ismade at each task interval to get the data. It searchestheinternal cache
for the previously stored value of the same metric with atimestamp within thetime range specified with
the “Period in min” parameter.

If avalueisfound for the specified metric, it iscompared with the current value. The SAP Page/Roll Area
Max counter returnsthe greater of the two values and storesit in the cache with current timestamp.

If astored valueisnot found for the specified metric, the cache iscleared and the current valueis stored in
it. The counter returnsthisvalue.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics

The page and roll area metrics. This parameter is predefined multi-selectable. Possible values are:
Maximum Paging Area Used (%)
Maximum Paging Area Used (KB)
Maximum Roll Area Used (%)
Maximum Roll Area Used (KB)
Size of the Paging Area (KB)
Size of the Paging Area in the Shared Memory (KB)
Size of the Paging File (KB)
Size of the Roll Area (KB)

Size of the Roll Areain the Shared Memory (KB)
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Size of the Roll File (KB)

Size of the Work Process-Local Paging Buffer (KB)
(default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)

Used Roll Area (KB)

Period in min

Soecify amaximum duration of timein minutes. The default is 60.
Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The valuereturned is
the maximum value of the specified metric (KB or %), determined by the method described in
Determining a statistic's maximum value. The counter returns 999 if it encountersan error during
data collection.

Intelligent Data Point

The intelligent data point (IDP) lists, for the period, the maximum values for all statistics.

Interval

Recommended minimum is5 minutes.

SAP Process Monitoring

This counter returns CPU utilization or memory usage for selected processes. These processes must be set
up to be monitored by the SAP Operation System Collector.

To gather thisdata from the target R/3 instances, you must set up SAP OS Collector (saposcol) to gather
information about system processes. Completeinstructions are described in the document called
“Operation System Collector SAPOSCOL: Propertied, Operation and Installation”. It isavailable from the
SAP web site.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable
from the discovered list.

Process Pattern or User Pattern

Process or user to monitor. This parameter is single-selectable from the dynamically discovered list.

Metrics

Usage metrics for monitoring. This parameter is predefined and multi-selectable. Possible values are:
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CPU Utilization (%)
Process Count (default)
Resident Size (KB)

VM Size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The returned value isthe
value of the selected metric. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) displaysthe following information for each metric:

Last SapOsCol sample wastaken at: <date><time>
SapOsCol collection interval: <number_of_seconds> sec.

Interval

Recommended minimum is5 minutes.

SAP Spool Queue

Thiscounter returnsthe current number of SAP spool queue entriesthat match the specified criteria.
Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Request Satus

Request statusthat you want to monitor. This parameter is predefined and single-selectable. Possible
values are:

Problem
Processing (default)
Succeeded

Without

Data Point

Primary Data Point

The primary data point (PDP) for this counter isthe number of current SAP spool queue entriesthat
match the specified criteria. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
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The intelligent data point (IDP) is the number of entries in the spool queue for each request status.

Interval

Recommended minimum is5 minutes.

SAP System Log Entries

This counter returns, for the selected time period, the entriesthat match the specified expression.
Param eters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Time Period (Minutes)

Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from 5 to 180 (in minutes). The default value is 60.

Expression

Pattern to useto match the message text in the SAP system log . The default isall. You can either
accept the default or enter a string.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of entriesin the SAP system log that match the selection
criteria.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each message:

Severity M essage severity level: Error, Warning, or
Normal.

Time Message time.

Type Work processtype and number.

PID System processidentifier of the work
process.

Client Client number.

User User name.

Tcode Transaction code.

Mno M essage number.

Text M essage text.
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Interval

Recommended minimum is 10 minutes.

SAP Top CPU Utilization

Thiscounter returnsthe highest CPU utilization, by process, for the top 40 processeson the SAPR/3
application server.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Data Point

Primary Data Point
The primary data point (PDP) isthe highest CPU utilization value. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for the top 40 processes:

PID System process identifier.

Instance Name of SAP R/3 instance.

Command System process name.

CPU Util[%)] CPU utilization value.

CPU Time[g] CPU time value.

Working Set[KB] Top physical memory that isassigned to the process.

Private Pages[KB] Total of the entire memory (physical and virtual)
that isassigned to the process (Windows systems
only, thisvalueis 0 on UNIX).

Prior Process priority.

Interval

Recommended minimum is5 minutes.

SAP Top Load

This counter returnsa maximum workload statistic for the SAP system.
Parameters

SAP Instance
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Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count

Maximum number of active servers monitored for workload information. Valid entries are from 0 to
100. The default is 10.

Sorting Parameter

Workload characteristic you want to monitor. This parameter is predefined and multi-selectable.
Possible values are:

CPU Time

DB Time

Response Time (default)
Transfer Size

Wait Time

Time Metrics

Unitsfor monitoring CPU Time, DB Time, and Response Time, and Wait Time. This parameter is
predefined and single-selectable. Possible values are:

MilliSeconds (default)
Seconds

Sze Metrics

Unit of space for monitoring Transfer Sze. This parameter is predefined and single selectable. Possible
values are:

Bytes
KiloBytes (default)

MegaBytes

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The returned value isthe
top workload, in time or size. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) displaysthe following information for each transaction:

User User name.
Transaction Transaction code name.
Report Report name.
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Background Job Name Name of background job, if valid.

Task Type Type of the task.

Response Time Response name.

CPU Time CPU time.

Wait Time Wait time.

DB Time Database time.

Transfer Size Number of transferred bytes.
Interval

Recommended minimum is 10 minutes.

SAP User Function Call

Thiscounter callsany R/3 RFC-enabled function when it isdesigned according the following
ServerVantage rules. This counter enablesyou to create and implement your own custom SAP R/3 counters.

ServerVantage User Function Call Guidelines

The function name can be any character string.
The function should have one import, one export, and one table parameter.

Import parameter: SY_PARAMETERS s a character string that serves for passing data from
ServerVantage to R/3 function. You define how thisstringis parsed in R/3 function.

Export parameter: SY_VALUE must be float type and serves for passing data point valuesfrom R/3
function to the Java Agent.

Table parameter: SY_EXTENDED_ DPisan optional parameter that serves for passing intelligent
(extended) data points from R/3 function to Java Agent. It can be any character string. To pass
intelligent data points, you need to include the table header.

Parameter names cannot be changed.

Exceptions: You can define any number of exceptions. In the case of an exception within RFM, the
Monitoring tree displays—1 in the primary data Point (PDP) and an exception message in Intelligent
Data Point (IDP).

In the body of the function, you may use any manipulationsto retrieve data from R/3 and set
SV_VALUE and SVY_EXTENDED_DP.

The function MUST NOT have any GUI or screen output statements, or any statements requiring
dialog, interaction, or additional answers.

See User Function Call Example.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.
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Function Name

R/3 Remote Function Module (RFM) name.

Parameters

Parametersto passto the function.
Data Point

Primary Data Point
The primary data point (PDP) isthe valuereturned by the R/3 RFM. If an error isencountered
during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) isreturned by the R/3 RFM.

Interval

Not applicable.

SAP Work Processes
This counter returnsthe number of work processesrunning on a SAP instance according to the specified
criteria.

Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Process Type

Type of work process. This parameter is predefined and multi-selectable. Possible values are:

BDG Background

DIA (default) Dialog

ENQ Enqueue

SPO Soool

upP2 Update 2

UPD Update
Process Sate

Process state to monitor. This counter is predefined and multi-selectable. Possible values are:

Completed
Running
Stopped

98



Conductor

Waiting (default)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The valuereturned isthe
number of work processes. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) liststhe following processinformation:

I Total Work Processes

I Work Processes - Waiting Sate

I Work Processes - Running Sate

I Work Processes - Sopped Sate

! Work Processes - Completed Sate

TheIDP also includes atable with the following information, for each process:

Number Process sequential number.

Type Process type.

Process ID Process system ID.

Status Process status.

Reason Work processiswaiting.

Semaphore Semaphore for which the work processiswaiting.

Restart Restart work process after dump.

Dumps Number of dumps.

CPU CPU time.

Elapsed Time Previous execution time of request (elapsed).

Client Client number.

User User that isusing the process.

Report Report or tcode name used by the process.

Action What the processisdoing.

Table Database table last accessed by the work process.
Interval

Recommended minimum is 10 minutes.
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SAP Workload Statistic

This counter returns selected ST03 workload statistics for selected task types.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Task Type

The task type you want to monitor. This parameter is predefined and multi-selectable. Possible values
are:

ALE
AUTOABA (default)
BCKGRD
BUF.SYN
DIALOG
ENQUEUE
FTP
HTTP
HTTPS
NNTP
RFC
SMTP
SPOOL
UPDATE

UPDATEZ2

Satistic Name
The workload statistic. This parameter is predefined and multi-selectable. Possible values are:

CPU time avg (ms)
CPU time total(s)
Database calls
Database requests

Database requests. Changes
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Database requests: Direct reads
Database requests: Sequential reads
DB timeavg (ms)

DB time total(s)

Dialog Steps (default)

Dialog steps/s

Frontend net time avg (ms)
Frontend net time total(s)

GUI time avg (ms)

GUI time total(s)

Requested kBytes
Response time avg(ms)
Response time total(s)

Roll in time

Roll ins

Roll out time

Roll outs

Roll wait time

Time per DB request

Time per DB request: Changes and commits
Time per DB request: Direct reads
Time per DB request: Sequential reads
Wait time avg (ms)

Wait time total(s)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
selected workload statistic. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displays alist of theremaining statistics, for example:

101



QALoad 05.06 Using the Conductor

4} -- web Page Dialog x|
Selected Data Point H
Server: qacsapdb

Workload Statistic (SAP Instance: "C62-gacsapdb-01-000", Task

Counter: Type: "DIALOG", Statistic Name: "Dialog Steps™)
Task: workload

Cateqory: SAP B3 Remote Extended

Task Collection Frequency: 5 minutes

Time /17,2004 4:15:56 PM

Value 569

Description Dialog Steps

Workload for the task type DIALOG:

Instance:
SAP System C&2 Date 17 Bap Z004
Instance no. oL

Server gacszapdb

CPT time 108.& = Databaze calls 43,048
Elapsed Time 15, 624.0 = Database regquests Qi 408
= Direct reads 653, E55
Dialoyg steps 1] - Segquential reads 26,419
Dimlog steps / = .o = Changes 1,734
Av. CPU timea 190, % m=
Av. RBFC4#CPIC time 1l2.5 ms Time per DB request 3.0 as
- Direct reads 1.5 ms
Av. response time 1,504, 2 ms = Sequential reads 5.6 ms
- Aw. walt Time 196, 7 ms - Changes and coumits 15.7 ms
= ar. load time d05. 1 m=
- Aw. roll it+w time 135.2 ms Boll-in time 0.& =
= Av. DB reg. tins 475, 0 m= Fall=aout tins 1.8 =
- Av. engueue Time 4.4 ms Boll walt times 6.3 =5
Ball=ins 1,399
bv. bytes reg. 425, 4 ms Boll-outs 1,388
Frontend:
Av. net time BEZ.Z m= Av. GUOL time 133.5 a=

Currenkt Position ; 1 Total ;1

This is the first datapoint,

Close | Freyigus NERE I

Interval

Recommended minimum is 60 minutes.

SNMP Counters

SNMP Counters

SNMP Remote Monitoring usesthe SNMP service to provide network and system counters. SNMP counters
can beretrieved from any machinethat isrunning an SNMP server. QALoad usesthe default SNMP port.
Although SNMP does not require auser name and password, the SNMP agent must be configured to allow
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read-only access from the Conductor machine. SNMP countersthat are supported by QALoad Remote
Monitoring are categorized below.

ICMP

icmplnMsgs/sec: the rate at which ICMP messages are received

icmplnErrors: the number of ICMP messages received having ICMP errors
IcmplnDestUnreachs: the number of ICMP Destination Unreachable messages received
IcmplnTimeExcds: the number of ICMP Time Exceeded messages received
IcmplnParmProbs: the number of ICMP Parameter Problem messages received

IcmplnSrcQuenchs: the number of ICMP Source Quench messages received
icmplnRedirects/sec: the rate at which ICMP Redirect messages are received
icmplnEchos/sec: therate at which ICMP Echo messages are received
icmplnEchoReps/sec: therate at which ICMP Echo Reply messages are received
icmplnTimestamps/sec: the rate at which ICMP Timestamp messages are received
icmplnTimestampReps/ sec: therate at which ICMP Timestamp Reply messages are received
icmplnAddrMasks: the number of ICMP Address Mask Request messages received
icmplnAddrMaskReps: the number of ICMP Address Mask Reply messages received
icmpOutMsgs/ sec: therate at which ICMP messages are sent

icmpOutMsgs/ sec: the number of ICMP messages not sent dueto ICMP errors
icmpOutDestUnreachs: the number of ICMP Destination Unreachable messages sent
icmpOutTimeExcds: the number of ICMP Time Exceeded messages sent
icmpOutParmProbs: the number of ICMP Parameter Problem messages sent
icmpOutSrcQuenchs; the number of ICMP Source Quench messages sent
icmpOutRedirects/ sec: the number of ICMP Redirect messages sent
icmpOutEchos/sec: the number of ICMP Echo messages sent
icmpOutEchoReps/sec: the number of ICMP Echo Reply messages sent
icmpOutTimestam ps/sec: the number of ICMP Timestamp messages sent
icmpOutTimestam pReps/ sec: the number of ICMP Timestamp Reply messages sent
icmpOutAddrMasks: the number of ICMP Address Mask Request messages sent
icmpOutAddrMaskReps: the number of ICMP Address Mask Reply messages sent

IP

ipForwarding: the indication of whether thisentity isacting asan IP router in respect to the forwarding of
datagramsreceived by, but not addressed to, this entity.

ipDefaultTTL: the default value inserted into the Time-To-Live field of the IP header of datagrams
originated at thisentity, whenever a TTL value isnot supplied by the transport layer protocol.
iplnReceives/sec: the rate of input datagramsreceived from interfaces, including those received in error.
iplnHdrErrors: the number of input datagrams discarded due to errorsin their IP headers, including bad
checksums, version number mismatch, other format errors, time-to-live exceeded, errors discovered in
processing their IP options, and so on.

iplnAddrErrors: the number of input datagrams discarded because the IP addressin their IP header's
destination field was not avalid addressto be received at thisentity.

ipForwDatagram s/ sec: therate of input datagrams for which thisentity wasnot their final IP destination,
asaresult of which an attempt was made to find aroute to forward them to that final destination.
iplnUnknownProtos: the number of locally-addressed datagrams receive successfully but discarded
because of an unknown or unsupported protocol.

iplnDiscards: the number of input IP datagrams for which no problemswere encountered to prevent their
continued processing, but which were discarded (for example, for lack of buffer space).

iplnDelivers/ sec: the rate of input datagrams successfully delivered to IP user-protocols (including ICMP).
ipOutRequests: the number of IP datagramswhich local IP user-protocols (including ICMP) supplied to IP
in requests for transmission.

ipOutDiscards: the number of output IP datagrams for which no problem was encountered to prevent
their transmission to their destination, but which were discarded (for example, for lack of buffer space).
ipOutNoRoutes: the number of IP datagrams discarded because no route could be found to transmit them
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to their destination.

ipReasm Timeout: the maximum number of secondswhich received fragmentsare held while they are
awaiting reassembling at this entity.

ipReasm Reqds: the number of IP fragments received which needed to be reassembled at this entity.
ipReasm OKs: the number of IP datagrams successfully re-assembled.

ipReasm Fails: the number of failures detected by the IP re-assembly algorithm (for whatever reason: timed
out, errors, etc).

ipFragOKs: the number of IP datagramsthat have been successfully fragmented at this entity.

ipFragFails: the number of IP datagramsthat have been discarded because they needed to be fragmented at
thisentity but could not be, for example, because their Don't Fragment flag was set.

ipFragCreates/ sec: the rate of IP datagram fragmentsthat have been generated as a result of fragmentation
at thisentity.

ipRoutingDiscards: the number of routing entrieswhich were chosen to be discarded even though they
arevalid.

NMP

snmplnPkts/sec: the rate of messages delivered to the SNMP entity from the transport service.
snmpOutPkts/ sec: the rate at which SNMP M essages were passed from the SNMP protocol entity to the
transport service.

snmplnBadVersions: the number of SNMP messages which were delivered to the SNMP entity and were
for an unsupported SNMP version.

snmplnBadCommunityNames: the number of SNMP messages delivered to the SNMP entity which used a
SNMP community name not known to said entity.

snmplnBadCommunityUses: the number of SNMP messages delivered to the SNMP entity which
represented an SNMP operation which was not allowed by the SNMP community named in the message.
snmplnASNParseErrs: the number of ASN.1 or BER errors encountered by the SNMP entity when decoding
received SNM P messages.

snmplnTooBigs: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmplnNoSuchNames: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and
for which the value of the error-statusfield isnoSuchName.

snmplnBadValues: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is badValue.

snmplnReadOnlys: the number valid SNMP PDUs which were delivered to the SNMP protocol entity and
for which the value of the error-statusfield isreadOnly.

snmplnGenErrs: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmplnTotalReqVars/sec: the rate of MIB objects which have been retrieved successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Get-Request and Get-Next PDUs.
snmplnTotalSetVars/sec: the rate of MIB objectswhich have been altered successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Set-Request PDUs.

snmplnGetRequests/ sec: the rate of SNMP Get-Request PDUs which have been accepted and processed by
the SNMP protocol entity.

snmplnGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been accepted and processed by the
SNMP protocol entity.

snmplnSetRequests/ sec: the rate of SNMP Get-Response PDUswhich have been accepted and processed
by the SNMP protocol entity.

snmplnGetResponses/sec: the rate of SNMP Set-Request PDUswhich have been accepted and processed
by the SNMP protocol entity.

snmplnTraps: the number of SNMP Trap PDUs which have been accepted and processed by the SNMP
protocol entity.

snmpOutTooBigs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmpOutNoSuchNames: the number of SNMP PDUswhich were generated by the SNMP protocol entity
and for which the value of the error-statusisnoSuchName.
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snmpOutBadValues: the number of SNMP PDUswhich were generated by the SNMP protocol entity and
for which the value of the error-statusfield is badValue.

snmpOutGenErrs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmpOutGetRequests/ sec: the rate of SNMP Get-Request PDUswhich have been generated by the SNMP
protocol entity.

snmpOutGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been generated by the SNMP
protocol entity.

snmpOutSetRequests/sec: the rate of SNMP Set-Request PDUs which have been generated by the SNMP
protocol entity.

snmpOutGetResponses/ sec: the rate of SNMP Get-Response PDUs which have been generated by the
SNMP protocol entity.

snmpOutTraps: the number of SNMP Trap PDUswhich have been generated by the SNMP protocol entity.
snmpOutTraps: indicates whether the SNMP entity is permitted to generate authenticationFailure traps.

TCP

tcpRtoAlgorithm: the algorithm used to determine the timeout value used for retransmitting
unacknowledged octets.

tcpRtoMin: theminimum value permitted by a TCPimplementation for the retransmission timeout.
tcpRtoMax: the maximum value permitted by a TCPimplementation for the retransmission timeout.
tcpMaxConn: thelimit on the total number of TCP connectionsthe entity can support.
tcpActiveOpens: the number of times TCP connections have made a direct transition to the SYN-SENT
state from the CLOSED state.

tcpAttem ptFails: the number of times TCP connections have made a direct transition to the SYN-RCVD
state from the LISTEN state.

tcpEstabResets: the number of times TCP connectionshave made a direct transition to the CLOSED state
from either the ESTABLISHED state or the CLOSE-WAIT state.

tcpCurrEstab: the number of TCP connections for which the current state is either ESTABLISHED or
CLOSE-WAIT.

tcplnSegs/ sec: the rate at which segments are received, including those received in error.
tcpOutSegs/sec: therate at which segments are sent, including those on current connections but
excluding those containing only retransmitted octets.

tcpRetransSegs/ sec: the rate at which segments are retransmitted.

tepinErrs/sec: therate at which segments are received in error.

tcpOutRsts/ sec: the rate at which segments containing the RST flag are sent.

tcpPassiveOpens: the total number of times TCP connections have made a direct transition to the SYN-
RCVD state from the LISTEN state.

UbP

udplnDatagrams/ sec: the rate of UDP datagrams being delivered to UDP users.

udpNoPorts/ sec: therate of received UDP datagrams for which there was no application at the destination
port.

udplnErrors: the number of received UDP datagramsthat could not be delivered for reasons other than
thelack of an application at the destination port.

udpOutDatagrams/sec: therate at which UDP datagrams are sent.

Solaris: Sun System

Collisions/sec: therate of output collisions.

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that is spent in system mode.
Cpuldle%: the percentage of idle processor time.

IfInPackets/ sec: the rate of input packets.

IfOutPackets/ sec: therate of output packets.
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IfInErrors: the total number of input errors.

IfOutErrors: the total number of output errors.

Interrupts/sec: the rate of system interrupts.

Pagesln KBytes/ sec: the rate of pagesread in from disk.

PagesOut KBytes/sec: the rate of pageswritten to disk.

Swapln KBytes/sec: the rate at which pages are being swapped in.
SwapOut KBytes/sec: therate at which pages are being swapped out.

HP-UX: HP System

AvgJobsl: the average number of jobsin thelast minute * 100.

AvgJobs5: the average number of jobsin thelast 5 minutes* 100.

AvgJobsl5: the average number of jobsin thelast 15 minutes* 100.

CpuUser%: the percentage of non-idle processor time that isspent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that is spent in system mode.
Cpuldle%: the percentage of idle processor time.

FreeMemory KBytes: the amount of idle memory.

FreeSwap KBytes: the amount of free swap space on the system.

MaxProc: the maximum number of processes allowed.

MaxUserMem KBytes: the amount of maximum user memory on the system.
PhysMemory KBytes: the amount of physical memory on the system.

Users: the number of userslogged on to the machine.

Memory

AvailableSwvap KBytes: the available swap on the system.

Buffered KBytes: the amount of memory used as buffers.

Cached KBytes: the amount of memory cached.

FreeMemory KBytes: the amount of idle memory.

Shared KBytes: the amount of memory shared.

TotalMemory KBytes: the total amount of memory on the system.

TotalSwap KBytes: the total swap size for the system.

TotalSwapTXT KBytes: the total swap size for the system for text pages.
AvailableSwapTXT KBytes: the available swap on the system for text pages.
TotalMemoryTXT KBytes: the total amount of memory on the system for text pages.
FreeMemoryTXT KBytes: the amount of idle memory used for text pages.

Total Free KBytes: the amount of idle memory and available swap.

MinimumSwap KBytes: the swap space expected to be kept free or available during normal operation on
the system.

UsedSwapTXT KBytes: the amount of swap used by text pageson the system.
UsedMemoryTXT KBytes: the amount of memory used by text pageson the system.

System

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that is spent in system mode.
Cpuldle%: the percentage of idle processor time.

CpuWait%: the percentage of processor time waiting for 10.

CpuKernel%: the percentage of processor time processing kernel-level code.
Cpulnterrupt%: the percentage of processor timethat isspent handling hardware interrupts.
10Sent KBytes/sec: therate at which pages are being sent out.

IOReceived KBytes/ sec: the rate at which pages are being sent in.

Interrupts/sec: the rate of system interrupts.

ContextSwitches/sec: the rate of context switches.

CpuSoftIRQ%: the percentage of processor time processing software interrupts.
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Swapln KBytes/sec: the rate at which pages are being swapped in.
SwapOut KBytes/sec: therate at which pages are being swapped out.

Windows HTTP Server

httpTotalFilesSent: the total number of files sent by thisHTTP server.

httpTotalFilesReceived: the total number of filesreceived by thisHTTP server.
httpCurrentAnonymousUsers: the number of anonymous users currently connected to thisHTTP server.
httpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this
HTTP server.

httpTotalAnonymousUsers: the total number of anonymous usersthat have ever connected to thisHTTP
server.

httpTotalINonAnonymousUsers: the total number of non-anonymoususersthat have ever connected to
thisHTTP server.

httpMaximum AnonymousUsers: the maximum number of anonymous users simultaneously connected
to thisHTTP server.

httpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to thisHTTP server.

httpCurrentConnections: the current number of connectionsto the HTTP server.
httpMaximumConnections: the maximum number of simultaneous connectionsto the HTTP server.
httpConnectionAttempts: the total number of connection attemptsto the HTTP server.
httpLogonAttempts: the total number of logon attemptsto the HTTP server.

httpTotalOptions: the total number of requests made to thisHTTP server using the OPTIONSmethod.
httpTotalGets: the total number of requests made to thisHTTP server using the GET method.

httpTotal Posts: the total number of requests made to thisHTTP server using the POST method.
httpTotalHeads: the total number of requests made to thisHTTP server using the HEAD method.
httpTotalPuts: the total number of requests made to thisHTTP server using the PUT method.
httpTotalDeletes: the total number of requests made to thisHTTP server using the DELETE method.
httpTotal Traces: the total number of requests made to thisHTTP server using the TRACE method.
httpTotalMove: the total number of requests made to thisHTTP server using the MOVE method.
httpTotalCopy: the total number of requests made to thisHTTP server using the COPY method.
httpTotalMkcol: the total number of requests made to thisHTTP server using the MKCOL method.
httpTotalPropfind: the total number of requests made to thisHTTP server using the PROPFIND method.
httpTotalProppatch: the total number of requests made to thisHTTP server using the PROPPATCH
method.

httpTotalSearch: the total number of requests made to thisHTTP server using the MSSEARCH method.
httpTotalLock: the total number of requests made to thisHTTP server using the LOCK method.
httpTotalUnlock: the total number of requests made to thisHTTP server using the UNLOCK method.
httpTotalOthers: the total number of requests made to thisHTTP server not using the OPTIONS, GET,
HEAD, POST, PUT, DELETE, TRACE, MOVE, MKCOL, PROPFIND, PROPPATCH, MS-SEARCH, LOCK or
UNLOCK methods.

httpCurrentCGIRequests: the number of Common Gateway Interface requests currently being serviced by
thisHTTP server.

httpCurrentBGIRequests: the number of Binary Gateway Interface requests currently being serviced by
thisHTTP server.

httpTotal CGIRequests: the total number of Common Gateway Interface requests made to thisHTTP
server.

httpTotalBGIRequests: the total number Binary Gateway Interface requests made to thisHTTP server.
httpMaximum CGIRequests: the maximum number of Common Gateway Interface requests
simultaneously processed by thisHTTP server.

httpMaximumBGIRequests: the maximum number of Binary Gateway Interface requests simultaneously
processed by thisHTTP server.

httpCurrentBlockedRequests: the current number of requests being temporarily blocked by thisHTTP
server.

httpTotalBlockedRequests: the total number of requeststhat have been temporarily blocked by thisHTTP
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Server.
httpTotalRejectedRequests: the total number of requeststhat have been rejected by thisHTTP server.

Windows FTP Server

ftpTotalFilesSent: the total number of files sent by this FTP server.

ftpTotalFilesReceived: the total number of filesreceived by this FTP server.
ftpCurrentAnonymousUsers: the number of anonymous users currently connected to this FTP server.
ftpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this FTP
server.

ftpTotalAnonymousUsers: the total number of anonymoususersthat have ever connected to this FTP
server.

ftpTotaINonAnonymousUsers: the total number of non-anonymous usersthat have ever connected to
this FTP server.

ftpMaximumAnonymousUsers: the maximum number of anonymous users simultaneously connected to
this FTP server.

ftpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to this FTP server.

ftpCurrentConnections: the current number of connectionsto the FTP server.

ftpMaximum Connections: the maximum number of simultaneous connectionsto the FTP server.
ftpConnectionAttempts: the total number of connection attemptsto the FTP server.

ftpLogonAttem pts: the total number of logon attemptsto the FTP server.

WebLogic Counters

WeblLogic Remote Extended Counters

The following dynamically discovered WebLogic remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebLogic system. The
categories, counter names, and parameters are all dynamically discovered by processing the set of MBeans

availablein the WebLogic M X Server.

WebLogic Application Runtime
WebLogic Connector Service Runtime
WebLogic Deployer Runtime

WebLogic Domain Log Handler Runtime
WebLogic Domain Runtime

WebLogic EB Cache Runtime

WebLogic EB Component Runtime
WeblLogic EB Locking Runtime
WebLogic EB Pool Runtime

WebLogic EB Transaction Runtime
WebLogic Entity EJB Runtime

WebLogic Execute Queue Runtime
WebLogic IDBC Connection Pool Runtime
WebLogic MSConnection Runtime
WebLogic MSConsumer Runtime
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WebLogic M S Session Runtime
WebLogic JTA Recovery Runtime
WebLogic JTA Runtime

WebLogic WM Runtime

WebLogic Log Broadcaster Runtime
WebLogic Message Driven EJB Runtime

WebLogic Migratable Service Coordinator
Runtime

WebLogic Server Life Cycle Runtime
WebLogic Server Runtime
WebLogic Server Security Runtime
WebLogic Servlet Runtime
WeblLogic Sateful EB Runtime
WebLogic Sateless EB Runtime
WebLogic Time Service Runtime

WebLogic Transaction Resource Runtime
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WebLogic MSDestination Runtime WebLogic Web App Component Runtime

WebLogic MSRuntime WebLogic Web Server Runtime
WeblLogic IMS Server Runtime

WebLogic Application Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

counters Description
CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Application

The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values and wildcard patterns, a PDP and IDP are returned for each discovered
combination of parameters.

Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:15:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

ApplicationBuntime Cachingli=abled

Private property that disables caching in proxies.

Attribute walues for MBean:

ApplicationName = wl_management _internall
Cachingli=zabled = trus
Fegistered = fals=

il v oz

Interval

Recommended minimum is5 minutes.

WebLogic Connector Service Runtime

The WebLogic Connector Service Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

_ counes Description | Type

Private property that disables caching
in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsthe number of currently

deployed connection pools. Integer Yes | Yes

ConnectionPoolCurrentCount

Returnsthetotal number of deployed
ConnectionPoolsTotalCount connection poolsinstantiated since Integer Yes | Yes
the Server startup.

Returnsfalseif the MBean
Registered represented by this object has been Boolean | Yes | Yes
unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
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parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Service
Name of the connector service runtime MBean. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.

SatType

This parameter appliesonly to the countersthat are returning a count or total
(ConnectionPoolCurrentCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

E]

Datapoint Details g
Eerver: secotdw?, Time: 8-19-2003 6:23 - S& PH, Valus: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=e=0)

ConnectorServiceRuntime CachingDi=abled

Frivate property that di=sables caching in proEies.

Attribute wvaluss for MBesan:

ConnectionPoolsTotalCount = 0
Fegistered = false
ConnectionPool CurrentCount = 0
Cachingli=zabled = trus

il v Lz

Interval
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Recommended minimum is5 minutes.

WeblLogic Deployer Runtime

The WebLogic Deployer Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Deployer
Name of the deployer runtime MBean. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point

For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details fr k|

Server: secotdwvZ. Time: 8-19-2003 6:14:56 FH., Values: 1.00000 :J
Value : 1 (Boolean) (True=1, False=0)

DepleverBuntine CachinglDizabkled

Frivate property that di=sable=s caching in proxies.

Attribute wvalue=s for MBean:

Cachingli=abled = true
Fegistered = fal=se

A 2y

Interval

Recommended minimum is5 minutes.

WebLogic Domain Log Handler Runtime

The WebLogic Domain Log Handler Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

M Description

i i ingi Boolean
CachingDisabled Prlvgte property that disables caching in Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves ves
Parameters

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The name of the domain log handler to be monitored. You can specify one or more names for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:18:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

DomainlogHandlerBuntime CachingDi=abled

Private property that disables caching in proxies.

Attribute walus=s for MBean:

Fegistered = fal=e
Cachingli=zabled = trus

il v oz

Interval

Recommended minimum is5 minutes.

WebLogic Domain Runtime

The WebLogic Domain Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters ‘ % Ui ‘

Private property that disables
cachingin proxies.

CachingDisabled Boolean | Yes | Yes

Setsthetimeout valuein
milliseconds of the current
CurrentClusterDeploymentTimeout | deployment to acluster. Thisis Long No Yes
set at the beginning of the
deployment to acluster and is
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reset after the deployment.

Returnsfalse if the MBean
Registered represented by thisobject has Boolean | Yes | Yes
been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i k|
Eerver: secotdw?, Time: 8-19-2003 6:18-S5¢ PM, Valus: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=se=0)

DomainFuntimne CachingDisabled

Frivate property that dimables caching in proEies.

Attribute wvalus=s for HB=san:

Cachingli=zabled = trus
Fegistered = false
ActivationTime = Mondaw., Augu=st 13. 2003 3:01:35 FH EDT

il 2

Interval

Recommended minimum is5 minutes.
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WebLogic EJB Cache Runtime

The WebLogic EBB Cache Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Activation Count Returnsthe_total number of timesthe Long ves | Yes
EJB was activated.

CacheAccessCount Returnsthet(_)tal number of times EB Long ves | Yes
was accessed in the cache.

CachedBeansCurrentCount FE{;;:rnsthe current number of cached Integer Yes | Yes

. Returnsthe total number of timesthe
CacheHitCount EB was hit in the cache. Long Yes | Yes

Returnsthe total number of timesan
CacheMissCount attempt to access a bean from the cache Long No Yes
failed.

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

N Returnsthetotal number of timesthe
PassivationCount . Long Yes | Yes
EB was passivated.

Returnsfalse if the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or

more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component

The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ActivationCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Eerver: secotdw?, Time: 8-19-2003 6:20:56 PHM, ¥alus: 0. 00000 :J
Value : 0 (Long)

EJBCacheFuntime ActiwvationCount

Feturn=s the total number of bean= from this EJB Home that hawve beesn
activated.

Attribute valus=s for MBean:

CacheAccessCount = 0
CachedBeansCurrentCount = ([
Cachingli=zabled = trus
Fegistered = fal=e
CacheHitCount = 0
ActivationCount = 0O
Fasz=sivationCount = 0

il 2

Interval
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Recommended minimum is5 minutes.

WebLogic EJB Component Runtime

The WebLogic EBB Component Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

counters Description

CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.

DeploymentState Returnscurrent deployment state of the Integer No Yes
module.

Registered Re_turn_sfalse if the MBean _represented by Boolean Yes Yes
this object has been unregistered.
Returnsthe deployment's status. The set of

Satus statusisdefined in the EJB Deployment Integer Yes Yes
interface (DEPLOYED, UNDEPLOYED, 9
ERROR).

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

EBName
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Theremainder of the EBB component name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: secotdv2, Time: 8192003 6:20:56 PH. Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1. Fal=ze=0]

EJBComponentBEuntime Cachingli=abled

Friwvate property that disables caching in proEies.

Attribute waluss for MHBe=an:

Status = 0
DeplovmentNamse = adminssrver appsdir _=3b20 _homemethods ear =31b20_homemethods . jar

Fegiztered = false
CachinglDi=zabled = true

Al A

Interval

Recommended minimum is5 minutes.

WebLogic EJB Locking Runtime

The WebLogic EB Locking Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters o Type
-_ Description

Private property that disables cachingin

. Boolean Yes | No
proxies.

CachingDisabled

Returnsthe number of current EB lock

LockEntriesCurrentCount ) Integer Yes | No
entries.

LockM anager AccessCount Returnsthe number of accessesto the Long ves | No
lock manager.

Registered Returnsfalse if the MBean represented Boolean ves | No

by this object has been unregistered.
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TimeoutTotalCount Ret_urnst_h_e number of objectstimed out Long ves | No
while waiting on the lock.

WaiterTotal Count Returnsthe number of objects waiting Long ves | No
on thelock.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (LockEntriesCurrentCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.
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I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Eerver: secotdw?, Time: 3-19-2003 6:21:56 PM, Valus: 1.00000 :J
Waluse : 1 (Boolean) (Trus=1. Fal===0)

EJBLockingBuntime Cachingli=abl=ed

Private property that disables caching in prozies.

Attribute walues for MBsan:

LockEntriesCurrentCount = 0
Fegiztered = false
WaiterTotalCount = 0
CachingDi=abled = trus
TimeoutTotalCount = 0
LockManagericoces=Count = 0

il 2

Interval

Recommended minimum is5 minutes.

WebLogic EJB Pool Runtime

The WebLogic EB Pool Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Returnsthetotal number of times
AccessTotalCount an attempt was made to get an Long No Yes
instance from the free pool.

Returnsthe number of beans

. Integer Yes Yes
currently in use.

BeansinUseCount

Returnsthe number of bean
BeanslnUseCurrentCount instances currently in use from Integer No Yes
the free pool.

Private property that disables

. . . Boolean Yes Yes
caching in proxies.

CachingDisabled

Returnsthetotal number of times
abean instance from this pool
DestroyedTotalCount was destroyed due to anon- Long No Yes
application Exception being
thrown from it.
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Returnsthe number of idle beans

IdleBeansCount in this EB.

Integer Yes Yes

Returnsthetotal number of times
afailed attempt was made to get
an instance from the free pool.
An attempt to get a bean from
the pool failsif thereare no
availableinstancesin the pool.

MissTotalCount Long No Yes

Returnsthe current number of
PooledBeansCurrentCount available bean instancesin the Integer No Yes
free pool.

Returnsfalse if the MBean
Registered represented by thisobject has Boolean Yes Yes
been unregistered.

TimeoutTotalCount Returnsthetotal nlumber of Long Yes Yes
timed out transactions.

Returnsthe current number of

WaiterCurrentCount available bean instancesin the Integer No Yes
free pool.

WaiterTotalCount Returnsthe QL_lmber of EBs Long Yes Yes
currently waiting.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
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The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (BeansinUseCount isone

examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details = |
Server: =szecotdw?. Time: 8-19-2003 6:21:56 P, Values: 0. 00000 :J
Valus : 0 (Integer)

EJEPoolBEuntime EBeansInlUssCount

Feturh=s the total number of bean instances currently in use from the

free pool.

Attribute wvaluses for MB=san:

Fegiztered = false
TimeoutTotalCount =
Bean=InlUs=eCount = 0
Cachingli=abled = trues
IdleBean=Count = 0
WaiterTotalCount = 0

kil vz

o

Interval

Recommended minimum is5 minutes.

WebLogic EJB Transaction Runtime

The WebLogic EB Transaction Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.
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Couniess e

Private property that disables
cachingin proxies.

CachingDisabled Boolean | Yes | Yes

Returnsfalse if the MBean
Registered represented by this object has Boolean | Yes | Yes
been unregistered.

Returnsthe total number of EB
TransactionsCommittedTotalCount | transactionsthat were Long Yes | Yes
committed.

Returnsthe total number of EIB

TransactionsRolledBackTotalCount .
transactionsrolled back.

Long Yes | Yes

Returnsthe total number of EIB

TransactionsTimedOutTotalCount . .
transactionsthat timed out.

Long Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

SatType
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This parameter is available for countersthat are returning a count or total
(TransactionsCommittedTotalCount isone example in thiscounter category). Possible values are;

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details
Server: secotdvZ, Time: 8-19-2003 6:18:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

EJBTranzactionFuntime CachingDi=sabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

Fegistered = fal=e
Tran=zactionsRolledBackTotalCount =
TransactionsTimedOutTatalCount = 0
Cachingli=zabled = trues
TransactionsCommittedTotalCount = 0

il v

Interval

]

Recommended minimum is5 minutes.

WebLogic Entity EJB Runtime

The WebLogic Entity EIB Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters .
Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalseif the MBean represented by
Registered thisobject has been unregistered. Boolean ves ves
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details = |
Server: secotdvZ, Time: B8-19-2003 6:19:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

EntitwEIBRuntime CachingDi=zabled

Private property that disables caching in proxies.

Attribute walues for MBean:

EJBHam= = beanManaged
Cachingli=zabled = trus
Eegiztered = fal=d

il v
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Interval

Recommended minimum is5 minutes.

WebLogic Execute Queue Runtime

The WebLogic Execute Queue Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

. Coumters = Description M

Private property that disables

o oF . Boolean | Yes | Yes
cachingin proxies.

CachingDisabled

ExecuteThreadCurrentldleCount Ret_urnsthe number of idle threads Integer Yes | Yes
assigned to the queue.

Returnsthe total number of
ExecuteThreadTotalCount execute threads assigned to the Integer No Yes
queue.

Returnsthe number of waiting

requestsin the queue. Integer Yes | Yes

PendingRequestCurrentCount

Returnsthetimethat the longest
PendingRequestOldestTime waiting request was placed in the Long Yes | Yes
queue.

Returnsfalse if the M Bean
Registered represented by thisobject has been Boolean | Yes | Yes
unregistered.

Returnsthe number of requests
ServicedRequestTotalCount that have been processed by this Integer Yes | Yes
queue.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.
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Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values

manually.

Queue

The execution queue name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ExecuteThreadTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:20:5& PH, Value: 1.00000 :J
Waluse : 1 (Boolean) (Trus=1. Fal==s=0)

ExecutefususRuntine CachingDisabled

Private property that disables caching in prozies.

Attribute walues for MBean:

FendingFequestCurrentCount = 0

ServicedRequestTotalCount = 0

CachinglDi=zabled = true

Fegistered = fal=se

ExecuteThreadCurrent IdleCount = 2

FendingFeque=stllde=ztTime = Tussday. Augu=st 19, 2003 &:21:37 PM EDT

il 2

Interval

Recommended minimum is5 minutes.

WebLogic JDBC Connection Pool Runtime

The WebLogic DBC Connection Pool Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.
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ActiveConnectionsAverageCount

Description

Returnstherunning average
of active connectionsin the
this MBean. The count starts
at zero each timethe MBean is
instantiated.

Integer

No

Yes

ActiveConnectionsCurrentCount

Returnsthe current number of
active connections.

Integer

Yes

Yes

ActiveConnectionsHighCount

Returnsthe highest number of
active current connections.
The count starts at zero each
timethe
JDBCConnectionPoolRuntime
MBean isinstantiated.

Integer

Yes

Yes

CachingDisabled

Private property that disables
caching in proxies.

Boolean

Yes

Yes

ConnectionDelayTime

Returnsthe number of
millisecondsit takesto get a
physical connection from
database. It is calculated as
summary timeto connect,
divided by summary number
of connections.

Integer

Yes

Yes

ConnectionLeakProfileCount

Returnsthe current number of
connection leak profilesin the
profile storage.

Integer

Yes

Yes

ConnectionsTotalCount

Returnsthe total number of
JDBC connectionsin this
JDBCConnectionPoolRuntime
MBean since the pool was
instantiated.

Integer

Yes

Yes

FailuresToReconnectCount

Returnsthe count of attempts
to refresh aconnection to a
database that failed. Failure
may happen because of
database unavailability or a
broken connection to the
database.

Integer

Yes

Yes

HighestNumAuvailable

Returnsthe highest number of
available connectionsin this
pool.

Integer

No

Yes

HighestNumUnavailable

Returnsthe highest number of
unavailable connectionsin
thispool.

Integer

No

Yes
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LeakedConnectionCount

Returnsthe number of
connectionsthat were
checked out from the
connection pool but were not
returned to the pool by calling
close ().

Integer

Yes

Yes

MaxCapacity

Returnsthe maximum
capacity of thisconnection
pool.

Integer

Yes

Yes

NumAvailable

Returnsthe number of
available connectionsin this
pool.

Integer

No

Yes

NumUnavailable

Returnsthe number of
unavailable connectionsin
thispool.

Integer

No

Yes

PoolSate

Returnstrueif the pool is
enabled, false if the pool is
disabled.

Boolean

Yes

Yes

PreparedSatementCacheProfileCount

Returnsthe number of
prepared statement cache
profiling stores cache
snapshotsthat arein external
storage.

Integer

Yes

Yes

PrepSmtCacheHitCount

Returnsthe cumulative,
running count of the use of
each cached statement.

Integer

Yes

Yes

PrepSmtCacheMissCount

Returnsacount of the cases
when the cache doesnot have
a cached statement to satisfy a
request.

Integer

Yes

Yes

Registered

Returnsfalse if the MBean
represented by thisobject has
been unregistered.

Boolean

Yes

Yes

SatementProfileCount

Returnsthe number of
statement profiling storesin
external storage.

Integer

Yes

Yes

WaitingForConnectionCurrentCount

Returnsthe current number of
requests waiting for a
connection.

Integer

Yes

Yes

WaitingForConnectionHighCount

Returnsthe highest number of
requests waiting for a
connection. The count starts
at zero each timethe
JDBCConnectionPoolRuntime
MBean isinstantiated.

Integer

Yes

Yes
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Returnsthe highest number of

WaitSecondsHighCount . :
seconds a connection waited.

Integer Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Pool

The connection pool name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details

Eerver: secotdw?, Time: 8-19-2003 6:20:56 PFM, Values: 1. 00000
Valus : 1 (Integer)

JDBCConnectionFoolRuntine ActiveConnections=CurrentCount
Counter description not defined in MBean metadata.

> b

Attribute walues for MBean:

ActiveConnectionsHighCount = 2
Fegiztered = false
LealkedConnectionCount = 0
FrepStmtCacheli=z=Count = 3
WaitingForConnectionHighCount = 0
FreparedStatemnentCacheProfileCount = 0
FailuresToReconnectCount = 0
WaitSecond=sHighCount = 0
StatemnentProfileCount = 0
ConnectionlelayTime = 71
FrepStmtCacheHitCount = 0

PoolState = true

VerzionJDECDriver = com.pointbass. jdbc . jdbcllniverszallriver
ConnecticnsTotalCount = 2

MaxCapacity = 10
ConnectionleakProfileCount = 0
WaitingForConnectionCurrentCount = 0
ActiveConnectionsCurrentCount = 1
Cachingli=abled = trus

il vz

Interval

Recommended minimum is5 minutes.

WeblLogic IMS Connection Runtime

The WebLogic M SConnection Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.

Registered Re_turn_sfalse if the MBean_represented by Boolean ves | Yes
this object has been unregistered.

SessionsCurrentCount Re_turnsthec_:urrent number of sessions for Long ves | Yes
thisconnection.

. . Returnsthe peak number of sessionsfor
SessionsHighCount thisconnection since the last reset. Long Yes | Yes
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SessionsTotal Count Returns_then_umber of sessionson this Long Yes Yes
connection since the last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Connection
The M Sconnection name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (SessionsTotalCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details : |
Server: secotdvZ, Time: 8192003 6:19:56 PH., Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e=0]}

JMSConnectionFuntime CachingDissbled

Frivate property that disables caching in proies.

Attribute wvalus= for HBesan:

Cachingli=abled = true
Fegizstered = fal=e

Sezzion=HighCount = 8
Sesz=zionsCurrent Count
SezsionsTotalCount =

A 2

Interval

= 8
g

Recommended minimum is5 minutes.

WeblLogic IMSConsumer Runtime

The WebLogic M SConsumer Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

COLECE Description

Determinesif the consumer is active.
Determineswhether the consumer has a
message listener set up or a synchronous
receive in progress.

Active Boolean Yes | Yes

Returnsthe number of bytes pending
BytesPendingCount (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of bytes received by

BytesReceivedCount this consumer since the last reset. Long Yes | Yes

CachingDisabled Prlvqte property that disables caching in Boolean ves | Yes
proxies.

Durable Determineswhether the consumer is Boolean ves | Yes

durable.

Returnsthe number of messages pending
MessagesPendingCount | (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of messages received

by this consumer since the last reset. Long Yes | Yes

M essagesReceivedCount
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Returnsfalseif the MBean represented by

thisobject has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Consumer
The M Sconsumer name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:19:56 PH. Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e==0]}

JMSConsumerFuntime Active

Determines if the consumer active. Determines whether the consumsr has

a mezzage listener set up or a synchronous receive 1n progress.

Attribute walues for MBean:

Fegizstered = fal=e

MeszzagesFPendingCount = 0

Durable = false

Active = true

BvtesReceivedCount = 0

De=tinationHame = sxamplelususSsnd

MeszzagesReceivedCount = 0

BrtesPendingCount = 0

CachinglDi=zabled = trues =

A A

Interval

Recommended minimum is5 minutes.

WebLogic IMSDestination Runtime

The WebLogic MSDestination Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

counters Description
Returnsthe current number of bytes
BytesCurrentCount stored in the destination. Thisdoes not Long Yes | Yes
include the pending bytes.
. Returnsthe peak number of bytes stored
BytesHighCount in the destination since the last reset. Long Yes | Yes
Returnsthe number of pending bytes
BytesPendingCount stored in the destination. Pending bytes Long ves | Yes
are over and above the current number
of bytes.
) Returnsthe number of bytesreceived in
BytesReceivedCount thisdestination since the last reset. Long Yes | Yes
. Returnsthe amount of timein the
BytesThresholdTime threshold condition since the last reset. Long Yes | Yes
CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.
ConsumersCurrentCount | Returnsthe current number of Long Yes | Yes
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consumers accessing thisdestination.

Returnsthe peak number of consumers
ConsumersHighCount accessing thisdestination since the last Long Yes | Yes
reset.

Returnsthe total number of consumers
ConsumersTotalCount accessing thisdestination since the last Long Yes | Yes
reset.

Returnsthe current number of messages
M essagesCurrentCount in the destination. Thisdoesnot include Long Yes | Yes
the pending messages.

Returnsthe peak number of messagesin

M essagesHighCount the destination since the last reset.

Long Yes | Yes

Returnsthe number of pending messages
in the destination. Pending messages are
over and abovethe current number of

M essagesPendingCount messages. A pending message isone that Long Yes | Yes
haseither been sent in atransaction and
not committed, or that has been received
and not committed or acknowledged.

Returnsthe number of messages received

M essagesReceivedCount in thisdestination since that reset. Long ves | Yes
. Returnsthe amount of timein the
MessagesThresholdTime threshold condition since the last reset. Long ves | Yes
Registered Re.turn.sfalsenc theMBean_represented by Boolean ves | Yes
thisobject has been unregistered.
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Destination
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The name of the M Sdestination. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details BE:: |
Eerver: secotdw?, Time: 3-19-2003 6:20:56 PM, Value=: 0.00000 :J
Valus : 0 [(Long)

JHMSDestinationFuntime BytesCurrentCount

Feturn= the current number of bytes s=tored in the destination. Thi=

dos=s not include the pending byte=.

Attribute walus=s for MBesan:

MeszzagesCurrentCount = 0
MessagesReceivedCount = 0
BvrtesReceivedCount = 0
Bvte=ThresholdTime = 0
ByrtesCurrentCount = 0
MeszzagesHighCount = 0
ConsunersHighCount = 0
BrtesPendingCount = 0
Mezzage=ThresholdTime
Consumers_urrentCount
BrtesHighCount = 0
ConzumersTotalCount =
CachinglDi=zabled = trues
MeszzagesFendingCount = 0
DesztinationTvpe = Dusus
Fegizstered = fal=e

il 2

Interval

=]

Recommended minimum is5 minutes.

WebLogic IMSRuntime

The WebLogic M SRuntime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

DGR Description

Private property that disables caching in
proxies.

CachingDisabled Boolean Yes | Yes

. Returnsthe current number of
ConnectionsCurrentCount connections to this WebLogic Server. Long Yes | Yes

Returnsthe peak number of connections
ConnectionsHighCount to thisWebLogic Server sincethe last Long Yes | Yes
reset.

Returnsthe total number of connections
ConnectionsTotalCount made to thisWebLogic Server since the Long Yes | Yes
last reset.

Returnsthe current number of MS
IM SServersCurrentCount serversthat are deployed on this Long Yes | Yes
WebLogic Server instance.

Returnsthe peak number of MSservers
that were deployed on thisWebLogic
Server instance since the server was
started.

IM SServersHighCount Long Yes | Yes

Returnsthe number of MSserversthat
JM SServersTotalCount were deployed on this WebLogic Server Long Yes | Yes
instance since the server was started.

Returnsfalseif the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.
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M SSrver

The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is
one examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnstheraw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details = |
Eerver: secotdw?. Time: 8-19-2003 6:19:56 FM, Valus: 1. 00000 :J
Value : 1 (Boolean) {(Trus=1, Fal=se=0]}

JHMSEuntime CachingDi=zabled

Frivate property that disables caching in proEies.

Attribute wvalus=s for MB=an:

ConnectionsCurrentCount = (0
Fegizstered = fal=e
JHSServersCurrentCount = ([
JHSServersHighCount = [
JHMSServersTotal Count 0
ConnectionsHighCount 0
ConnectionsTotalCount = 0
Cachingli=zabled = trus

A vz

Interval

Recommended minimum is5 minutes.

WeblLogic IMS Server Runtime

The WebLogic M S Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.
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BytesCurrentCount

Description

Returnsthe current number of bytes
stored on this M Sserver. Thisdoes not
include the pending bytes.

Long

Yes

Conductor

Yes

BytesHighCount

Returnsthe peak number of bytes stored
in the M Sserver since the last reset.

Long

Yes

Yes

BytesPendingCount

Returnsthe current number of bytes
pending (unacknowledged or
uncommitted) stored on this M Sserver.
Pending bytes are over and above the
current number of bytes.

Long

Yes

Yes

BytesReceivedCount

Returnsthe number of bytes received on
thisM Sserver since the last reset.

Long

Yes

Yes

BytesThresholdTime

Returnsthe amount of timein the
threshold condition since the last reset.

Long

Yes

Yes

CachingDisabled

Private property that disables caching in
proxies.

Boolean

Yes

Yes

DestinationsCurrentCount

Returnsthe current number of
destinations for this MM Sserver.

Long

Yes

Yes

DestinationsHighCount

Returnsthe peak number of destinations
on thisM Sserver since the last reset.

Long

Yes

Yes

DestinationsTotalCount

Returnsthe number of destinations
instantiated on thisJM Sserver sincethe
last reset.

Long

Yes

Yes

MessagesCurrentCount

Returnsthe current number of messages
stored on this M Sserver. Thisdoes not
include the pending messages.

Long

Yes

Yes

M essagesHighCount

Returnsthe peak number of messages
stored in the M Sserver sincethe last
reset.

Long

Yes

Yes
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Returnsthe current number of messages
pending (unacknowledged or

M essagesPendingCount uncommitted) stored on thisIMSserver. | Long Yes Yes
Pending messages are over and above
the current number of messages.

Returnsthe number of messages
M essagesReceivedCount received on thisdestination sincethe Long Yes Yes
last reset.

Returnsthe amount of timein the

MessagesThresholdTime threshold condition since the last reset.

Long Yes Yes

Returnsfalseif the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

. Returnsthe current number of session
SessionPoolsCurrentCount poolsinstantiated on this M S server. Long Yes Yes

Returnsthe peak number of session
SessionPoolsHighCount poolsinstantiated on this MM S server Long Yes Yes
since the last reset.

Returnsthe number of session pools
SessionPoolsTotalCount instantiated on this M Sserver since the Long Yes Yes
last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

M SSrver

The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType
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This parameter is available for countersthat are returning a count or total (SessionPoolsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Eerver: secotdw?,. Time: 8-19-2003 &:20:56 P, Value: 0.00000 :J
Value : 0 {(Long)

JHSServerFuntime BvtesCurrentCount

Feturn=s the current number of bytes stored on thi= JHS =erver. This
doez not i1nclude the pending bytes.

Attribute wvaluss for MBean:

MessagesPendingCount = (0
HeszzagesHighCount = 0
Mes=agesThresholdTine = 0
DeztinationsTotalCount = 5
BvteszsHighCount = 0
SeszzionFPoolsHighCount = 0
SezzionPoolsCurrentCount = 0
HeszzagesCurrentCount = 0
MessagesEeceivedCount = [
Fegiztered = false
Cachingli=abled = trues
BytesPendingCount = [
Bvte=ThresholdTime = 0
BrtesFeceivedCount = I
BytesCurrentCount = [
Sez=zionFPool=TotalCount = (0
DeztinaticonsCurrentCount =
De=ztinationsHighCount = 5

il 2

Interval

5

Recommended minimum is5 minutes.

WebLogic IMS Session Runtime

The WebLogic M S Session Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.
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Counters .
Description

Returnsthe number of bytes pending

BytesPendingCount (uncommitted and unacknowledged) for Long Yes | Yes
this session.

BytesReceivedCount Re_turns_the n_umber of bytes received by Long Yes | Yes
thissession since the last reset.

BytesSentCount Retgrnst_he number of bytes sent by this Long ves | Yes
session since the last reset.

CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.

ConsumersCurrentCount Returnsthecurre_nt ”“'_””ber of Long Yes | Yes
consumersfor this session.

. Returnsthe peak number of consumers

ConsumersHighCount for thissession since the last reset. Long Yes | Yes
Returnsthe number of consumers

ConsumersTotalCount instantiated by this session since the last Long Yes | Yes
reset.
Returnsthe number of messages pending

M essagesPendingCount (uncommitted and unacknowledged) for Long Yes | Yes
this session.

M essagesReceivedCount Re_turns_the n_umber of messages sent by Long Yes | Yes
thissession since the last reset.

M essagesSentCount Retgrnst_he number of bytes sent by this Long ves | Yes
session sincethe last reset.

ProducersCurrentCount Returnsthe_current number of producers Long ves | Yes
for this session.

. Returnsthe peak number of producers

ProducersHighCount for this session since the last reset. Long Yes | Yes

ProducersTotal Count Retgrnst_he number of producersfor this Long ves | Yes
session sincethe last reset.

Registered Re_turn_sfalself theMBean_represented by Boolean ves | Yes
this object has been unregistered.

Transacted Returnswhether the session is Boolean ves | Yes
transacted.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
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parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Session

The M Ssession name. You can select avalue from the discovered list.

SatType

This parameter is available for countersthat are returning a count or total (ConsumersTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Eerver: secotdw?, Time: 8-19-2003 6:21:56 PM, Valus=: 0. 00000 _:J
Valus : 0 (Long)

JMSSes=zionBEuntime BvtesPendingCount

Feturn= the number of bytes pending (uncommitted and unaclknowledged)
for thi=s ses=ion.

Attribute waluss for MBesan:

HezzagesReceivedCount = 0
ConsunersHighCount = 1
Tranzacted = false
ByteszSentCount = 0
AcknowledgeMode = Auto
BvtesPendingCount = 0
FroducerzHighCount = 1
HessagesSentCount = ([
Froducers=TotalCount = [
MessagesFPendingCount = 0
ByrtesReceivedCount = [
FroducersCurrentCount =
Consumers_urrentCount =
Cachingli=zabled = trus
Fegistered = fals=
ConsumnersTotalCount = 1

4 2y

Interval

0
1

Recommended minimum is5 minutes.

WebLogic JTA Recovery Runtime

The WebLogic JTA Recovery Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Sl R

Returnswhether the
Transaction Recovery

Active S Boolean | Yes | Yes
Serviceiscurrently
activated on this server.
Private property that

CachingDisabled disables cachingin Boolean | Yes | Yes

proxies.

Returnsthe total number
of transactionsthat are
recovered from the
Transaction Log initially.

InitialRecoveredTransaction TotalCount Integer Yes | Yes

Returnsthe percentage of

s Integer Yes | Yes
theinitially recovered g

RecoveredTransactionCompletionPercent
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transactionsthat are
completed.

Returnsfalse if the MBean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

SatType

This parameter is available for countersthat are returning a count or total
(InitialRecoveredTransaction TotalCount isone examplein this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details i |
Server: secotdvZ, Time: 8-19-2003 6:20:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

JTARecovervEuntine Active

Feturn= whether the Transaction Recowvery Service 1= currently activated

on thiz =erwver.

Attribute waluss for MBesan:

Active = trues
Cachingli=abled = trues

InitialPecoveredTransactionTotalCount = 0
FecoveredTransactionConpletionPercent = 0

Fegistered = false =
Al M 4
Interval

Recommended minimum is5 minutes.

WebLogic JTA Runtime

The WebLogic JTA Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters .. Type
- Description —

Returnsthe number of
ActiveTransactionsTotalCount active transactionson the Integer Yes | Yes
server.

Private property that

. L2 : Boolean Yes | Yes
disables caching in proxies.

CachingDisabled

Returnsfalse if the MBean
Registered represented by this object Boolean Yes | Yes
has been unregistered.

Returnsthe total number
SecondsActiveTotalCount of seconds for all Long Yes | Yes
committed transactions

Returnsthe number of
TransactionAbandonedTotalCount transactionsthat were Long Yes | Yes
abandoned.

Returnsthe number of

committed transactions. Long Yes | Yes

TransactionCommittedTotalCount

Returnsthe number of
TransactionHeuristicsTotalCount transactionsthat Long Yes | Yes

completed with a heuristic
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status.

Returnsthe number of
transactionsthat were
rolled back dueto an
application error.

TransactionRolledBackAppTotalCount Long Yes | Yes

Returnsthe number of
TransactionRolledBackResourceTotalCount transactions that were Long Yes | Yes
rolled back dueto a

resource error.

Returnsthe number of
transactionsthat were
rolled back due to an
internal system error.

TransactionRolledBackSystem TotalCount Long Yes | Yes

Returnsthe number of
TransactionRolledBackTimeoutTotalCount transactions that were Long Yes | Yes
rolled back dueto a

timeout expiration.

Returnsthe number of

. transactionsthat were
TransactionRolledBackTotalCount rolled back. Long Yes | Yes

Returnsthe total number
of transactions processed.
TransactionTotalCount Th|stqtal Includes all Long Yes | Yes
committed, rolled back
and heuristic transaction

completions.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
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JTA

The JTA MBean name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (TransactionTotalCount is
one examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnstheraw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: =szecotdw?, Time: 8192003 6:19:56 PH, Values: 0.00000 :J
Valus : 0 [(Integer)

JTARuntime_ ActiwveTlranzaction=TotalCount

Feturn=s the number of active transactions on the =erver.

Attribute walues for MBean:

Second=ActiveTotalCount = 0
TransactionBol ledBackTotalCount = 0
TransactionHeuristic=TotalCount = 0

Fegistered = fal=se
Tran=zactionRolledBackSystemTotalCount = 0
Transactionkol ledBackAppTotalCount = 0
Tran=zactionAbandonedTotalCount = 0
TransactionTotalCount = 0

Transactionkol ledBackTimeout TotalCount = 0
ActiwveTransactionsTotalCount = 0
TransactionCommittedTotal Count = 0
CachinglDi=abled = trues

TransactionBol ledBackREesourceTotalCount = 0
Al M 4

Interval

Recommended minimum is5 minutes.

WebLogic WM Runtime

The WebLogic WM Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

150



Conductor

Counters | _ Deripton P

CachingDisabled anafte property that disables caching in Boolean Yes Yes
proxies.
Returnsthe current amount of free memory

HeapFreeCurrent (in bytes) in the M heap. Long Yes Yes

HeapSizeCurrent Returnsthe current size (in bytes) of the Long Yes Yes
VM heap.

. Returnsfalseif the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details E k|
Eerver: secotdvsd, Time: 8-19-2003 6:19:56 PH, Walues: 1.00000 :J
Value : 1 (Boolean) (True=1. Fal=e=0)

JVMREuntime CachingDi=abled

Frivate property that disables caching in proxies.

Attribute wvalue=s for MBean:

HeapFresCurrent = 14234392
JavaVer=sion = 1.3 .1_06&
HeapSizeCurrent = 48488448
JavaWendor = Sun Microsvstems Inc.
Fegistered = fal=e

COSHame = SundS

OSVersion = 5.8

Cachingli=abled = true

A Ay

Interval

Recommended minimum is5 minutes.

WebLogic Log Broadcaster Runtime

The WebLogic Log Broadcaster Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

counters Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
Returnsthetotal number of log messages

M essagesLogged generated by thisinstance of the WebLogic Long Yes Yes
server.

Registered Rgturn;false if the MBean 'represented by Boolean Yes Yes
this object has been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The name of the log broadcaster. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (MessagesLogged in this
counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details P |
Serwver: secotdwv?., Time: B8-19-2003 6:20:56 FM. Walue: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0)

LogBroadocasterFuntime CachingDi=ssbled

Frivate property that di=mables caching in proEies.

Attribute wvaluss for MB=an:

Fegiztered = false
Messageslogged = 270
CachingDi=abled = trus

il v 4

Interval

Recommended minimum is5 minutes.

WebLogic Message Driven EJB Runtime

The WebLogic Message Driven EJB Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
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WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

counters Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
M SConnectionAlive Returns_thestate of the EB's MS Boolean Yes Yes
connection.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered Boolean ves ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details :
Server: secotdvZ, Time: B8-19-2003 6:19:56 PH, VWalue: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

MessagelrivenElBRuntime CachingDi=abled

Private property that disables caching in proxies.

Attribute walues for MBsan:

EJBHame = jm=lMeszsagseformat

CachingDi=zabled = trud

Fegistered = false

JHSConnectiondlive = trus

Al W
Interval

Recommended minimum is5 minutes.

WeblLogic Migratable Service Coordinator Runtime

The WebLogic Migratable Service Coordinator Runtime category includesthe counterslisted in the
following table. Some of the counterslisted in the table may not be available on your system. WebLogic
counter categories, counter names, and parameters are dynamically discovered by processing the set of
MBeansin the WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

counters Description
CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Service
The name of the migratable service coordinator. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

1.00000 4

Datapoint Details o
Server: secotdw2. Time: B8-19-2003 6:21:56 FH., Value:
Value : 1 {(Boolean) {(Trus=1, Fal=se=0]}
MigratableServiceCoordinatorBuntime Cachingli=sabled
Frivate property that disables caching in proEies.

Attribute wvaluse=s for MBsan:

Cachingli=abled = trus
Fegi=stered = fal=e

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Server Life Cycle Runtime

The WebLogic Server Life Cycle Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

ColiniEs Description

Private property that disables caching in

. Boolean Yes Yes
proxies.

CachingDisabled

Returnsfalse if the MBean represented by

thisobject has been unregistered. Boolean ves ves

Registered

Returnsan integer that identifiesthe
SateVal current state of the server. Valuesrange Integer Yes Yes
from O to 8.
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The application server name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : |
Eerver: secotdw?. Time: 8-19-2003 6:20-:56 FM, Valus=: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

ServerlifeCyvcleRuntime CachingDisabled

Frivate property that disables caching in proxies.

Attribute wvaluses for MB=an:

CachingDi=abled = trus
Fegiztered = false
State = REUHHIHG
StateVal = 2

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Server Runtime
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The WebLogic Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

T
Description M

Counters

ActivationTime Returnsthetime when the server was Long ves | Yes
started.
Returnsthe administration port on

AdministrationPort which this server islistening for Integer Yes | Yes
connections.
Returnswhether the

AdministrationPortEnabled AdministrationPort isenabled on the Boolean | Yes | Yes
server.

AdminServer Checksif the server isan administrator Boolean | Yes | Yes
server.

AdminServerListenPort Return.sthe pqrt on which admm Integer Yes | Yes
server islistening for connections.
Returnsthe secureType on which

AdminServerListenPortSecure | admin server islistening for Boolean | Yes | Yes
connections.

CachingDisabled Erlvate.property that disables caching Boolean | Yes | Yes
in proxies.

ListenPort _Ret_urns_the port on wh_lch this server Integer ves | Yes
islistening for connections.

ListenPortEnabled _Returnswhether the default ListenPort Boolean | Yes | Yes
isenabled on the server.

OAMVersion Retl_JrnstheOAM version |r_n‘o. Integer Yes | Yes
Indicates release level of this server.
Returnsthe current number sockets

Open SocketsCurrentCount registered for socket muxing on this Integer Yes | Yes
Server.

. Returnsfalse if the MBean represented

Registered by this object has been unregistered. Boolean | Yes | Yes

RestartsTotalCount Returnsthe total number of restarts Integer | Yes | Yes
for this server since the cluster was last
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activated.

Returnsthe total number of
SocketsOpenedTotalCount registrations for socket muxing on this | Long Yes | Yes
server.

Returnsthe port on which this server

SS.ListenPort islistening for SSL connections

Integer Yes | Yes

<9 Listen PortEnabled Returnsif the default ISSListenPort is Boolean | Yes | Yes
enabled on the server.

Integer
SateVal Returnscurrent state of the server. Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

SatType

This parameter is available for countersthat are returning a count or total (SocketsOpenedTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Eerver: =ecotdw?, Times: 3-13-2003 £:1%9:56 PH., Valus: 106123368EL576 :J
Value : 1061233653334 (Long)

ServerFuntimne ActivationTimes

Feturn the time when the server was s=tarted.

Attribute walusez for ME=an:

Soclket=0penedTotalCount = 2
ActivationTime = Mondaw. August 18, 2003 3:07:38 PH EDT
WeblogicVersion = Weblogic Server 7.0 SP2 Sun Jan 26 23:09%:32 PST 2003 2341492

JVHMID = 35456500233173095 secotdv2-null mull-<168041316-7-7005-7005-2006-70067005.~700
CachingDi=zabled = true

LiztenAddress = secotdwid-10.4 27 100
State = RUHNHIHG

LiztenPort = 7005

Festart=TotalCount = 00

Fegiztered = fal=e
OpenSocketsCurrentCount = 2
AdminServerHost = zecotdw:d
SSLLiztenAddress = zecotdv2- 10 4 27 100
AdminServerlistenFort = 7001

AdminServer = fal=e

AdminServerlistenPortSecure = falss

AdministrationFort = 9002

AdministrationPortEnabled = fal=e

CurrentDirectory = <opt<bea?lZ-user projectz testdomain- .
ListenPortEnabled = trues

DAHYerszion = 2
S51LLi=tenPort = 7006
SS5LLiztenFPortEnabled = trus
StateWal = 2

1| | v s

Interval

Recommended minimum is5 minutes.

WebLogic Server Security Runtime

The WebLogic Server Security Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

s  owipion ||

Private property that
disables caching in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsthe cumulative
InvalidLoginAttemptsTotalCount number of invalid logins Long Yes | Yes
attempted on this server.

Returnsthe highest number
of userswith outstanding
invalid login attemptsfor
this server.

InvalidLoginUsersHighCount Long Yes | Yes
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Returnsthe number of
LockedUsersCurrentCount currently locked users on Long Yes | Yes
this server.

Returnsthe cumulative
number of invalid logins
attempted on this server
while the user was locked.

LoginAttemptsWhileLockedTotalCount Long Yes | Yes

Returnsfalse if the MBean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Returnsthe number of times
UnlockedUsersTotalCount a user was unlocked on this Long Yes | Yes
server.

Returnsthe cumulative
UserLockoutTotalCount number of user lockouts Long Yes | Yes
doneon this server.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

SatType

This parameter is available for countersthat are returning a count or total
(InvalidLoginAttemptsTotalCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
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I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details o K |
Eerver: secotdw?, Time: 8-19-2003 6:21-S56& PM, Value: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0)

ServerSecurityFuntime CachingDi=ssbled

Frivate property that di=mables caching in proEies.

Attribute wvalus=s for MBsan:

LoginAttempt=WhilelockedTotalCount = 0
TzerlockoutTotalCount = 0
TnlockedlUzersTotal Count = 0

Fegistered = fals=
InvalidlogindAttenpt=TotalCount = 0
InvalidloginU=zersHighCount = 0
Cachingli=zabled = trues
LockedUzersCurrentCount = 0

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Servlet Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

Returnsthe average amount of time all
ExecutionTimeAverage | invocations of the servlet have executed Integer Yes | Yes
since it was created.

Returnsthe amount of timethe single
ExecutionTimeHigh longest invocation of the servlet has Integer Yes | Yes
executed since it was created.

Returnsthe amount of timethe single
shortest invocation of the servlet has
ExecutionTimeLow executed since it was created. Note: For Integer Yes | Yes
the CounterMonitor, the difference
option must be used.
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Returnsthe amount of time all
ExecutionTimeTotal invocations of the serviet has executed Integer Yes | Yes
since it was created.

Internal Servlet g;t\lljlrerj[swhether thisisan Internal Boolean No Yes

Returnsthe total number of timesthe

InvocationTotalCount servlet has been invoked. Integer Yes | Yes
PoolM axCapacit Returnsthe maximum capacity of this Integer ves | Ves
pacity servlet for single thread model servlets. 9
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered Boolean ves | Yes
ReloadTotal Count Returnsthetotal number of timesthe Integer ves | Ves

servlet has been reloaded.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Serviet
The serviet name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (InvocationTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.
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INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Eerver: secotdw?, Time: 8-19-2003 6:21- 56 PH, Value: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0]

ServletFuntine Cachingli=abled

Frivate property that di=zables caching in proEies.

Attribute wvalus=s for MB=an:

PoolMaxCapacity = 0

Fegistered = fal=e=
ExecutionTimelow = 0
FeloadTotalCount = 0

ExecutionTimeHigh = 10

ServletPath = ~domain-HTRealm.j=p

ExecutionTimeTotal = 0

InvocationTotalCount 0

ExecutionTimsAverage 0

TEL = HTTE:~<<=ecotdw?: 7001 -console<domain-HNTEealmn.j=p

ServletHanse = weblogic managemsnt console webapp. _domain.  ntrealm
Cachingli=zabled = trus

ContextPath = <console

il v

Interval

Recommended minimum is5 minutes.

WebLogic Stateful EJB Runtime

The WebLogic Sateful EIB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes No
proxies.
. Returnsfalseif the MBean represented by
Registered thisobject has been unregistered. Boolean ves No
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details BE- |
Server: secotdwv?, Time: 8192003 6:20:56 FM. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0)

Stateful EJBERuntime CachinglDi=zabl=ed

Frivate property that dimables caching in proEies.

Attribute wvalus=s for MB=an:

EJBHame = =statefulSse=s=s=ion
Cachingli=abled = trus
Fegiztered = false

il 2
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Interval

Recommended minimum is5 minutes.

WeblLogic Stateless EJB Runtime

The WebLogic Sateless EB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters |  Deiption |

CachingDisabled _Prlvate_property that disables caching Boolean Yes Yes
in proxies.
. Returnsfalseif the MBean represented
Registered by this object has been unregistered. Boolean Yes Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.
Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

alu=: 1.00000 :l

Datapoint Details
Eerver: secotdw?, Times: 3-19-2003 £:19 56 BH,
Value : 1 (Boolean) (Trus=1, Fal=se=0)
Statelez=EJBFuntime CachingDi=abled

Frivate property that dimables caching in proEies.

Attribute wvalus=s for HB=an:

Fegiztered = false
CachinglDi=zabled = trues
EJEBName = receivelnT=

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Time Service Runtime

The WebLogic Time Service Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

CachingDisabled Prlvgte property that disables cachingin Boolean ves | Yes
proxies.
Returnsthetotal number of exceptions

ExceptionCount thrown while executing scheduled Integer Yes | Yes
triggers.

ExecutionCount Returnsthe total number of triggers Integer ves | Yes
executed.

ExecutionsPerMinute Returnsthe average num ber of triggers Integer Yes | Yes
executed per minute.

Registered Re_turn_sfalse if the MBean_represented by Boolean ves | Yes
thisobject has been unregistered.

ScheduledTriggerCount Returnsthe 'f‘“mber of currently active Integer Yes | Yes
scheduled triggers.
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Name
The name of the time service. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ExecutionCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details G

Server: secotdvZ, Time: 8-19-2003 6:1%9:56 PH, Walue: 1.00000 :J
Walue : 1 (Boolean) (Trus=1. Fal===0)

TimeServiceRuntime Cachingli=abled

Private property that disables caching in prozies.

Attribute walues for MBsan:

Fegistered = fal=ses
ExceptionCount = 0
Cachingli=abled = trus
ExecutionsFPerMinute = 21
ExecutionCount = 34696
ScheduledTriggerCount = 11

A v 4

Interval

Recommended minimum is5 minutes.

WebLogic Transaction Resource Runtime

The WebLogic Transaction Resource Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

- Coumtes = Description Type

Private property that
disables caching in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsfalse if the M Bean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Returnsthe number of

committed transactions. Long Yes | Yes

TransactionCommittedTotalCount

Returnsthe number of
transactionsfor which this
resource hasreturned a
heuristic commit decision.

TransactionHeuristicCommitTotalCount Long Yes | Yes

Returnsthe number of
transactionsfor which this
resource hasreported a
heuristic hazard decision.

TransactionHeuristicHazardTotalCount Long Yes | Yes

Returnsthe number of
transactions for which this
resource hasreported a
heuristic mixed decision.

TransactionHeuristicMixedTotal Count Long Yes | Yes
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Returnsthe number of
TransactionHeuristicRollbackTotal Count transactions for which this Long Yes | Yes
resource hasreturned a

heuristic rollback decision.

Returnsthe number of
TransactionHeuristicsTotalCount transactlons'_[hat o Long Yes | Yes
completed with a heuristic

status.

Returnsthe number of
TransactionRolledBackTotalCount transactionsthat were Long Yes | Yes
rolled back.

Returnsthetotal number
of transactions processed.
. Thistotal includes all
TransactionTotalCount committed, rolled back and Long Yes | Yes
heuristic transaction

completions.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Transaction Runtime
The JTA runtime name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Component
The JTA component name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total
(TransactionCommittedTotalCount isone examplein this counter category). Possible values are:
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ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
1.00000 |

Datapoint Details
Server: =zecotdwvZ, Time: 8-19-2003 6:20:56 FH, Value:
Value : 1 (Boolean) (Trus=1., Fal===0)
TransactionREesourceRuntime CachingDisabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

TranzactionTotalCount = 1
TransactionBEol ledBackTotalCount = 0

TransactionHeuristicHazardTotalCount = 0
TransactionHeuristic=TotalCount = 0
Cachingli=zabled = trus
TransactionHeuristicCommitTotalCount = 0

Fegistered = fal=se
TransactionCommittedTotal Count = 1
TransactionHeuristicHizedTotalCount = 0
Fezourcelamnse = weblogic. jdbc. jt=s . Connection
TransactionHeuristicRol lbackTotalCount = 0

il 2y

Interval

Recommended minimum is5 minutes.

WeblLogic Web App Component Runtime

The WebLogic Web App Component Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

Counters

Description

Private property that disables

. . . Boolean | Yes | Yes
caching in proxies.

CachingDisabled

Returnsthe current deployment

state of the module. Integer No Yes

DeploymentSate
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IndexDirectoryDisabled

Returnsthedirectory indexing
indicator configured in
weblogic.xml.

Boolean

No

Yes

JSPDebug

Returnsthe JSP'sdebug/line
numbers parameter values
configured in weblogic.xml.

Boolean

No

Yes

JSPKeepGenerated

Returnsthe JSP's KeepGenerated
parameter value configured in
weblogic.xml.

Boolean

No

Yes

JSPPageCheck Secs

Returnsthe JSP's PageCheck Secs
value configured in weblogic.xml.

Long

No

Yes

JSPVerbose

Returnsthe JSP's Verbose parameter
value configured in weblogic.xml.

Boolean

No

Yes

Open SessionsCurrentCount

Returnsthe current total number of
open sessionsin thiscomponent.

Integer

Yes

Yes

Open SessionsHighCount

Returnsthe highest of the total
number of open sessionsin this
server. The count starts at zero each
time the server is activated. Note
that thisisan optimization method
for ahighly useful statistic that
could beimplemented less

efficiently using change notification.

Integer

Yes

Yes

Registered

Returnsfalse if the MBean
represented by this object has been
unregistered.

Boolean

Yes

Yes

ServletReloadCheckSatus

Returnsthe servlet reload check
seconds configured in weblogic.xml.

Integer

No

Yes

SessionCookieM acAgentSecs

Returnsthe session's cookie max age
configured for http sessions.

Integer

No

Yes

SessionInvalidationInterval Secs

Returnstheinvalidation check timer
interval configured for http sessions.

Integer

No

Yes

SessionMonitoringEnabled

Returnsthe session monitoring
indicator configured in
weblogic.xml.

Boolean

No

Yes

SessionsOpenedTotalCount

Returnsthe total number of sessions
opened in thisserver.

Integer

Yes

Yes
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Returnsthetimeout configured for

Session Timeout Secs .
http sessions.

Integer No Yes

Returnsthe single threaded servlet
SngleThreadServletPoolSze pool size configured in Integer No Yes
weblogic.xml.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Application
The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (OpenSessionsCurrentCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details :

Server: secotdvZ, Time: 8-19-2003 6:20:5 PH, Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1., Fal===0)

WebAppComnponentBuntime CachingDi=ssbled

Private property that disables caching in proxies.

Attribute walues for MBsan:

OpenSesszionsHighCount = 0
Fegiztered = false
Sesz=zions=lpetnedTotal Count
COpeEnSesszions_urrentiCount
Sourcelnfo = ezamplesliebipp
Statu=z = DEFLOYED
CachinglDi=abled = trus
ComponentHame = ezampleslisbipp

0
0

ContextFoot = <exampleslsbiApp —
A W
Interval

Recommended minimum is5 minutes.

WeblLogic Web Server Runtime

The WebLogic Web Server Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.

DefaultWebServer Returnswhether it isthe defaultWebServer Boolean No Yes
or aVirtualHost.

. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details
Server: secotdvZ, Time: B8-19-2003 6:20:56 PH, Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=es=0)

WebServerRBuntime CachingDi=zabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

CachinglDi=zabled = trus
Fegiztered = false
WebServerHame = sxamnplesssrver

il 2

Interval

Recommended minimum is5 minutes.

WebSphere Counters

WebSphere Remote Extended Counters

The following dynamically discovered WebSphere remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebSphere system. The
categories, counter names, and parameters are all dynamically discovered by processing data available from

the WebSphere Performance Monitoring Infrastructure.

Remote monitoring supports WebSphere versions: 4.0+, 5.0, and 6.0. The counters supported vary by
version.
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WebSphere Alarm Manager Counters
WebSphere Bean Module
WebShere Cache Module
WebSphere Connection Pool Module
WebSphere DCS Sack Counters

WebSphere ORB Perf Module
WebSphere Scheduler Module
WebShere Servlet Sessions Module
WebShere System Module
WebSphere Thread Pool Module

WebShere High Availability Manager Counters WebSphere Transaction Module

WebSphere 2C Module
WebSphere VM Runtime Module

WebSphere Alarm Manager Counters

WebSphere Web App Module
WebSphere Web Services Counters

The countersdiscovered for the WebSphere Alarm Manger category are determined by the level of metrics
you set in WebShere. The WebShere Alarm Manager data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSphere
and greater) (5.0 or earlier) P Version
Total number of
alarms created by all 50 and
AlarmsCreatedCount asynchronous scopes ) High Long
. above
for this
.WorkManager.
Number of alarms 50 and
AlarmsCancelledCount cancelled by the ) High Long
A above
application.
AlarmsFiredCount l\_lumber of alarms 5.0 and High Long
fired. above
AlarmLatencyDuration _Later_w)_/ of alarmsfired | 5.0 and High Load
in milliseconds. above
AlarmsPendingSze Nu_m_ ber of ._allarms 5.0 and High Load
waiting to fire. above
AlarmRate l\_lgmber of alarms 5.0 and High Load
firing per second. above
Parameters

The following parameters are valid for this counter category:

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the

discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more serversfor monitoring. In any combination, select values from the

discovered list, or enter values manually.

Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of

available instances. The default value isthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the

discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

WebSphere Bean Module Counters

The counters discovered for the WebSphere Bean category are determined by the level of metricsyou set in
WebSphere. The WebShere Bean data counters may include the following counters;

Counter Name (6.0 and Counter Name (5.0 . WebSpher ~EE
: Description . of
greater) or earlier) e Version .
Metrics
Number of
CreateCount creates times beans 3.5.5 and Low Long
above
were created.
Number of
times beans 3.5.5and
RemoveCount removes Low Long
were above
removed.
Number of
times beans
PassivateCount passivates were 3.5.5and Low Long
passivated above
(entity and
stateful).
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ActivateCount

activates

Number of
times beans
were
activated
(entity and
stateful).

3.5.5 and
above

Low

Long

LoadCount

persistence loads

Number of
times bean
datawas
loaded from
persistent
storage
(entity).

3.5.5 and
above

Low

Long

SoreCount

persistence stores

Number of
times bean
datawas
stored in
persistent
storage
(entity).

3.5.5 and
above

Low

Long

InstantiateCount

instantiations

Number of
times bean
objects were
instantiated.

3.5.5 and
above

Low

Long

FreedCount

destroys

Number of
times bean
objects were
freed.

3.5.5 and
above

Low

Long

Ready Count

Num Ready Beans

Number of
concurrently
ready beans
(entity and
session). This
counter was
called
concurrent
activein
Versions
3.5.5+ and
4.0.

3.5.5 and
above

High

Load

LiveCount

concurrent live

Number of
concurrently
live beans.

3.5.5 and
above

High

Load

MethodResponseTime

avg method rsp time

Average
response
timein
milliseconds
on the bean

3.5.5 and
above

High

Long
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methods
(home,
remote,
local).

CreateTime

avg method rsp time
for create

Averagetime
in
milliseconds
a bean create
call takes,
including
thetime for
theload, if
any.

5.0

Mediu

Long

LoadTime

avg method rsp time
for load

Average time
in
milliseconds
for loading
the bean
data from
persistent
storage
(entity).

5.0

Mediu

Long

SoreTime

avg method rsp time
for store

Average time
in
milliseconds
for storing
the bean
datato
persistent
storage
(entity).

5.0

Mediu

Long

RemoveTime

avg method rsp time
for remove

Averagetime
in
milliseconds
abean entry
call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

MethodCallCount

total method calls

Total
number of
method
calls.

3.5.5 and
above

High

Long
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ActivationTime

avg method rsp time
for activation

Average time
in
milliseconds
a
beanActivate
call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

PassivationTime

avg method rsp time
for passivation

Average time
in
milliseconds
a

bean Passivat
e call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

ActiveMethodCount

active methods

Number of
concurrently
active
methods -
number of
methods
called at the
sametime.

3.5.5 and
above

High

Long

RetrieveFromPoolCount

Per method
invocations

Number of
callsto the
bean
methods
(home,
remote,
local).

3.5.5 and
above

Long

RetrieveFrom PoolSuccessCoun
t

Per method rsp time

Average
response
timein
milliseconds
on the bean
methods
(home,
remote,
local).

3.5.5 and
above

M ax

Long

ReturnsToPoolCount

Per method
concurrent
invocations

Number of
concurrent
invocations
tocall a
method.

5.0

M ax

Load
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RetrieveFromPoolCount

getsFrom Pool

Number of
calls
retrieving an
object from
the pool
(entity and
stateless).

3.5.5 and
above

Low

Long

RetrieveFrom Pool SuccessCoun
t

getsFound

Number of
timesa
retrieve
found an
object
availablein
the pool
(entity and
stateless).

3.5.5 and
above

Low

Long

ReturnsToPoolCount

returnsToPool

Number of
calls
returning an
object to the
pool (entity
and
stateless).

3.5.5 and
above

Low

Long

ReturnsDiscardCount

returnsDiscarded

Number of
timesthe
returning
object was
discarded
because the
pool was full
(entity and
stateless).

3.5.5 and
above

Low

Long

DrainsFromPoolCount

drainsFrom Pool

Number of
timesthe
daemon
found the
pool wasidle
and
attempted to
clean it
(entity and
stateless).

3.5.5 and
above

Low

Long

DrainSze

avgDrainSze

Average
number of
objects
discarded in
each drain
(entity and
stateless).

3.5.5 and
above

Mediu

Long
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PooledCount

avgPoolSze

Number of
objectsin
the pool
(entity and
stateless).

3.5.5 and
above

High

Load

MessageCount

messageCount

Number of
m essages
delivered to
the bean on
M essage
method
(message
driven
beans).

5.0

Low

Long

M essageBackoutCount

m essageBackoutCoun
t

Number of
m essages
failed to be
delivered to
the bean on
M essage
method
(message
driven
beans).

5.0

Low

Long

WaitTime

serverSessionWait

Average time
to obtain a
Server
Session from
the pool
(message
drive bean).

5.0

Mediu

Long

ServerSessionPoolUsage

serverSessionUsage

Percentage of
Server
Session pool
in use
(message
driven).

5.0

High

Load

Parameters

The following parameters are valid for this counter category:

Enterprise Beans (WebSphere Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.
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Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Container
Name of bean container to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Bean
Name of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Enterprise Beans (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Jar File
Name of jar fileto monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

EB Type
Type of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more typesfor monitoring. In any combination, select values from the
discovered list, or enter values manually.

Bean
Name of Enterprise JavaBeans (EJB) to monitor.

183



QALoad 05.06 Using the Conductor

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Cache Module Counters

The counters discovered for the Cache category are determined by the level of metricsyou set in
WebShere. The Cache data countersmay include the following counters:

WebSph
Description ere
Version

Counter Name (6.0 and Counter Name (5.0 or

greater) earlier)

Maximum
MaxInMemoryCacheEntryCo maxinMemoryCacheSize number of in- | 5.0 and Low Lon
unt memory above g
cache entries.
Current
InMemoryCacheEntryCount inMemoryCacheSze number of in- | 5.0 and Low Lon
memory above g
cache entries.
Aggregate of
TimeoutlnvalidationCount totalTimeoutinvalidation tgmplate 5.0 and Low Lon
timeoutsand above g
disk timeouts.
Requests for
this cacheable 50 and Lon
HitssnMemoryCount hitssnMemory object served ) Low
above g
from
memory.
Requests for
HitsOnDiskCount hitsOnDisk th|_s cacheable | 5.0 and Low Lon
object served above g
from disk.
ExplicitinvalidationCount explicitinvalidations Total explicit | 5.0 and Low Lon
invalidation above g9
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issued for this
template.

LrulnvalidationCount

lrulnvalidations

Cache entries
evicted from
memory by a
Least
Recently Used
algorithm.
These entries
are passivated
to disk if disk
overflow is
enabled.

5.0 and
above

Low

Lon

TimeoutlnvalidationCount??
77

timeoutlnvalidations

Cache entries
evicted from
memory
and/or disk
because their
timeout has
expired.

5.0 and
above

Low

Lon

InMemoryAndDiskCacheEntr
yCount

Entries

Current
number of
cache entries
created from
thistemplate.
Refersto the
per-template
equivalent of
totalCacheSz
e.

5.0 and
above

Low

Lon

MissCount

Misses

Requests for
this cacheable
object that
were not
found in the
cache.

5.0 and
above

Low

Lon

ClientRequestCount

RequestFrom Client

Requests for
this cacheable
object
generated by
applications
running on
the
application
server.

5.0 and
above

Low

Lon

DistributedRequestCount

requestsfrfom VM

Requests for
this cacheable
object
generated by
cooperating

5.0 and
above

Low

Lon
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cachesin this
cluster.

ExplicitMemorylnvalidation
Count

explicitinvalidationsFrom
Memory

Explicit
invalidations
resulting in
an entry
being
removed
from
memory.

5.0 and
above

Low

Lon

ExplicitDiskInvalidationCou
nt

explicitinvalidationsFrom
Disk

Explicit
invalidations
resulting in
an entry
being
removed
from disk.

5.0 and
above

Low

Lon

ExplicitinvalidationCount

explicitinvalidationsNoOp

Explicit
invalidations
received for
thistemplate
whereno
correspondin
g entry exists.

5.0 and
above

Low

Lon

LocalExplicitinvalidationCou
nt

explicitinvalidationsLocal

Explicit
invalidations
generated
locally, either
programmatic
ally or by a
cache policy.

5.0 and
above

Low

Lon

RemoteExplicitinvalidationC
ount

explicitinvalidationsRemot
e

Explicit
invalidations
received from
a cooperating
MM in this
cluster.

5.0 and
above

Low

Lon

RemoteCreationCount

remoteCreations

Entries
received from
cooperating
dynamic
caches.

5.0 and
above

Low

Lon

Parameters

The following parameters are valid for this counter category:

Dynamic Cache (WebSphere Version 5)

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more serversfor monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of
available instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Connection Pool Module Counters

The counters discovered for the DBC Connection Pool category are determined by the level of metrics you
set in WebSphere. The IDBC Connection Pool data countersmay include the following listed counters.

Performance Monitoring Infrastructure (PMI) collects performance data for 4.0 and 5.0 JDBC data sources.
For a 4.0 data source, the data source name isused. For a 5.0 data source, the Java Naming and Directory
Interface (INDI) nameisused.

Counter
Counter Name (6.0 and Name (5.0 Description WebSr_Jhere Level_ of
greater) . Version Metrics
or earlier) SR

Total number 3.55 and
CreateCount Creates of connections A Low Long
above
created.
Bounded
PoolSze Avg Pool Sze Average pool 3.5.5and High Range
size. above A
Satistic
Average free Bounded
FreePoolSze Free Pool Sze 9 5.0 High Range
pool size. Satistic
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AllocateCount

Allocates

Total number
of connections
allocated.

3.5.5 and
above

Low

Long

ReturnCount

Returns

Total number
of connections
returned.

4.0 and
above

Low

Long

WaitingThreadCount

Avg Waiting
Threads

Number of

threadsthat
are currently
waiting for a
connection.

3.5.5 and
above

High

Sat

FaultCount

Connection
Pool Faults

Total number
of faults, such
as, timeouts, in
connection
pool.

3.5.5 and
above

Low

Long

CloseCount

Destroys

Number of
times bean
objects were
freed.

3.5.5 and
above

Low

Long

WaitTime

Avg Wait
Time

Average
waiting timein
milliseconds
until a
connection is
granted.

5.0

Medium

Long

UseTime

Avg Timein
Use

Averagetime a
connection is
used.

5.0

Medium

Long

PercentUsed

Percent Used

Average
percent of the
pool that isin
use.

3.5.5 and
above

High

Sat

PercentM axed

Percent
M axed

Average
percent of the
timethat all
connections
arein use

3.5.5 and
above

High

Sat

PrepSmtCacheDiscardCount

Satement
Cache discard
count

Total number
of statements
discarded by
the LRU
algorithm of
the statement
cache.

4.0 and
above

Low

Long
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Number of
Number M an aged
ManagedConnectionCount Managed ged 5.0 Low Long
. Connection
Connections . .
objectsin use.
Current
ConnectionHandleCount Number. number_of 5.0 Low Long
Connections connection
objectsin use
Amount of
timein
JDBC milliseconds
JDBCTime Operation spent 5.0 Medium | Long
Timer executingin
the IDBC
driver.
Concurrent
Waiters
Parameters

The following parameters are valid for this counter category:

JDBC Connection Pools (Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, enter values manually, or enter wildcard patterns.

Data Source

Name of data source.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

JDBC Connection Pools (Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Sarver Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default valueisthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Provider
Name of data source provider to monitor.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Data Source
Name of data source to monitor.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Sat, or Bounded Range Satistic.

Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere DCS Stack Counters

The counters discovered for the WebSphere DCS Sack category are determined by the level of metrics you
set in WebSphere. The WebSphere DCS Sack data counters may include the following counters:

Counter Name
(6.0 and COURtEr Name Description ‘ WebsSphere  Level of =) poing Type
greater) (5.0 or earlier) Version Metrics

Number of
message buffer
reallocations due
to inadequate
buffer size. If this
number islarger 6.0 and
than 20 percent above
of the number of
sent messages,
you may want to
contact I1BM
Support.

Number of
message buffer
reallocations

Medium | Long
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Outgoing

Minimal,
maximal, and
average size (in
bytes) of the

6.0 and

message size messages that above High (AverageStatistic)
were sent
through the DCS
stack.
Number of
Number of sent messages sent 6.0 and High Lon
m essages through the DCS | above 9 9
stack.
Minimal,
maximal and
. average size (in
Incommg_ bytes) of the 6.0 and High (AverageStatistic)
message size above
messages that
were received by
the DCSstack.
Number of rl\rl1uer3$§ge;50f 6.0 and
:ﬁcei\;egs received by the above High Long
9 DCSstack.
Amount of time Amount of time
needed to
needed for the
L guarantee that 6.0 and .
synchronization . High Sat
all view above
procedure to
members are
complete .
synchronized.
Number of
Number of messages that
M essages \r,\g:::nsmitted it
retransmitted . ) 6.0 and . (AverageSatistic)
during the view High
by local above
. changeto ensure
member during L
the view change synchronlzatlon
with other
members.
Number of Number of times
timesthat the that the 6.0 and
synchronization synchronization ak.:)ove Medium | Long
procedure procedure timed
timed out out.
Number of Number of times
timesthat a that ahigh 6.0 and _
high severity severity above Medium | Long
congestion congestion event
event for for outgoing
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outgoing
m essages was
raised

m essages was
raised.

Coalesce Time

Measuresthe
amount of time
it actually takes
to coalesce a
view.

6.0 and
above

Medium

Sat

Join View
Change Time

Measuresthe
timetodo a
merge view
change. The DCS
stack is blocked
during thistime.

6.0 and
above

High

Sat

Remove View
Change Time

Measuresthe
timeto do a split
view change.
DCSstack is
blocked during
thistime.

6.0 and
above

High

Sat

Number of
suspicions

Measuresthe
number of times
that thelocal
member
suspected other
members.

6.0 and
above

High

Long

Number of view
changes

Number of times
that thismember
underwent view
changes.

6.0 and
above

Medium

Long

View group size

Measuresthe size
of the group the
local member
belongsto.

6.0 and
above

Medium

(AverageSatistic)

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Sarver Name
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Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

WebSphere High Availability Manager Counters

The countersdiscovered for the WebSphere High Availability Manager category are determined by the level
of metricsyou set in WebSphere. The WebSphere High Availability Manager data counters may include the
following counters:

Counter Name (6.0 Counter Name Descrintion WebSphere
and greater) (5.0 or earlier) P Version

Number of local Total number of local | 6.0 and

High Load
groups groups. above

Time taken in
millisecondsto
rebuild the global
group state. During
therebuild time, no
fail-over can happen.
If thistimeistoo
high and is
unacceptable for the
Group state rebuild desired availability, 6.0 and
time you may want to above
increase the number
of coordinators. For
proper operation of
thiscounter, you
must host the active
coordinator in an
application server
other than the
deployment

High Sat
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manager.

Number of bulletin-
board subjects

Total number of
subjects managed.

6.0 and
above

High

Load

Number of bulletin-
board subscriptions

Total number of
bulletin-board
subscriptions.

6.0 and
above

High

Load

Bulletin-board
rebuild time

Timetaken in
millisecondsto
rebuild the global
state of the bulletin-
board. During this
time no messages
will be received by
the subscribers. If
thistimeistoo high,
and isunacceptable,
you may want to
increase the number
of coordinators. For
proper operation of
thiscounter, you
must host the active
coordinator in an
application server
other than the
deployment
manager.

6.0 and
above

High

Sat

Number of local
bulletin-board
subjects

Total number of
subjects being posted
to locally. The
number includesthe
proxy postings (if
any) done by the
core group bridge
service on behalf of
servers belonging to
different WebSphere
cells.

6.0 and
above

High

Load

Number of local
bulletin-board
subscriptions

Total number of local
subject subscriptions.
The number includes
the proxy
subscriptions (if any)
done by the core
group bridge service
on behalf of servers

6.0 and
above

High

Sat
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belonging to
different WebSphere
cells.

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

WebSphere 2C Connection Pool Module Counters

The counters discovered for the 2C Connection Pool category are determined by the level of metricsyou
set in WebSphere. The 2C Connection Pool data counters may include the following counters:

Counter
Counter Name (6.0 and Name (5.0 Description WebSphere Level' of
greater) Version Metrics

or earlier)
Number Number of Managed
. : . . 5.0 and
ManagedConnectionCount | managed Connection objectsin above Low Long
connections | use.
ConnectionHandleCount Number Current number of 5.0 and Low Long
connections | connection objectsin | above
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use.

Number
CreateCount manage(_j Total num ber of 5.0 and Low Long
connections | connections created. above
created
Number Total number of
managed . 5.0 and
CloseCount : connections Low Long
connections destroved above
destroyed yed.
Number Total number of
managed . 5.0 and
AllocateCount : connections Low Long
connections above
allocated.
allocated
Number
FreedCount manage(_j Total num ber of 5.0 and Low Long
connections | connectionsfreed. above
freed
Number of faults, 50 and
FaultCount faults such astimeouts, in ) Low Long
: above
the connection pool.
free pool Number of free 50 and
FreePoolSze reep connectionsin the ) High Sat
size above
pool.
. . 5.0 and .
PoolSize pool size Pool size. above High Sat
Average number of
WaitingThreadCount concurrent thrlegds concurrently 5.0 and High Load
waiters waiting for a above
connection.
Percent Average percent of 50 and
PercentUsed the pool that isin ) High Load
used above
use.
Average percent of
PercentM axed Percent thet|me_that aII_ 5.0 and High Load
maxed connectionsarein above
use.
Average waiting time
WaitTime AV(_era_ge in milliseconds until a 5.0 and Medium | Long
wait time . above
connection isgranted.
Averagetimein
UseTime A_verage use mHhsecgndsthaF 5.0 and Medium | Long
time connectionsarein above

use.
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Parameters

The following parameters are valid for this counter category:
J2C Connection Pools (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default valueisthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of
available instances. The default valueisthefirst instancein thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Java Virtual Machine (VM) Runtime Module Counters

The countersdiscovered for the Java Virtual Machine (VM) category are determined by the level of metrics
you set in WebSphere. The WM data counters may include the following counters:

Counter
Counter Name (6.0 NEE o WebSphere
Description ’
and greater) Version
earlier)
FreeMemory Free Free memory in VM run time. 3.5.5and Low Long
memory above
UsedMemory Used Used memory in VM run time. 3.5.5and Low Long
memory above
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HeapSze Total Total memory in WM run time. 3.5.5 and High Long
memory above
UpTime Up time Thea_tmountofﬂmetheJVM is | 5.0and Low Long
running. above
Number of garbage collection
N{;l;ab(zr calls. Thiscounter isnot 4.0 and
GCCount g o available unless - ' Max Long
collection . . . . above
calls Xrunpmi Jvnpi Profil er isset
when starting the WM.
A Average garbage collection in
ti\r/:éage seconds between two garbage
GCintervalTime between coII_(lag'glon. T|h|scounter Isnot 4.0 and M ax Long
arbage available unless - above
gollection Xrunpmi Jvnpi Profil er isset
when starting the WM.
Average Averag_e durat|_0n of aga_rbage
arbage collection. This counter isnot 4.0 and
GCTime g 9 available unless - i M ax Long
collection . . . . above
duration Xrunpmi Jvnpi Profil er isset
when starting the WM.
Number of timesthat athread
num waits for alock.This counter is 4.0 and
W aitsForLockCount waits for not available unless - above M ax Long
alock Xrunpm Jvnpi Profil er isset
when starting the WM.
Average time that athread
avgtime waits for alock. This counter is 4.0 and
WaitForLockTime waiting not available unless - above M ax Long
for lock Xrunpmi Jvnpi Profil er isset
when starting the WM.
Number of objects allocated in
Number heap. This counter isnot 4.0 and
ObjectAllocateCount | of objects | available unless - above M ax Long
allocated Xrunpm Jvipi Profil er isset
when starting the WM.
ObjectMovedCount
Number of objectsin heap.
Number This counter isnot available 4.0 and
of objects | unless- above M ax Long
found Xrunpmi Jvnpi Profil er isset
when starting the WM.
Number of objectsfreed in
. 4.0 and
ObjectFreedCount Number heap. This counter isnot Max Long
of objects ; above
available unless -
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freed Xrunpmi Jvnpi Profil er isset
when starting the WM.

Number of threads started. This
counter isnot available unless
ThreadSartedCount the -XrunpmidmpiProfiler
option isset when starting the
NM.

4.0 and
above

Number of failed threads. This
counter isnot available unless
ThreadEndedCount the -XrunpmidmpiProfiler
option isset when starting the
NM.

4.0 and
above

Parameters

The following parameters are valid for this counter category:

JVM Runtime (WebSphere All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Object Pool Counters

The counters discovered for the WebSphere Object Pool category are determined by the level of metrics
you set in WebSphere. The WebSphere Object Pool data counters may include the following counters:
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Counter Name (6.0 Counter Name Description WebSpher
and greater) (5.0 or earlier) P Version

. Total number of 5.0 and .
ObjectsCreatedCoun objects created. above High Long
Number of objects 50 and
ObjectsAllocatedCount requested from the aBove High Long
pool.
Number of objects 50 and
ObjectsReturnedCount returned to the ’ High Long
above
pool.
Average number of 50 and
IdleObjectsSze idle object instances ) High Load
. above
in the pool.
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default valueisthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.
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WebSphere ORB Perf Module Counters

The counters discovered for the Object Request Broker (ORB) category are determined by the level of
metricsyou set in WebSphere. The ORB data counters may include the following counters:

Counter Name (6.0 and Counter Name (5.0 _ WebSphere Level of
: Description - :
greater) or earlier) = Version Metrics

Thetime (in
milliseconds)
to look up an
object 5.0 and
reference above
before method
dispatch can
be carried out.

LookupTime referenceLookupTime Medium | Long

The total
number of 5.0 and
RequestCount num Request requests sent above Low Long

to the ORB.

The number
of requests
that are 5.0 and
concurrently above
processed by
the ORB.

ConcurrentRequestCount | concurrentRequests High Load

Thetime (in
milliseconds)
it takesa 5.0 and
ProcessingTime processingTime registered ) Medium | Long
above
portable
interceptor to
run.

Parameters

The following parameters are valid for this counter category:

Object Request Broker (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Sarver Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default valueisthe first application server in thelist.
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You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of
available instances. The default valueisthefirst instancein thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Scheduler Module Counters

The countersdiscovered for the WebSphere Scheduler category are determined by the level of metrics you
set in WebSphere. The WebSphere Scheduler data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSphere
and greater) (5.0 or earlier) P Version

. Number of tasksthat 5.0 and
TaskFailureCount failed to run. above High Long
. Number of tasksthat 5.0 and
TaskFinishCount ran successfully. above High Long
Number of poll
PollCount cycles completed for 5.0 and High Long
above
all daemon threads.
TaskEinishRate Number of tasksrun 5.0 and High Load
per second. above
Number of collisions
encountered per 50 and
TaskCollisionRate second between ) High Load
. above
competing poll
daemons.
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Sart timein

. milliseconds for each 5.0 and .
PollQueryDuration poll daemon thread's | above High Load
database poll query.

: Timein milliseconds 5.0 and .
RunDuration taken to run atask.. above High Load
TaskExpirationRate Number of tasksin a 5.0and High Load

poll query. above
Period of timein 50 and
TaskDelayDuration secondsthat the task ) High Load
. above
isdelayed.
PollDuration Number of seconds 5.0 and High Load
between poll cycles. above
Number of tasksrun
by each poll daemon
thread. (Multiply this
by the number of 5.0 and .
TaskRunRate poll daemon threads above High Load
to get the tasksrun
per effective poll
cycle.)
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Sarver Name

Application server to monitor. Select the server name that you want to monitor from thelist of

available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of
available instances. The default value isthefirst instancein the list.
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You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Serviet Sessions Module Counters

The counters discovered for the Servlet Sessions category are determined by the level of metricsyou set in
WebShere. The Servlet Sessions data counters may include the following counters;

Counter Name (6.0 and Counter Name (5.0 .
. Description
greater) or earlier) - 5 Version
CreateCount createdSessions N““.“ber of 3.5.5 and Low Long
sessions created. above
. . . . N““.“ber of 3.5.5and
InvalidateCount invalidatedSessions sessions Low Long
. . above
invalidated.
LifeTime sessionLifeTime Average session 3.5.5 and Mediu Long
lifetime. above m
Number of
concurrently
active sessions. A
session isactive if 355 and
ActiveCount activeSessions WebSphereis alljo.ve High Load
currently
processing a
request that uses
that session.
Number of
LiveCount liveSession sessonsthat are 5.0 and High Load
currently cached above
in memory.
_ | Appliesonly to
NoRoomForNewSessionCo NoRoom ForNew Sessi sgssmn in memory 50 Low Long
unt on with
AllowOverflow=fal
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se. The number of
timesthat a
request for anew
session cannot be
handled because it
would exceed the
maximum session
count.

CacheDiscardCount

cacheDiscards

Number of session
objectsthat have
been forced out of
the cache. (An
LRU algorithm
removesold
entriesto make
room for new
sessions and cache
misses). Applicable
only for persistent
sessions.

5.0

Low

Long

ExternalReadTime

externalReadTime

Time (in
milliseconds)
taken in reading
the session data
from persistent
store. For multi-
row sessions, the
metrics are for the
attribute; for
single-row
sessions, the
metrics are for the
whole session.
Applicable only
for persistent
sessions. When
usingaJMS
persistent store,
you havethe
choice of whether
to serialize the
data being
replicated. If you
choose not to
serialize the data,
the counter isnot
available.

504

Mediu

Long

ExternalReadSze

externalReadSze

Sze of session data
read from
persistent store.
Applicable only
for (serialized)

5.0

Mediu

Lon
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persistent sessions;
similar to
externalReadTime
above.

ExternalWriteTime

externalWriteTime

Time
(milliseconds)
taken to writethe
session data from
the persistent
store. Applicable
only for
(serialized)
persistent sessions.
Smilar to
externalReadTime
described above.

5.0

Mediu

Lon

ExternalWriteSze

externalWriteSze

Sze of session data
written to
persistent store.
Applicable only
for (serialized)
persistent sessions.
Smilar to
externalReadTime
described above.

5.0

Mediu

Lon

AffinityBreakCount

affinityBreaks

The number of
requests received
for sessionsthat
were last accessed
from another Web
application. This
can indicate
failover processing
or acorrupt plug-
in configuration.

5.0

Low

Long

SessionObjectSze

serializableSessObjSz
e

The size in bytes
of (the attributes
that can be
serialized) in-
memory sessions.
Only count
session objects
that contain at
least one attribute
object that can be
serialized. Note
that a session may
contain some
attributesthat can
be serialized and
somethat are not.

5.0

Long
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Thesizein bytesis
at a session level.

Thetime
differencein
milliseconds

TimeSncelLastActivated timeSnceLastActivat between previous 50 Mediu Long
ed and current access m
time stamps. Does
not include

session time out.

The number of

requests for a

. . - session that no

TimeoutinvalidationCount :Jrlval|datedV|aT|me0 CountSatistic 5.0 Low Long
exists, presumably

because the

session timed out.

Number of
requests for a
session that no
longer exists,
presumably
because the 5.0 Low Long
session timed out.
Use this counter to
help determine if
thetimeout istoo
short.

ActivateNonExistSessionCo | attemptToActivateN
unt ot ExistentSession

Parameters

The following parameters are valid for this counter category:
Servlet Sessions (WebSphere Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Servlet Sessions (WebSphere Version 5)

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
War File
Name of war file to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere System Module Counters

The countersdiscovered for the System category are determined by the level of metricsyou set in
WebSphere. The System data counters may include the following counters:

Counter Name WebSpher Level of

Counter Name (6.0 and greater) Description

(5.0 or earlier) e Version Metrics

Average system
CPU utilization
taken over the
timeinterval

CPUUsageSncelLastMeasuremen percentCpuUsage gncgthe |ast 50 Low Lon
t reading. Because g
thefirst call is
required to
perform

initialization, an
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invalid value
such asOis
returned. All
subsequent calls
return the
expected value.
On SMP
machines, the
valuereturned is
the utilization
averaged over all
CPUs.

FreeMemory

freeMemory

The amount of
real free memory
available on the
system. Real
memory that is
not allocated is
only alower
bound on
available real
memory, since
many operating
systemstake
some of the
otherwise
unallocated
memory and use
it for additional
I/0O buffering.
The exact
amount of buffer
memory that can
be freed up is
dependent on
both the
platform and the
application(s)
running on it.

5.0

Low

Lon

CPUUsageSnceServerSarted

avgCpuUtilizatio
n

The average
percentCpuUsag
ethat isbusy
after the server is
started.

5.0

Mediu

Lon

Parameters

The following parameters are valid for this counter category:

System Performance (WebSphere Version 5)

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Thread Pool Module Counters

The counters discovered for the Thread Pool category are determined by the level of metricsyou set in
WebSphere. The Thread Pool data counters may include the following counters:

Counter el Level Data
Name . WebSpher S e
Name (6.0 Description : of Point
(5.0 or Version — || =
and greater) : Metrics  Type
earlier) laEanies
CreateCount Thread Total number of threads created. 3.5.5 and Low Long
creates above
DestroyCount Thread Total number of threads destroyed. 3.5.5 and Low Long
destroys above
ActiveCount Active Number of concurrently active 3.5.5and High Load
threads threads. above
PoolSze Pool size Average number of threadsin pool. 2550'3;1”(1 High Load
PercentM axed Percent Average perpent of thetimethat all 3.5.5and High Load
maxed threads arein use. above
Parameters

The following parameters are valid for this counter category:
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Thread Pools (WebSphere All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthefirst nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Pool
Name of thread pool to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Transaction Module Counters

The counters discovered for the Transaction category are determined by the level of metricsyou set in
WebShere. The Transaction data counters may include the following counters:;

Counter Name (6.0 and Counter Name . WebSpher
. Description .
greater) (5.0 or earlier) e Version
Number global T;)c;tglalnumber of 4.0 and
GlobalBegunCount transactions 9 . ) Low Long
transactions above
begun
begun on server.
Total number of
Number global global 4.0 and
GloballnvolvedCount transactions transactions above Low Long
involved involved on
server (for
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example, begun
and imported).

Number local

Total number of

LocalBegunCount transactions local transactions gb%\?gd Low Long
begun begun on server.
Number of
ActiveCount Active g_lobal coqcurrently 3.5.5and Low Load
transactions active global above
transactions.
Number of
Local ActiveCount Active I(_)cal coqcurrently 4.0 and Low Load
transactions active local above
transactions.
Global Average duration :
GlobalTranTime transactions of global 3.5.5and Mediu Sat
. . above m
duration transactions.
. Local transaction Average duration 4.0 and Mediu
LocalTranTime . of local Sat
duration . above m
transactions.
Average duration
GlobalBeforeCompletionTim Local transact|0_ns of . 4.0 and Mediu
before_completio before_completio Sat
e . above m
ntime n for local
transactions.
Global Q]zlg)arlﬁ%??;gtrlon 4.0 and Mediu
GlobalCommitTime transaction ) Sat
. global above m
commit time .
transactions.
Global Q;/errigz:jeufr(?rtlon 4.0 and Mediu
GlobalPrepareTime transaction brep ) Sat
: global above m
preparetime .
transactions.
Average duration
Local transaction of .
LocalBeforeCompletionTime | before_completio before_completio 4.0 and Mediu Sat
. above m
ntime n for local
transactions.
_— Local transaction Average Quranon 4.0 and Mediu
LocalCommitTime . of commit for Sat
commit time . above m
local transactions.
Number global Total number of
. . global 3.5.5 and
CommittedCount transactions . Low Long
: transactions above
committed :
committed.

212




Conductor

Total number of
Number of global lobal 355 and
RolledbackCount transactions 9 . o Low Long
transactions above
rolled back
rolled back.
Number of global
Number global transactions
L . 4.0 and
OptimizationCount transactions converted to Low Long
T : above
optimized single phase for
optimization.
Number of local Number of local 4.0 and
LocalCommittedCount transactions transactions ) Low Long
. : above
committed committed.
Number of local Number of local 4.0 and
LocalRolledbackCount transactions transactions ) Low Long
above
rolled back rolled back.
Number of global Number of global 4.0 and
Global TimeoutCount transactions transactions ) Low Long
) . above
timed out timed out.
Number of local Number of local
. : . 4.0 and
LocalTimeoutCount transactions transactions Low Long
. . above
timed out timed out.

Parameters

The following parameters are valid for this counter category:

Transactions (All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere

IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.
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Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere Web App Module Counters

The counters discovered for the Web Application category are determined by the level of metricsyou set in
WebShere. The Web Application data counters may include the following counters:

Counter Name (6.0  Counter Name Description WebSphere Level of
and greater) (5.0 or earlier) P Version Metrics
LoadedServletCount | numLoadedServlets Number of serviets 3.5.5and Low Long
that were loaded. above
ReloadCount numReloads Number of serviets 3.5.5and Low Load
that were reloaded. above
Total number of 3.55 and
RequestCount totalRequests requests a servlet atl)olve Low Long
processed.
Number of requests 3.55 and
ConcurrentRequests | concurrentRequests | that are concurrently akl)olve High Sat
processed.
Responsetime, in 355 and
ServiceTime responseTime milliseconds, of a - Medium | Long
above
servlet request.
Total number of
X 3.5.5and
ErrorCount numErrors errorsin aservlet or above Low Long
Java Server Page (JSP).
Parameters

The following parameters are valid for this counter category:

Web Applications (Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Sarver Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default valueisthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Serviet
Name of servlet to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Web Applications (Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
War File
Name of war fileto monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Sarvlet
Name of servlet to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.
Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
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Business Machines Corporation.

WebSphere Web Services Module Counters

The countersdiscovered for the WebSphere Web Service category are determined by the level of metrics
you set in WebSphere. The WebSphere Web Service data counters may include the following counters:

Counter Name (6.0 and CaRTIET . WebSphere Level of
Name (5.0 Description — -
greater) . Version Metrics
or earlier)

LoadedWebServiceCount Number 9f loaded 5.02 and Low Long
Web services. above
ReceivedRequestCount Number' of rquests 5.02 and Low Long
the service received. above
. Number of requests 5.02 and
DispatchedRequestCount the service dispatched. | above Low Long
Number_ of requests 502 and
ProcessedRequestCount the service Low Sat
above
successfully processed.
Average response
. time, in milliseconds, 5.02 and .
ResponseTime for a successful above High Sat
request.
Average response
RequestResponseTime time, in milliseconds, 5.02 and Medium | Sat
to prepare arequest above
for dispatch.
Average response 5.02 and
DispatchResponseTime time, in milliseconds, ) Medium | Sat
. above
to dispatch arequest.
Average response
ReplyResponseTime time, in milliseconds, 5.02 and Medium | sat
to prepare areply after | above
dispatch.
Average payload size 5.02 and
PayloadSze in bytesof areceived ) Medium | Sat
above
request or reply.
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. Average payload size 5.02 and .
RequestPayloadSze in bytes of a request. above Medium | Sat
Average payload size 5.02 and .
ReplyPayloadSze in bytes of areply. above Medium | Sat

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of
available instances. The default value isthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere IDPs

(Intelligent Data Points): Long.

Interval
Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International
Business Machines Corporation.

WebSphere MQ Counters

WebSphere MQ Remote Extended Counters

The following extended WebSphere MQ remote countersare provided in QALoad. These counters extend

the monitoring of your WebSphere MQ system:
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Channel Events

Channel Satus

Error Log Entries

Percent Queue Depth

Performance Events

Queue Depth

Queue Manager Connections
Queue Manager Events
Queue Manager Satistics
Queue Manager Up/Down

Queue Satistics

WebSphere MQ Channel Events

This counter reportsthe number of channel events for the current interval.

Parameters

Queue Manager

Queue manager you are monitoring.

Event Name

Soecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored

unless event name(s) are selected.

Event Name ‘

Channel Activated

Channel Auto-
Definition Error

Channel Auto-
Definition OK

Channel
Conversion Error

Channel Not
Activated

Channel Sarted
Channel Sopped

Channel Sopped
By User

Description

This condition is detected when achannel that has been
waiting to become active,and for which a Channel Not
Activated event has been generated, isnow able to become
active, because an active slot has been released by another
channel.

Automatic channel definition failed.
Automatic channel definition succeeded.
This condition isdetected when achannel isunableto carry out

data conversion.

The channel isunableto establish the connection because the
limit on the number of active channels has been reached.

An instance of achannel has been successfully established
The channel was stopped.

The channel has been stopped by the operator.

Primary Data Point

218
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Intelligent Data Point

Theintelligent data point displaysthe number of channel events, description of individual events
(event name, date & time that the message was put on the event queue, name of the queue manager
that put the message, queue associated with the event, and reason code).

Channel events are reported by channels as aresult of conditions detected during their operation.
For example, when achannel instanceisstopped. Channel events are generated:

! By acommand to start or stop achannel

I When achannel instance starts or stops

I When achannel receives a conversion error warning when getting a message.

! When an attempt ismadeto create a channel automatically; the event is generated whether

the attempt succeeds or fails.
Interval

Recommended minimum is5 minutes.

WebSphere MQ Channel Status
Thiscounter reportstherunning state of achannel. Thiscounter cannot be used for client-connection
channels.

Parameters

Queue Manager

Queue manager you are monitoring.

Channd

Channel you are monitoring.

Primary Data Point

The primary data point is the running state of achannel.
I "1"if the channel isactive.
I "0"if thechannel isnot active.
I "-1"if an error occurred.

Intelligent Data Point

Theintelligent data point liststhe queue manager, channel name, and status, or if an error occurred.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Error Log Entries

This counter reportsthe number of errorsin the MQ error log file for the current interval. It uses standard
Java file processing API functionsto gather the information.

Note: This counter does not appear in the discovery data if the MQ instance was configured as remote in
the agent manager.
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Parameters

Error Number

Soecify All Errors, asingle error number, or an error number range to monitor.

Error Number Range Description
AMQ3500-AM Q3999 WebSphere MQ for Windows
m essages.
AMQ4000-AM Q4999 WebSphere MQ for Windows NT
User Interface messages.
AMQ5000-AM Q5999 Installable services messages.
AMQ6000-AM Q6999 Common services messages.
AMQ7000-AM Q7999 WebSphere MQ product messages.
AMQ8000-AM Q8999 WebSphere MQ administration
m essages.
AMQ9000-AM Q9999 Rem ote messages.

Primary Data Point

The primary data point is the number of errorsin the error log file for the current interval.

Intelligent Data Point

There are three alternatives for what isreturned for the intelligent data point. It dependson what
you selected for the Error Number parameter.

The data point detail lists each error and the number of timesit occurred within theinterval.

Oneerror chosen:
I Number of errorsin interval that match the error number.
I Each error range and count for the range.
I Total errorsduring theinterval.

Error range chosen:
! Number of errorsin interval that are within chosen range.
! Top 10 errorsin range.
I Error range and count for the range.
I Total errorsduring theinterval.

All errorschosen:
! Number of errorsin interval.
I Top 10 errors.
I Error and count.
I Error range and count for the range.
I Total errorsduring theinterval.

Interval
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Recommended minimum is5 minutes.

WebSphere MQ Percent Queue Depth

This counter reportsthe current queue depth as a percentage of the defined maximum.
Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the current queue depth as a percentage of the defined maximum.

Intelligent Data Point
Theintelligent data point liststhe queue manager, queue, current queue depth, and percent queue
depth.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Performance Events

Thiscounter reportsthe number of performance events for the current interval.
Parameters

Queue Manager

Queue manager you are monitoring.

Performance Event Queue
Name of the performance event queue that you are monitoring. The default valueis
SYSTEM.ADMIN.PERFM .EVENT.

Event Name

Soecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored
unless event name(s) are selected.

Event Name Description

Queue Depth High Queue depth high limit reached or exceeded.

Queue Depth Low Queue depth low limit reached or exceeded.

Queue Full Queue already contains maximum number of
m essages.
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High

Queue Service Interval No successful getsor putshave been detected

within an interval greater than the limit
specified in the Q Service Interval attribute.

OK

Queue Service Interval A successful get has been detected within an

interval lessthan or equal to the limit specified
in the Q Service Interval attribute.

Primary Data Point

The primary data point is the number of performance events for the specified queue during the current

interval.

Intelligent Data Point

The intelligent data point displaysthe number of performance events, description of individual
events (performance event type, event name, date & time that the message was put on the event
gqueue, name of the queue manager that put the message, queue associated with the event, time
since reset, high queue depth, message enqueue count, message dequeue count and reason code).

Performance events are notificationsthat athreshold condition has been reached by aresource. The
conditions can affect the performance of applicationsthat use a specified queue. Performance event
types are:

Queue Depth High

Queue Depth Low

Queue Full

Queue Service Interval High
Queue Service Interval OK

Performance event statistics are reset when a performance event occurs or a queue manager stops
and restarts.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Depth

Thiscounter monitorsthe current depth of the specified queue.

Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the number of messages on queue.
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Intelligent Data Point

The intelligent data point liststhe queue manager, queue, and queue depth.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Connections

Thiscounter reportsthe current number of connectionsto a queue manager.
Parameters

Queue Manager

Queue manager you are monitoring.

Primary Data Point
The primary data point is the positive integer representing the number of connectionsor "-1" if an
error occurred.
Intelligent Data Point
Theintelligent data point liststhe queue manager, the number of active connections, and the
connection names. If an error occurred, then it displaysthe error number and description.
Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Events

This counter reportsthe number of queue manager events for the current interval.
Param eters

Queue Manager

Queue manager you are monitoring.

Queue Manager Event Queue
Name of the queue manager event queue you are monitoring. The default valueis
SYSTEM.ADMIN.QM GR.EVENT.

Event Name

Soecify the name(s) of the event(s) to monitor. All eventson the queue are monitored unless event
name(s) are selected.

Event Name Description

Alias Base Queue Type The Base Q Name in the alias queue definition resolvesto a queue
Error that isnot alocal queue, or local definition of aremote queue.

Default Transmission Either alocal definition of the remote queue was specified, or a
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Queue Type Error

gueue-manager aliaswas being resolved, but in either case the
XmitQName attributein thelocal definition is blank.

Default Transmission
Queue Usage Error

The queue defined by the DefXmitQNamequeue-manager attribute
does not have a Usage attribute of MQUS TRANSMISSON.

Get Inhibited

Getsinhibited for the queue.

Not Authorized

The user isnot authorized for access.

Put Inhibited

Put callsinhibited for the queue.

Queue Manager Active

Queue manager created.

Queue Manager Not
Active

Queue manager unavailable.

Queue Type Error

Queuetype not valid.

Remote Queue Name
Error

Remote queue name not valid.

Transmission Queue
Type Error

Transmission queue not local.

Transmission Queue
Usage Error

Transmission queue with wrong usage.

Unknown Alias Base
Queue

The BaseQNamein the alias queue attributesis not recognized as a
queue name.

Unknown Default
Transmission Queue

The XmitQName attribute in the local definition is blank.

Unknown Object
Name

The Object Name in the object descriptor isnot recognized for the
specified object type.

Unknown Remote
Queue Manager

An error occurred with the queue-name resolution.

Unknown
Transmission Queue

The XmitQName attribute of the definition isnot blank and not
the name of alocally-defined queue.

Primary Data Point

The primary data point

Intelligent Data Point
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The intelligent data point displaysthe number of queue manager events, description of individual
events (Qqueue manager event type, event name, date & time that the message was put on the event

is the number of queue manager eventsfor the current interval.

queue, name of the queue manager that put the message, and reason code).

Queue manager events are eventsthat arerelated to the definitions of resources within queue

managers. For example, an application attemptsto put a message to a queue that does not exist.

Queue manager event types are: authority, inhibit, local, remote, and start/stop.

Event Type

Reason Code




Authority Events
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I Not Authorized (type 1)
I Not Authorized (type 2)
I Not Authorized (type 3)
I Not Authorized (type 4)

Inhibit Events

I Get Inhibited
! Put Inhibited

Local Events

I Alias Base Queue Type Error
I Unknown Alias Base Queue
I Unknown Object Name

Remote Events

I Default Transmission Queue Type Error

I Default Transmission Queue Usage Error
I Queue Type Error

I Remote Queue Name Error

I Transmission Queue Type Error

I Transmission Queue Usage Error

! Unknown Default Transmission Queue

I Unknown Remote Queue Manager

! Unknown Transmission Queue

Sart and Sop
Events

! Queue Manager Active
I Queue Manager Not Active

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Statistics

This counter reports statistics describing a queue manager.
Parameters

Queue Manager

Queue manager you are monitoring.

Satistic

Soecify the statistic to

use asthe primary data point.:

Authority Events

Reportsthe on/off value of Authority events. Authority eventsindicate
that an authorization violation has been detected.

Automatic
Channel
Definition Events

Reportsthe on/off value of Automatic Channel Definition events.
Automatic channel definition eventsindicate whether an automatic
definition of achannel fails or succeeds.

Inhibit Events

Reportsthe on/off value of Inhibit events. Inhibit eventsindicate that
an MQPUT or MQGET operation has been attempted against a queue,
wherethe queueisinhibited for putsor getsrespectively.
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Local Events Reportsthe on/off value of Local events. Local eventsindicate that an
application (or the queue manager) has not been able to access alocal
gueue, or other local object.

Performance Reportsthe on/off value of Performance events. Performance events are
Events notificationsthat athreshold condition hasbeen reached by aresource.
Remote Events Reportsthe on/off value of Remote events. Remote eventsindicate that

an application (or the queue manager) cannot access a (remote) queue
on another queue manager.

Start Stop Events Reportsthe on/off value of these events. Sart and stop eventsindicate
that a queue manager has been started or has been requested to stop or
quiesce.

Primary Data Point

The primary data point isthe one of the following statistics as specified by the Satistics parameter:
I Authority Events
I Automatic Channel Definition Events
I Inhibit Events
! Local Events
I Performance Events
I Authority Events
I Automatic Channel Definition Events

Intelligent Data Point

The intelligent data point liststhe queue manager and queue manager statistics. Thiscounter
reportsthe current state of the statistics, it does not report the statistics values asthey progress
through time. For dynamic information, monitor with the Queue Manager Event counter. As
appropriate, any of the following information may be included:

Data Description

Authority Events = <integer> Variable that storesthe on/off value of these events. Authority
eventsindicate that an authorization violation has been detected.

Automatic Channel Variable that storesthe on/off value of these events. Automatic
Definition Events = <integer> | channel definition eventsindicate whether an automatic
definition of achannel fails or succeeds.

Inhibit Events = <integer> Variable that storesthe on/off value of these events. Inhibit events
indicatethat an MQPUT or MQGET operation has been attempted
against aqueue, wherethe queue isinhibited for putsor gets
respectively.

Local Events = <integer> Variable that storesthe on/off value of these events. Local events
indicate that an application (or the queue manager) has not been
able to access alocal queue, or other local object.

Performance Events = Variable that storesthe on/off value of these events. Performance
<integer> eventsare notificationsthat athreshold condition hasbeen
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reached by aresource.

Remote Events = <integer>

Variable that storesthe on/off value of these events. Remote
eventsindicate that an application (or the queue manager) cannot
access a (remote) queue on another queue manager.

Sart Sop Events = <integer>

Variable that storesthe on/off value of these events. Sart and stop
eventsindicate that a queue manager has been started or has been
requested to stop or quiesce.

Cluster Workload Data =
<wstring>

Cluster workload exit data.

Command Level = <integer>

Level of system control commands supported by the queue
manager.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Up/Down

Thiscounter monitorstherunning state of a queue manager.

Parameters

Queue Manager

Queue manager you are monitoring.

Primary Data Point

The primary data point is the running state of queue manager.
I "1"if the queue manager isrunning.
I "0"if the queue manager isnot running.
I "-1"if an error occurred.

Intelligent Data Point

Theintelligent data point liststhe queue manager and whether the queue manager isup, down, or

an error occurred.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Statistics

This counter reports statistics describing a queue.

Parameters

Queue Manager
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Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Satistic

Soecify the statistic to use asthe primary data point.

Current Depth Reportsthe current number of messages on queue.

Queue Depth High Reportsthe on/off value of these events. Queue depth high events

Event indicate that the queue depth hasincreased to a predefined threshold.

Queue Depth Low Reportsthe on/off value of these events. Queue depth low events

Event indicate that the queue depth has decreased to a predefined threshold.

Queue Depth Max Reportsthe on/off value of these events. Queue depth max events

Event indicate that the queue hasreached its maximum depth, that is, the
queue isfull.

Queue Service Reportsthe on/off value of these events. Queue service interval events

Interval Event arerelated to whether messages are processed within a user-specified
timeinterval.

Primary Data Point

The primary data point isthe one of the following statistics as specified by the Statistics parameter:
I Current Depth
I Queue Depth High Event
! Queue Depth Low Event
! Queue Depth Max Event
I Queue Service Interval Event

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, and queue statistics. This counter reportsthe
current state of the statistics, it does not report the statistics values asthey progressthrough time. For
dynamic information, use the Queue Manger Events counter. Asappropriate, any of the following
information may beincluded:

Data Description

Inhibit Get = <integer> Indicates whether get operations are allowed on the queue.
Inhibit Put = <integer> Indicates whether put operations are allowed on the queue.
Current Queue Depth = | Current number of messages on the queue.

<integer>

Maximum Queue Maximum number of messages allowed on the queue.
Depth = <integer>
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Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
high eventsindicate that the queue depth hasincreased to a
predefined threshold.

Conductor

Queue Depth High
Limit = <integer>

Valuethat triggersan event if it isreached.

Queue Depth Low
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
low eventsindicate that the queue depth has decreased to a
predefined threshold.

Queue Depth Low Limit

= <integer>

Value that triggers an event if it isreached.

Queue Depth Max
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
max eventsindicate that the queue hasreached its maximum depth,
that is, the queueisfull.

Queue Service Interval
Event = <integer>

Variable that storesthe on/off value of these events. Queue service
interval eventsarerelated to whether messages are processed within
a user-specified time interval.

Queue Service Interval
= <integer>

Queue service interval time.

Trigger Data =
<wstring>

Free-format datathat iswritten into a trigger message.

Trigger Depth =
<integer>

Number of messagesthat have to be on the queue before a trigger
message is written.

Trigger Control =
<integer>

Controlswhether or not trigger messages are written to an initiation
queue.

Interval

Recommended minimum is5 minutes.

WMI Counters

WMI Remote Extended Counters

The following extended WMI (Windows Management Instrument) remote counters are provided in
QALoad. To display and use the extended countersin task configuration, you must configure user access
with the MM C (Microsoft Management Console) and configurethe WMI agent using the ServerVantage
Agent Console (Reconfigure Agent). These procedures are described in the topic Configuring WMI in the
ServerVantage Agent Configuration online help. Once configuration iscomplete, and you select WMI
collector asyour Server Type during task configuration on the Select Counters page, ServerVantage
discoversthe Windows registry counters and the extended counters for each WMI-configured server.

These counters extend the monitoring of your WMI system:

WMI WQL

WMI Top Ten Counters:
I CPU Utilization % - Top Ten
I Memory Utilization % - Top Ten
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I 1/O Utilization % - Top Ten

WMI Top Ten Counters
I Top Ten CPU
I Top Ten Memory
! Top Ten I/O

CPU Utilization % - Top Ten

The CPU Utilization % - Top Ten counter provides data for the Load Characterization Report. It returnsa
numeric value for each of the top ten processes that utilize the most machine CPU or all processes for
which CPU utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

Memory Utilization % - Top Ten

The Memory Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric
value for each of the top ten processesthat utilize the most machine Memory or all processes for which
Memory utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

I/O Utilization % - Top Ten

The I/O Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric value
for each of the top ten processesthat utilize the most machine I/O or all processes for which 1/O utilization
isgreater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).
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WMI WQL
The WMI WQL (Windows Query Language) counter monitorsthe object (s) specified by the WQL
statement. Users may select predefined WQL templates.

Parameters

W QL Satement
Enter avalid WQL (WMI Query Language) statement.

Data Point

Primary Data Point

The primary data point returns 0 if the WMI system executed query is successful. If the query fails, the
graph displays DATA_NOT_FOUND asthe data point. If you click on the data point, the actual error is
provided in the error description.

Intelligent Data Point

Theintelligent data point (IDP) isthe response from the query.

Interval

Recommended minimum interval 5 minutes.

Oracle Application Server Counters

Oracle AS Counters

QALoad providesthe following dynamically discovered Oracle Application Server (AS) remote extended
counter categories for remote monitoring of Oracle10g Application Server performance metrics. Each
category provides counters and parametersthat extend the monitoring of your Oracle ASsystem. The
Oracle ASagent dynamically discoversall available counters and parameter values. The available categories
and metricsvary by installation. The Oracle ASagent supports wild-carded parameters and resource
blackouts.

Supported platforms for Oracle ASinclude:

I Solaris I Microsoft Windows 2000 with Service Pack 3 or above

I AIX I Microsoft Windows Server 2003 (32-bit)

I HP I Microsoft Windows XP (not all components are supported)
I Linux

Oracle AS Counter Categories

Oracle ASEB Method Metrics Oracle ASIM S Session Metrics

Oracle ASEntity Bean Metrics Oracle ASIM S Sore Metrics

Oracle ASHTTP OC4JMetrics Oracle ASIMSTemp Destination Metrics
Oracle ASHTTP Server Metrics Oracle AS JServ JSP Metrics

Oracle ASHTTP Server Module Metrics Oracle AS JServ Metrics

Oracle ASHTTP Server Response Metrics Oracle AS JServ Servlet Metrics

Oracle ASHTTP Server Virtual Host Metrics Oracle AS JServ Zone Metrics
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Oracle ASIDBC Connection Metrics
Oracle ASIDBC Connection Source Metrics
Oracle ASIDBC Metrics

Oracle ASIDBC Statement Metrics

Oracle ASIM S Browser Metrics
Oracle ASIM SConnection Metrics

Oracle ASIMSConsumer Metrics

Oracle ASIMSDurable Subscription Metrics
Oracle ASIMSMetrics

Oracle ASIM S Persistence Metrics

Oracle ASIM S Producer Metrics

10g Release 2 Counter Categories

Oracle ASPortal Cache Metrics
Oracle ASPortal Cache Summary Metrics
Oracle ASPortal DB Provider Metrics

Oracle Application Server EJB Method Metrics

Oracle ASJSP Metrics

Oracle ASIVM Metrics

Oracle ASNotification Server Metrics

Oracle ASOC4JTransaction Manager Metrics
Oracle ASPLSQL Metrics

Oracle ASPortal Engine Metrics

Oracle ASProcess Manager Metrics

Oracle AS Servlet Metrics

Oracle ASTask Manager Metrics

Oracle ASWeb Module Metrics

Oracle AS Portal Page Metrics
Oracle ASPortal DB Repository Metrics
Oracle ASPortal Web Provider Metrics

The Oracle Application Server (AS) EBB Method Metrics category includesthe counterslisted in the

following table.

Counters ‘

client.active
method.

Current number of threads accessing
the actual implementation of this

Description Type‘ Units ‘

Operations

client.avg

Average time spent inside the actual
implementation of thismethod.

Milliseconds

Number of requests for beans

client.completed processed by this application. Operations
Maximum number of threads
client.maxActive accessing the actual implementation Operations

of thismethod.

client.maxTime
method.

Maximum time spent inside the
actual implementation of this

Milliseconds

client.minTime
method.

Minimum time spent inside the
actual implementation of this

Milliseconds

232



Conductor

client.time

Time spent inside the actual
implementation of thismethod.

Milliseconds

ejbPostCreate.active

Current amount of time spent in
ejbPostCreate.

Operations

ejbPostCreate.avg

Average time spent in ejbPostCreate.

Milliseconds

ejbPostCreate.completed

Number of timesthis ejbPostCreate
has been called.

Operations

ejbPostCreate.maxTime

Maximum time spent in
ejbPostCreate.

Milliseconds

ejbPostCreate.minTime

Minimum time spent in
ejbPostCreate.

Milliseconds

ejbPostCreate.time

Time spent in the ejbPostCreate
method (entity beans).

Milliseconds

wrapper.active

Current number of threads accessing
the automatically generated wrapper
method.

Count

wrapper.avg

Average time spent inside the
automatically generated wrapper
method.

Milliseconds

wrapper.completed

Number of requests for beans
processed by thisapplication.

Operations

wrapper.maxActive

Maximum number of threadsthat
access the wrapper.

Operations

wrapper.maxTime

Maximum time spent inside the
automatically generated wrapper
method.

Milliseconds

wrapper.minTime

Minimum time spent inside the
automatically generated wrapper
method.

Milliseconds

wrapper.time

Time spent inside the automatically
generated wrapper method.

Not all wrapper methodsinvokethe
actual bean implementation at
runtime (i.e., create method in a
stateless bean). Thismeansthat the
time spent in the wrapper code could
belessthan thetime spent in the
bean implementation.

Milliseconds
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Oracle Application Server Entity Bean Metrics

The Oracle Application Server (AS) Entity Bean Metrics category includesthe counterslisted in the

following table.

Counters Description Type Units

exclusive-write-
access

Possible values: true or false. Value

Oracle Application Server HTTP OC4JMetrics

The Oracle Application Server (AS HTTP OC4JMetrics category includesthe counterslisted in the

following table.

Counters Description Type Units

Foecifiesthe total number of requests, both

ErrReq session and non-session, that mod_oc4j Count | Operations
failed to routeto an OC4J.
Fecifiesthe total number of non-session

ErrRegNon Sess requeststhat mod_oc4j failed to route to an Count | Operations
OC4Jprocess.
Fecifiesthe total number of session requests

ErrReqSess that mod_oc4j failed to route to an OC4J Count | Operations
process.

Failover Specmesthetptal num ber' of failovers for Count | Operations
both non-session and session requests.
Foecifiesthe total number of routed OC4J Number of

MMCnt NMMsthat belong to thisdestination. Value NVMs

Non SessFailover SpeC|f|es'thetotal number of failovers for Count | Operations
non-session requests.

SessFailover Secifiesthe total number of failovers. Count | Operations
Secifiesthe total number of requests, both

ucReq session and non-session, that mod_oc4j Count | Operations
successfully routed to an OC4J.
Fecifiesthe total number of non-session

SucRegNon Sess requeststhat mod_oc4j successfully routed to | Count | Operations
an OC4Jprocess.
Foecifiesthe total number of session requests

SucReqSess that mod_oc4j successfully routed to an Count | Operations

OC4Jprocess.
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ErrReq

Foecifiesthe total number of requests, both
session and non-session, that mod_oc4;j
failed to routeto an OC4J.

Count

Operations

ErrReqNon Sess

Fecifiesthe total number of non-session
requeststhat mod_oc4j failed to route to an
oc4j process.

Count

Operations

ErrReqSess

Foecifiesthe total number of session requests
that mod_oc4j failed to routeto an OC4J
process.

Count

Operations

Failover

Fecifiesthe total number of failoversfor
both non-session and session requests.

Count

Operations

Non SessFailover

Fecifiesthe total number of failoversfor
non-session requests. For example, assume
that thismount point was serviced by an
OC4Jlsland with three ¥M's (WM1, WM2
and WM 3). A new hon-session request is
routed to VM1. WM1 failsto service the
request, and the request is failed over to
VM2. WM2 failsto service the request, and
so the request isfailed over to WM3. At this
point the NonSessFailover.Count is
incremented by 2.

Operations

SessFailover

Fecifiesthe total number of failoversfor
session requests. For example, assume that
thismount point was serviced by an OC4J
Island with three ¥M's (WM1, M2 and
JVM3). A session request isrouted to VM 1.
VM1 failsto service therequest. So, the
request isfailed over to WM2. At this point
the SessFailover.Count isincremented by 1.
VM2 failsto service the request, and so the
request isfailed over to WM 3. At this point
the SessFailover.Count isincremented by 2.

Count

Operations

SucRegNon Sess

Foecifiesthe total number of requests, both
session and non-session, that mod_oc4;j
successfully routed to an OC4Jinstance.

Count

Operations

SucReqSess

Fecifiesthe total number of session requests
that mod_oc4j successfully routed to an
OC4Jprocess.

Count

Operations

IncorrectReqlnit

Total number of timesan internal error
occurred. There could be anumber of
reasons, including mod_oc4j not finding a
connection endpoint and configuration
errors.

Count

Operations

Oc4jUnavailable

Total number of timesthat an oc4j WM
could not be found to service requests.

Count

Operations
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Total number of timesmod_oc4j declined to

UnableToHandleReq handle a request

Count | Operations

Oracle Application Server HTTP Server Metrics

The Oracle Application Server (AS) HTTP Server Metrics category includesthe counterslisted in the
following table.

busyChildren Number of child processes active. Value
childFinish Number of child processesthat finish. Count
childSart Number of child processesthat start. Count

Number of connections currently
open.

connection.active Number | Threads

Average time spent servicing HTTP

. Value Microseconds
connections.

connection.avg

Maximum time spent servicing any

HTTP connection. Microseconds

connection.maxTime

Minimum time spent servicing any

connection.minTime HTTP connection.

Microseconds

Total time spent servicing HTTP

. Microseconds
connections.

connection.time

error Count

get Count

Child servers currently in the handle

processing phase. Threads

handle.active

Average time spent in module

handler. Microseconds

handle.avg

Number of timesthe handle

handle.completed processing phase has completed.

Operations

Maximum time spent in module

handler. Microseconds

handle.maxTime

Minimum time spent in module

handler. Microseconds

handle.minTime

handle.time Total time spent in module handler. Microseconds
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internal Redirect Number of t|mesamodulered|rected Count Operations
arequest to anew, internal URI.
lastConfigChange Value
numChildren Number of child processes. Value
numMods Number of loaded modules. Value Operations
post Count
readyChildren Value
request.active Child servers currently in the request Threads
processing phase.
request.av Average time required to service an Microseconds
q -avg HTTP request.
request.completed Number of HTTP request completed. Operations
request. maxTime Maximum time required to service an Microseconds
q ' HTTP request.
request. minTime Minimum time required to service an Microseconds
q ' HTTP request.
request.time Total timerequired to service HTTP Microseconds
requests.
responseSze Value

Oracle Application Server HTTP Server Module Metrics

The Oracle Application Server (AS) HTTP Server Module Metrics category includesthe counterslisted in the
following table.

Description

Counters
decline Number of requests declined. Count Operations
handle.active Number of requests currently being Active Requests

handled by thismodule.

handle.avg

Average time required for thismodule.

Microseconds

handle.completed

Number of requests handled by this
module.

Operations

handleemaxTime

Maximum time required for this

Microseconds
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module.

Minimum time required for this

Microseconds
module.

handleeminTime

handle.time Total timerequired for this module. Microseconds

Oracle Application Server JDBC Connection Metrics

The Oracle Application Server (AS) JDBC Connection Metrics category includesthe counterslisted in the
following table.

The parent parameter you select for these counters determineswhether you get totals or data source-
specific metrics.

Counters ‘ Description Type‘ Units ‘

Average time spent creating a new

statement. Milliseconds

CreateNewSatement.avg

Number of timesarequest for a
CreateNewSatement.completed | statement failed to be satisfied Operations
from the cache.

Maximum time spent creating a

new statement. Milliseconds

CreateNewSatement.maxTime

Minimum time spent creating a

new statement. Milliseconds

CreateNewSatement.minTime

Time spent creating a new
statement (thisdoesnot include
thetimerequired to parsethe
statement).

CreateNewSatement.time Milliseconds

Average time spent getting a
CreateSatement.avg statement from the statement Milliseconds
cache.

Number of timesarequest for a
CreateSatement.completed statement was satisfied from the Operations
cache.

Maximum time spent getting a
CreateSatement.maxTime statement from the statement Milliseconds
cache.

Minimum time spent getting a
CreateSatement.minTime statement from the statement Milliseconds
cache.

Time spent getting a statement

from the statement cache. Milliseconds

CreateSatement.time
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SatementCacheHit

Satement found in cache.

Count

Operations

SatementCacheMiss

Satement not found in cache.

Count

Operations

Oracle Application Server JDBC Metrics

The Oracle Application Server (AS) JDBC Metrics category includesthe counterslisted in the following

table.

JDBC data source metrics are only available for non-emulated data sources. You are only able to access
JDBC data source metrics if the data source you created isfor anon-emulated data source, including
OrionCMTDataSource and OracleXADataSource.

Description

Total number of connections

that have been opened.

ConnectionCloseCount that have been closed. Count | Operations

ConnectionCreate.active Curr_ent number .Of threads Operations
creating connections.

ConnectionCreate.avg Average_tlmespent creating Milliseconds
connections.
Number of timesthis

ConnectionCreate.completed | PhaseEvent has started and Operations
ended.

ConnectionCreate.maxTime MaX|mu.m time spent creating Milliseconds
connections.

ConnectionCreate.minTime Mlnlmu.m time spent creating Milliseconds
connections.

ConnectionCreate.time Tlmespgnt creating Milliseconds
connections.

ConnectionOpenCount Total number of connections Count | Operations

Oracle Application Server JDBC Statement Metrics

The Oracle Application Server (AS) JDBC Satement Metrics category includesthe counterslisted in the

following table.

The JDBC Satement Metrics are only available for IDBC connectionsthat have enabled statement caching
and set the property or acl e. j dbc. DMBSSt at enent Cachi ngMetri cs to thevalue true. When JDBC
statement caching isdisabled, you can make the JDBC statement metrics available by setting the property
oracl e. jdbc. DMSSt at enent Met ri ¢s to true. To improve performance and to avoid collecting expensive
metrics, by default these properties are both set to false.

The parent parameter you select for these counters determineswhether you get totals or data source-

specific metrics.
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Counters Description Type

Thetimethisstatement has spent
executing the SQL including the first

Execute fetch and thetime required to parsethe Time Milliseconds
statement.
Fetch Thetimethisstatement has spent in Time Milliseconds

other fetches.

Oracle Application Server IM SBrowser Metrics

The Oracle Application Server (AS) JM SBrowser Metrics category includesthe counterslisted in the
following table.

Counters Description

System.currentTimeMillis() when this

ctor Milliseconds
browser was created.

startTime

Interval timer metric (PhaseEvent Sensor)
for every major method call in this browser
object; callsto hasMoreElement and
nextElement are made on individual
method-name enumeration objects, but counted as Normal
PhaseEventsin the browser object to
simplify data collection. Multiple
enumerations can be active on the same
browser.

Oracle Application Server M S Connection Metrics

The Oracle ASIMS Connection Metrics category includesthe counterslisted in the following table.

Counters Description Type ‘

Valueis Truewhen the MMS
isLocal connection islocal to the OC4J Value Boolean
M Sserver in the same WM.

isXA Valuels'Trugv'vhen the Value Boolean
connection isin XA mode.

Remote M Sserver port for this
port connection; set only for non-local Value Integer
connections.

System.currentTimeMillis() when

: . Value Milliseconds
thisconnection was created.

startTime

Interval timer metric (PhaseEvent

method-name .
Sensor) for every major method

Normal
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call in thisconnection object.

Oracle Application Server MS Consumer Metrics

The Oracle Application Server (AS) M SConsumer Metrics category includesthe counterslisted in the
following table.

Counters Description Type ‘

The nolLocal setting of a
nolLocal subscription; set only for topic Value Boolean
consumers.

System.currentTimeMillis() when

) Value Milliseconds
thisconsumer was created.

startTime

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in thisconsumer object.

Oracle Application Server M S Metrics
The Oracle Application Server (AS M SMetrics category includesthe counterslisted in the following table.

Counters Description Type ‘ Units ‘

Number of M Sconnections (local

connections and remote) created by the M S Normal | Operations
server.

debug oc4j.jms.debug OC4JIM Scontrol ctor Boolean
knob value.
ocdj.jms.forceRecovery OC4JIMS

forceRecovery ctor Boolean
control knob value.

listen erAttem pts ocdj.jms.listenerAttempts OC4JMS ctor Integer
control knob value.

maxOpenFiles ocdj.jms.maxOpenFilesOC4JM S ctor Integer
control knob value.

maxOpenFiles ocdj.jms.maxOpenFilesOC4JM S ctor Integer
control knob value.
oc4dj.jms.messagePoll OC4JIM S

m essagePol| ctor Boolean
control knob value.
ocdj.jms.noDms OC4JIM Scontrol

noDms ctor Boolean
knob value.

saveAllExpired oc4j.jms.saveAllExpired OC4JIM S ctor Milliseconds
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control knob value.

ocdj.jms.serverPoll OC4JJIM Scontrol

serverPoll knob value. ctor Integer

socketBufsize oc4j.jms.socketBufsize OC4JIM S ctor Boolean
control knob value.

. ocdj.jms.usePersistence OC4JIM S

usePersistence ctor Boolean
control knob value.

useUUID oc4dj.jms.useUUID OC4JIM Scontrol ctor Integer
knob value.
TCP/1P port on which the M Sserver

port . . . . ctor Integer
listensfor incoming connections.
Number of request handlers created

requestHandlers.count by the MSserver. Normal | Integer

. System.currentTimeMillis() when the -

startTime.value OC4JIMS server was started. ctor Milliseconds
Scheduling interval of the OC4Jtask

taskManagerinterval manager (and the scheduling interval ctor Milliseconds
for the OC4J M Sexpiration task).
Interval timer metric (PhaseEvent

method-name Sensor) for every major method call Normal

in the OC4JJM Sserver.

Oracle Application Server JM S Persistence Metrics

The Oracle Application Server (AS) M S Persistence Metrics category includesthe counterslisted in the

following table.

Type ‘

Counters Description

holePageCount Number (.)f 512b pages currently Normal Integer
freein thisfile.
Valueis True when the persistence

isOpen file descriptor is currently open Normal Boolean
(for LRU caching).
System.currentTimeMillis() when

lastUsed this persistence file was last used Normal Milliseconds
(for LRUcaching).

usedPageCount _Numbgr of .512.b pages currently Normal Integer
in usein thisfile.

method-name Interval timer metric_ (PhaseEvent Normal
Sensor) for every major method
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call in the persistence file object.

Oracle Application Server IMSProducer Metrics

The Oracle Application Server (AS M SProducer Metrics category includesthe counterslisted in the
following table.

Counters Description

Valueistrue when message IDs

disableMessagel D are disabled for the producer.

Normal | Boolean

Valueistrue when message

disableMessageTimestamp | timestamps are disabled for the Normal | Boolean
producer.
priority Current priority of thisproducer. | Normal | Integer

System.currentTimeMillis()

when this producer was created. ctor Milliseconds

startTime

timeToLive Current timeTolive of this Normal Milliseconds
producer.

Phase timer (PhaseEvent Sensor)
method-name metric for every major method Normal
call in thisproducer object.

Oracle Application Server JMS Session Metrics

The Oracle Application Server (AS) M S Session Metrics category includesthe counterslisted in the
following table.

Counters Description Type Units

iSXA Valueis True when the session is ctor Boolean

in XA mode.

System.currentTimeMillis() when

: . ctor Milliseconds
this session was created.

startTime

Valueis True when the session is
transacted ctor Boolean
transacted.

Integer count of the current local
transaction associated with this
session; the counter is

txid incremented each time alocal Normal Integer
transaction iscommitted or
rolledback. Not set for non-
transacted session.
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Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in thissession object.

Oracle Application Server IMS Store Metrics

The Oracle Application Server (AS M S Sore Metrics category includesthe counterslisted in the following
table.

Counters Description Type ‘ Units

Total number of messages

messageCount contained in this store.

Value Integer

Total number of message
messageDequeued dequeues (transacted or Count Operations
otherwise).

Total number of messages
messageDiscarded discarded after therollback of an Count Operations
enqueue.

Total number of message
messageEnqueued enqueues (transacted or Count Operations
otherwise).

Total number of message

messageExpired expirations.

Count Operations

Total number of message bodies

messagePagedIn paged in.

Count Operations

Total number of message bodies

m essagePagedOut paged out.

Count Operations

Total number of messages
recovered (either from a
persistence file, or after the
rollback of a dequeue).

m essageRecovered Count Operations

Total number of messagesthat are
pendingMessageCount | part of an enqueue or dequeue of Value Integer
an active transaction.

Total size, in bytes, of the message

storeSze dore.

Value Bytes

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in the message store object.
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Conductor

The Oracle Application Server (AS) JServ JSP Metrics category includesthe counterslisted in the following

table.

processRequest.active

Integer

Description Type

Threads currently in the
processRequest processing phase.

processRequest.avg

Average time to completely process
servlet (including JServ engine
overhead).

Milliseconds

processRequest.maxTime

Maximum time to completely
process servlet (including JServ
engine overhead).

Milliseconds

processRequest.minTime

Minimum timeto completely
process servlet (including JServ
engine overhead).

Milliseconds

processRequest.completed

Number of timesthe
processRequest processing phase
hascompleted.

Operations

processRequest.time

Total timeto completely process
servlet (including JServ engine
overhead).

Milliseconds

serviceRequest.active

Average time for service method
implementing thisapplication
(excluding JServ engine overhead).

Integer

serviceRequest.avg

Average time for service method
implementing thisapplication
(excluding Jserv engine overhead).

Milliseconds

serviceRequest.maxTime

Maximum time for service method
implementing this application
(excluding JServ engine overhead).

Milliseconds

serviceRequest.minTime

Minimum time for service method
implementing thisapplication
(excluding JServ engine overhead).

Milliseconds

serviceRequest.completed

Number of timesthe
serviceRequest processing phase
hascompleted.

Operations

serviceRequest.time

Total time for service method
implementing this application
(excluding JServ engine overhead).

Milliseconds
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local Serviet.avg

Average time to load servlet (from
cache or file).

Milliseconds

localServlet.maxTime

Maximum time to load servlet
(from cache or file).

Milliseconds

localServliet.minTime

Minimum time to load servlet
(from cache or file).

Milliseconds

local Servlet.completed

Number of timesthe loadServiet
processing phase has completed.

Operations

localServlet.time

Total timeto load servilet (from
cache or file).

Milliseconds

local ServletClasses.active

Threads currently in the
loadServietClasses processing
phase.

Count

local ServietClasses.avg

Average timeto load servlet classes
from file.

Milliseconds

local ServletClasses.maxTime

Maximum time to load servlet
classes from file.

Milliseconds

local ServletClasses.minTime

Minimum time to load servlet
classes from file.

Milliseconds

local ServletClasses.completed

Number of timesthe
loadServletClasses processing phase
has completed. For most classes,
thisvalueisusually one (1).

Operations

local ServletClasses.time

Total time to load servlet classes
from file.

Milliseconds

loadServiet.avg

Average time to load servlet (from
cache or file).

Milliseconds

createSession.active

Threads currently in the
createSession processing phase.

Count

createSession.avg

Average time to create a session.

Milliseconds

createSession.maxTime

Maximum time to create a session.

Milliseconds

createSession.minTime

Minimum time to create a session.

Milliseconds

createSession.completed

Number of timesthe createSession
processing phase has completed.
Number of sessionsthat have been
created for thisapplication.

Operations

createSession.time

Total time to create a session.

Milliseconds
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maxSTMInstances.value

Total number of instances available
for this SngleThreadModel servlet.

Instances

activeSTM Instances.maxValue

Maximum number of instances
concurrently servicing requests for

this SngleThreadModel.

Instances

activeSTM Instances.value

Total number of instances available
for this SngleThreadModel servlet.

Instances

Oracle Application Server JServ Metrics

The Oracle Application Server (AS) JServ Metrics category includesthe counterslisted in the following

table.
Counters Description Type Units ‘

readRequest.active Threads currently n the Count
readRequest processing phase.

readRequest.avg Average time to read and parse Milliseconds
requests.

readRequest.maxTime Maximum time to read and Milliseconds
parse requests.

readRequest.minTime Minimum time to read and Milliseconds
parse requests.
Number of timesthe

readRequest.completed readRequest processing phase Operations
has completed.

readRequest.time Total timeto read and parse the Milliseconds
request.
Number of requeststhat can be

maxConnections handled concurrently in the Value | Threads
JServ process.

activeConnections.maxValue M"."X'm“m numbgr of requests Threads
being processed simultaneously.

activeConnections Number of requests being Value | Threads

processed simultaneously.

idlePeriod.maxTime

Maximum time process was not
handling any requests.

Milliseconds

idlePeriod.minTime

Number of timesno requests
were being serviced.

Milliseconds

idlePeriod.completed

Number of timesno requests
were being serviced.

Operations
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Total time process was not

handling any requests. Milliseconds

idlePeriod.time

Maximum number of backlog
maxBacklog requeststhat may be queued in Value | Integer
the OSwaiting for this JServ.

Oracle Application Server JServ Servlet Metrics

The Oracle Application Server (AS) JServ Servlet Metrics category includesthe counterslisted in the
following table.

Counters Description Units

Threads currently in the

processRequest.active processRequest processing phase. Integer
Average time to completely process
processRequest.avg servlet (including JServ engine Milliseconds

overhead).

Maximum time to completely
processRequest.maxTime process servlet (including JServ Milliseconds
engine overhead).

Minimum timeto completely
processRequest.minTime process servlet (including JServ Milliseconds
engine overhead).

Number of timesthe
processRequest.completed processRequest processing phase Operations
has completed.

Total time to completely process
processRequest.time servlet (including JServ engine Milliseconds
overhead).

Threads currently in the

serviceRequest.active ; .
serviceRequest processing phase.

Integer

Average time for service method
serviceRequest.avg implementing this application Milliseconds
(excluding Jserv engine overhead).

Maximum time for service method
serviceRequest.maxTime implementing this application Milliseconds
(excluding JServ engine overhead).

Minimum time for service method
serviceRequest.minTime implementing thisapplication Milliseconds
(excluding Jserv engine overhead).

Number of timesthe

serviceRequest.completed : i
serviceRequest processing phase

Operations
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has completed.

serviceRequest.time

Total time for service method
implementing thisapplication
(excluding JServ engine overhead).

Milliseconds

loadServlet.avg

Average time to load servlet (from
cache or file).

Milliseconds

loadServliet.maxTime

Maximum time to load servlet
(from cache or file).

Milliseconds

loadServliet.minTime

Minimum time to load servlet
(from cache or file).

Milliseconds

loadServiet.completed

Number of timesthe loadServlet
processing phase has completed.

Operations

loadServlet.time

Total timeto load serviet (from
cache or file).

Milliseconds

loadServletClasses.active

Threads currently in the
loadServiletClasses processing
phase.

Integer

loadServletClasses.avg

Average time to load servlet classes
from file.

Milliseconds

loadServiletClassesmaxTime

Maximum time to load servlet
classes from file.

Milliseconds

loadServiletClassesminTime

Minimum time to load servlet
classes from file.

Milliseconds

loadServiletClasses.completed

Number of timesthe
loadServiletClasses processing phase
has completed. For most classes,
thisvalueisusually one (1).

Operations

loadServletClasses.time

Total timeto load servlet classes
from file.

Milliseconds

loadServiet.avg

Average time to load servlet (from
cache or file).

Milliseconds

createSession.active

Threads currently in the
createSession processing phase.

Count

createSession.avg

Average time to create a session.

Milliseconds

createSession.maxTime

Maximum time to create a session.

Milliseconds

createSession.minTime

Minimum time to create a session.

Milliseconds
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Number of timesthe createSession
processing phase has completed.

createSession.completed Number of sessions that have been Operations
created for thisapplication.
createSession.time Total time to create a session. Milliseconds

maxSTM Instances.value Total number of instances available Inteqer
' for this SngleThreadModel servlet. 9

Maximum number of instances
activeSTMInstances.maxValue | concurrently servicing requests for Integer
this SngleThreadM odel.

activeSTM Instances.val ue Total number of instances available Instances
' for this SngleThreadModel servlet.

Oracle Application Server JServ Zone Metrics

The Oracle Application Server (AS) JServ Zone Metrics category includesthe counterslisted in the following
table.

Counters Description ‘ Type Units ‘

Threads currently in the checkReload

checkReload.active .
processing phase.

Integer

Average timeto check if the zone

must be reloaded. Milliseconds

checkReload.avg

checkReload.maxTime Maximum time to check if the zone Milliseconds
must be reloaded.

checkReload.minTime Minimum time to check if the zone Milliseconds
must be reloaded.

Number of timesthe checkReload

checkReload.completed : Operations
processing phase has completed.

checkReload.time Total time to check if the zone must Milliseconds
be reloaded.
Number of times session data has

activeSessions been read with HttpSession.getValue Value | Sessions
in thiszone.
Number of times session data has

readSession been read with HttpSession.getValue Count | Operations

in thiszone.

Number of times session data has
writeSession been written with Count | Operations
HttpSession.putValuein thiszone.
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loadFailed

Number of times Oracle failed to load
therequested application (does not
work for OJSPs).

Count

Operations

Oracle Application Server JSP Metrics

The Oracle Application Server (AS) JSP Metrics category includesthe counterslisted in the following table.

Counters

processRequest.time

Description

Time spent processing requests for
JSPs.

_ Type

Milliseconds

processRequest.completed

Number of requests for JSPs
processed by thisapplication.

Operations

processRequest.minTime

Minimum time spent processing
requests for JSPs.

Milliseconds

processRequest.maxTime

Maximum time spent processing
requests for JSPs.

Milliseconds

processRequest.avg

Average time spent processing
requests for JSPs.

Milliseconds

Current number of active requests

for the JSP.

processRequest.active for JSPs. Operations
activelnstances.value Number of active mstilnces. Only Count | Instances
used when threadsafe=false.
availablelnstances.value Number of available (that is, created) Count | Instances
instances.
. . Current number of active requests
service.active Count

service.avg

Average time spent servicing the JSP.

Milliseconds

service.completed

Number of requests for JSPs
processed by this JSP.

Operations

service.maxTime

Maximum time spent servicing the
J5P.

Milliseconds

serviceeminTime

Minimum time spent servicing the
J5P.

Milliseconds

service.time

Timeto serve a J3P (that is, actual
execution time of the JSP).

Milliseconds
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Oracle Application Server VM Metrics

The Oracle Application Server (AS) VM Method Metrics category includesthe counterslisted in the
following table.

Counters Description Typ% Units ‘
. Number of active thread groupsin
activeThreadGroups the VM. Integer
activeThreadGroups.minValue M|n|mgm number of active thread Integer
groupsin the WM.
activeThreadGroupsmaxValue MaX|QO number of active thread Integer
groupsin the WM.
activeThreads Number of active threadsin the Threads
NMM.
. . Minimum number of active
activeThreads.minValue threadsin the VM. Threads
. Maximum number of active
activeThreads.maxValue threadsin the VM. Threads
freeMemory Amount of heap space freein the Kilobytes
NMM.
freeMemory.minValue Minimum amount of heap space Kilobytes
y- freein the WM. y
freeMemory.maxValue Maximum amount of heap space Kilobytes
y- freein the WM. y
totalMemory Total amount of heap spacein the Kilobytes
NMM.
. Minimum amount of total heap .
totalMemory.minValue space in the VM. Kilobytes
Maximum amount of total heap .
totalMemory.maxValue space in the VM. Kilobytes

Oracle Application Server Notification Server Metrics

The Oracle Application Server (AS) Notification Server Metrics category includesthe counterslisted in the
following table.

Counters Description Type Units

notifProcessed Number of notifications processed Value Operations
by ONS.

notifProcessQueue Number of notificationsin the Value Operations
process queue.
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notifReceived

Number of notifications received
by ONS.

Value

Operations

notifReceiveQueue

Number of notificationsin the
receive queue.

Value

Operations

Oracle Application Server PLSQL Metrics

The Oracle Application Server (AS) PLSQL Metrics category includesthe counterslisted in the following

table.
Counters Description
newM isses Number of new session cache misses. Count | Operations
staleMisses Number of stale session cache misses. Count | Operations
hits Number of session cache hits. Count | Operations
requests Number of requeststo the session Count | Operations
cache.
newM isses Number of new content cache misses. Count | Operations
staleMisses Number of stale content cache misses. | Count | Operations
hits Number of content cache hits. Count | Operations
requests Number of requeststo the content Count | Operations
cache.
Number of errorsthat have occurred .
error Count | Operations

within the group

connFetch.maxTime

Maximum time to fetch a connection
from the pool.

Microseconds

connFetch.minTime

Minimum time to fetch a connection
from the pool.

Microseconds

connFetch.avg

Average time to fetch a connection
from the pool.

Microseconds

connFetch.active

Child serverscurrently in the pool
fetch phase.

Threads

connFetch.time

Total time spent fetching connections

from the pool.

Microseconds

connFetch.completed

Number of times a connection has
been requested from the pool.

Operations

253



QALoad 05.06 Using the Conductor

newMisses NL_meer of new connection pool Count | Operations
misses.

staleMisses NL_meer of stale connection pool Count | Operations
misses.

hits Number of connection pool hits. Count | Operations

Oracle Application Server Portal Cache Metrics

The Oracle Application Server (AS) Portal Cache Metrics category includesthe counterslisted in the
following table.

Counters Description ‘ Type Units
cacheSze Overall size of the cache. Value Megabytes
dataCleanedUp.max uMan|mum amount of cache data clean Megabytes
dataCleanedUp.min uMplmmum amount of cache data clean Megabytes
dataCleanedUp.avg ﬁ;erage amount of cache data clean Megabytes

Amount of cache datacleaned up in
dataCleanedUp thelast cleanup operation. Megabytes
Number of timesthe cache has been .
cleanup Count | Operations

cleaned up.

cleanupTime.min

Minimum time to clean up the cache.

Milliseconds

cleanupTime.max

Maximum time to clean up the cache.

Milliseconds

cleanupTime.avg

Average timeto clean up the cache.

Milliseconds

cleanupTime

Timeto clean up the cachein thelast
cleanup operation.

Milliseconds

cacheTime.max

Maximum time to serve content from
the cache.

Milliseconds

cacheTime.min

Minimum time to serve content from
the cache.

Milliseconds

cacheTime.avg

Average time to serve content from
the cache.

Milliseconds

openTime

Number of times cached content has
been opened.

Operations
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openTime.avg

Average time to open cached content.

Milliseconds

openTime.max

Maximum time to open cached
content.

Milliseconds

readTime

Number of times cached content has
been read.

Operations

readTime.avg

Average time to read cached content.

Milliseconds

readTime.max

Maximum time to read cached
content.

Milliseconds

writeTime

Number of times cached content has
been written.

Operations

writeTime.avg

Average time to write cached content.

Milliseconds

writeTime.max

Maximum time to write cached
content.

Milliseconds

Oracle Application Server Portal DB Provider Metrics

The Oracle Application Server (AS) Portal DB Provider Metrics category includesthe counterslisted in the
following table for the Portal Servlet Database provider requests and Portal Servliet PL/SQL portlet requests.

Counters Description
cacheHits Number of cache hitsfor thisrequest. | Value
httpXXX Count of specific HTTP response Value | Operations

codes for thisrequest.

executeTime.maxTime

Maximum time to make the request.

Microseconds

executeTime.minTime

Minimum time to make the request.

Microseconds

executeTime.avg

Average time to make the request.

Microseconds

executeTime.active

Threads currently in the make request
phase.

Threads

executeTime.time

Total time spent making requests.

Microseconds

Oracle Application Server Portal Engine Metrics

The Oracle Application Server (AS) Portal Engine Metrics category includesthe counterslisted in the

following table.
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Counters Description Type

pageRequests

Total number of requests for Portal
pages.

Value

Count

cachePageHits

Number of requests for cacheable
fully assembled pagesthat have
resulted in a cache hit.

Value

Count

cachePageRequests

Number of requests for cacheable
fully assembled pages

Value

Count

pageM etadataW aitTimeAvg.value

Average time spent in the PPE
internal request queue waiting for
page metadata, for all requests. To
obtain the average, divide the value
metric by the count metric. The
valueisthe accumulative time for all
requests and the count isthe
number of requests made.

Value

Milliseconds

pageM etadataW ait TimeAvg.count

Number of requests made for page
metadata. Thismetric should be
used in conjunction with

pageM etadataW aitTimeAvg.value to
calculate the average time spent in
the PPE internal request queue.

Count

Operations

pageMetadataWaitTime.value

Timethe last page metadata request
spent in the PPEinternal request
queue.

Value

Milliseconds

pageM etadataWaitTime.count

Number of requests for page
metadata.

Count

Operations

pageMetadataWaitTime.minValue

Minimum time spent in the PPE
internal request queue waiting for
page metadata to be requested.

Milliseconds

pageMetadataWaitTime.maxValue

Maximum time spent in the PPE
internal request queue waiting for
page metadata to be requested.

Milliseconds

pageElapsedTimeAvg.value

Average time to generate pages,
including fetching the page
metadata. To obtain the average,
divide the value metric by the count
metric. Thevalueisthe
accumulative time for all requests
and the count isthe number of
requests made

Value

Milliseconds

pageElapsedTimeAvg.count

Number of pagesthat had to be
generated (that is, not cached). use
thismetricin conjunction with
pageElapsedTimeAvg.value to

Count

Operations
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calculate the average time to
generate pages, including fetching
the page metadata.

pageElapsedTime.value

Timeto generate the last page
requested, including fetching the
page metadata.

Value

Milliseconds

pageElapsedTime.count

Number of pagesthat had to be
generated (that is, not cached).

Count

Operations

pageElapsedTime.minValue

Minimum timeto generate a page,
including fetching the page
metadata.

Milliseconds

pageElapsedTime.maxValue

Maximum time to generate a page,
including fetching the page
metadata.

Milliseconds

pageM etadataFetchTimeAvg

Average time to fetch page metadata,
for all requests. To obtain the
average, divide the value metric by
the count metric. The valueisthe
accumulative time for all requests
and the count isthe number of
requests made.

Value

Milliseconds

pageM etadataFetchTimeAvg

Number of requests for page
metadata. Use thismetricin
conjunction with

pageM etadataFetchTimeAvg.value to
calculate the average time to fetch
page metadata.

Count

Operations

pageM etadataFetchTime.value

Timeto fetch page metadata, for the
last request.

Value

Milliseconds

pageM etadataFetchTime.count

Number of requests for page
metadata.

Count

Operations

pageM etadataFetchTime.minValue

Minimum timeto fetch page
metadata.

Milliseconds

pageM etadataFetchTime.maxValue

Maximum time to fetch page
metadata.

Milliseconds

queueTimeout

Number of requests for Portal data
that have timed out in the PPE
internal request queue.

Value

Milliseconds

queueSayAvg.value

Average time all internal PPE
requests spent in the PPE internal
request queue. To obtain the
average, dividethe valueisthe
accumulative time for all requests
and the count isthe number of

Value

Milliseconds
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requests made.

queueSayAvg.count

Number of requests added to the
internal PPE request queue. Use this
metric in conjunction with
queueStayAvg.value to calculate the
average time requests spent in the
internal PPErequest queue.

Count

Operations

queueSay.value

Timethelast internal PPErequest
spent in the PPE internal request
queue.

Value

Milliseconds

queueSay.count

Number of requests added to the
internal PPE request queue.

Count

Operations

queueStay.minValue

Minimum time arequest spent in
theinternal PPE request queue.

Milliseconds

queueSay.maxValue

Average length of the PPE internal
request queue. To obtain the
average, divide the value metric by
the count metric.

Milliseconds

queuelLengthAvg.value

Average length of the PPEinternal
request queue. To obtain the
average, divide the value metric by
the count metric.

Value

Milliseconds

queueLengthAvg.count

Number of requests added to the PPE
internal request queue. Use this
metric in conjunction with
queueLengthAvg.value to calculate
the average length of the PPE
internal request queue.

Count

Operations

queuelLength.value

Current length of the PPEinternal
request queue.

Milliseconds

queueLength.count

Number of requests added to the PPE
internal request queue.

Count

Operations

queueLength.minValue

Minimum number of requestsin the
PPE internal request queue.

Milliseconds

queuelLength.maxValue

Maximum number of requestsin the
PPE internal request queue.

Milliseconds

cacheHits

Number of cache hitsfor this
request.

Value

Operations

httpXXX

Count of specific HTTP response
codes for thisrequest.

Value

Operations

executeTime.maxTime

Maximum time to make the request.

Microseconds
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executeTime.minTime

Minimum timeto make the request.

Microseconds

executeTime.avg

Average time to make the request.

Microseconds

executeTime.active

Threads currently being processed.

Threads

executeTime.time

Total time spent making requests.

Microseconds

connFetch.completed

Number of requests made.

Operations

Oracle Application Server Portal Page Metrics

The Oracle Application Server (AS) Portal Page Metrics category includesthe counterslisted in the

following table.

Counters

Description

pageRequests

Total number of requests for Portal
pages.

Value

Count

cachePageHits

Number of requests for cacheable
fully assembled pagesthat have
resulted in a cache hit.

Value

Count

cachePageRequests

Number of requests for cacheable
fully assembled pages.

Value

Count

pageM etadataW aitTimeAvg.value

Average time spent in the PPE
internal request queue waiting for
page metadata, for all requests. To
obtain the average, divide the value
metric by the count metric. The value
isthe accumulative time for all
requests and the count isthe number
of requests made.

Milliseconds

pageM etadataW ait Tim eAvg.count

Number of requests made for page
metadata. Use thismetricin
conjunction with

pageM etadataW aitTimeAvg.value to
calculate the average time spent in
the PPE internal request queue.

Operations

pageMetadataWaitTime.value

Timethe last page metadata request
spent in the PPE internal request
gueue.

Value

Milliseconds

pageM etadataWaitTime.count

Number of requests for page
metadata.

Count

Operations

pageMetadataWaitTime.minValue

Minimum time spent in the PPE
internal request queue waiting for

Milliseconds
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page metadata to be requested.

pageMetadataWaitTime.maxValue

Maximum time spent in the PPE
internal request queue waiting for
page metadata to be requested.

Milliseconds

pageElapsedTimeAvg.value

Average time to generate pages,
including fetching the page metadata.
To obtain the average, divide the
value metric by the count metric. The
value isthe accumulative time for all
requests and the count isthe number
of requests made.

Value

Milliseconds

pageElapsedTimeAvg.count

Number of pagesthat had to be
generated (that is, not cached). Use
thismetric in conjunction with
pageElapsedTimeAvg.value to
calculate the average time to generate
pages, including fetching the page
metadata.

Count

Operations

pageElapsedTime.value

Timeto generate the last page
requested, including fetching the
page metadata.

Milliseconds

pageElapsedTime.count

Number of pagesthat had to be
generated (that is, not cached).

Operations

pageElapsedTime.minValue

Minimum timeto generate a page,
including fetching the page metadata.

Milliseconds

pageElapsedTime.maxValue

Maximum time to generate a page,
including fetching the page metadata.

Milliseconds

pageM etadataFetchTimeAvg.value

Average time to fetch page metadata,
for all requests. To obtain the average
you should divide the value metric by
the count metric. The value being the
accumulative time for all requests and
the count being the number of
requests made.

Milliseconds

pageM etadataFetch TimeAvg.count

Number of requests for page
metadata. This metric should be used
in conjunction with

pageM etadataFetchTimeAvg.value to
calculate the average time to fetch
page metadata.

Operations

pageM etadataFetchTime.value

Timeto fetch page metadata, for the
last request.

Milliseconds

pageM etadataFetchTime.count

Number of requests for page
metadata.

Operations
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pageM etadataFetchTime.minValue

Minimum timeto fetch page
metadata.

Milliseconds

pageM etadataFetchTime.maxValue

Maximum time to fetch page
metadata.

Milliseconds

queueTimeout

Number of requests for Portal data
that have timed out in the PPE
internal request queue.

Value

Milliseconds

queueStayAvg.value

Average time all internal PPE requests
spent in the PPE internal request
gueue. To obtain the average, divide
the value metric by the count metric.
Thevalueisthe accumulative time for
all requestsand the count isthe
number of requests made.

Milliseconds

queueSayAvg.count

Number of requests added to the
internal PPE request queue. Use this
metric in conjunction with
queueStayAvg.value to calculate the
average time requests spent in the
internal PPE request queue.

Operations

queueSay.value

Timethelast internal PPErequest
spent in the PPE internal request
queue.

Milliseconds

queueSay.count

Number of requests added to the
internal PPE request queue.

Operations

queueStay.minValue

Minimum time arequest spent in the
internal PPE request queue.

Milliseconds

queueStay.maxValue

Maximum time arequest spent in the
internal PPErequest queue.

Milliseconds

queuelLengthAvg.value

Average length of the PPE internal
request queue. To obtain the average,
divide the value metric by the count
metric.

Milliseconds

queueLengthAvg.count

Number of requests added to the PPE
internal request queue. Use this
metric in conjunction with
queueLengthAvg.value to calculate
the average length of the PPE internal
request queue.

Operations

queuelLength.value

Current length of the PPEinternal
request queue.

Milliseconds

queuelLength.count

Number of requests added to the PPE
internal request queue.

Operations
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Minimum number of requestsin the

PPEinternal request queue. Milliseconds

queueLength.minValue

Maximum number of requestsin the

PPE internal request queue. Milliseconds

queueLength.maxValue

requests. Number of page requests. Value | Operations

Count of specific HTTP response

httpXXX codes.

Value | Operations

Count of internal Parallel Page Engine
httpFailure errors encountered whilst requesting Value | Operations
portlets.

httpTimeout Count Qf timeouts encountered whilst Value Operations
requesting portlets.

Count of requests for portlets which
httpUnresolvedRedirect resulted in aredirected request not Value
being resolved successfully.

Oracle Application Server Portal Web Provider Metrics

The Oracle Application Server (AS) Portal Web Provider Metrics category includesthe counterslisted in the
following table.

Counters Description

cacheHits Number of cache hitsfor thisrequest. | Value | Operations

Count of specific HTTP response

httpXXX codes for this request. Value | Operations

executeTime.maxTime | Maximum timeto make the request. Microseconds
executeTime.minTime | Minimum timeto makethe request. Microseconds
executeTime.avg Average time to make the request. Microseconds

Threads currently in the make request

Threads
phase.

executeTime.active

executeTime.time Total time spent making requests. Microseconds

Oracle Application Server Process Manager Metrics

The Oracle Application Server (AS) Process Manager Metrics category includesthe counterslisted in the
following table.
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Description

Number of jobsin the OPMN worker

Conductor

jobWorkerQueue Value Operations
queue.

Number of local HTTP requests which .
IReq OPMN handles. Count Operations
procDeath Number of processes which die after Count Operations

the process manager startsthem.

Number of processes which are
procDeathReplace | restarted after the process manager Count Operations

detectsthey are dead.
reqFail Number of HTTP requests which fail. Count Operations
regPartial Succ N“”.‘ber of HTTPrequests which Count Operations

partially succeed.
reqauce Number of HTTP requests which Count Operations
succeed.

Number of remote HTTP requests .
rReq which OPMN handles. Count Operations
workerThread Number of worker threads. Value Threads

Number of millisecondsthe CPU(s)
cpuldle have been idle since an unspecified Value Milliseconds

time.
freePhysicalM em Amount of freg physical memory on Value Kilobytes

the host machine.

Number of processors available on the
numProcessors . Value Integer

host machine.
totalPhysicalMem Total phys!cal memory available on the Value Kilobytes

host machine.
Number, or maximum number, of
numProcConf processes configured for this process Value Integer
set.
reqFail Numb_er of HTTP requests which fail Count Operations
for this process set.
regPartial Succ N“”.‘ber of HTTP reque_stswhlch Count Operations
partially succeed for this process set.

reqauce Number of HT_TP requests which Count Operations
succeed for this process set

cpuTime Amount of CPU time used by the Value CPU Milliseconds
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process.

heapSze Heap size of the process. Value Kilobytes
privateMemory Private memory of the process. Value Kilobytes
sharedMemory Shared memory for the process. Value Milliseconds

Oracle Application Server Servlet Metrics

The Oracle Application Server (AS) Servlet Metrics category includesthe counterslisted in the following

table.

Counters

service.active

Description

Current number of threads servicing
this servlet.

Threads

service.avg

Average time spent in servicing the
servlet.

Milliseconds

service.completed

Total number of callsto service.

Count

service.maxActive

Maximum number of threads servicing
this servlet.

Threads

service.maxTime

Maximum time spent on a servlet's
service() call.

Operations

service.minTime

Minimum time spent on a servlet's
service() call.

Milliseconds

service.time

Total time spent on the servlet's
service() call.

Milliseconds

Oracle Application Server Task Manager Metrics

The Oracle Application Server (AS) Task Manager Metrics category includesthe counterslisted in the

following table.

interval

Description

How often the task should run. The task
manager executes all the tasksin a
round-robin fashion. If theinterval is
zero, then the task manager executes
the task when it isselected in the round
robin.

Value

Milliseconds

run().active

Number of active threads.

Threads
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run().avg

Average time for the task manager to
run thetask.

Milliseconds

run().completed

Number of timesthe task manager has
run thetask.

Operations

run().maxActive

Maximum number of active tasks.

Threads

run().maxTime

Maximum time for the task to run.

Milliseconds

run().minTime

Minimum time for the task to run.

Milliseconds

run().time

Total time spent running the task

Milliseconds

manager.

Oracle Application Server Web Module Metrics

The Oracle Application Server (AS) Web Module Metrics category includesthe counterslisted in the
following table.

Counters ipti

Total time spent to create/locate
servlet instances (within the serviet
context). Thisincludesthetime for
any required authentication.

resolveServlet.time

Units

Milliseconds

Total number of lookupsfor a

resolveServlet.completed servlet by 0C4J

Operations

Minimum time spent to
resolveServlet.minTime create/locate the servlet instance
(within the servlet context).

Milliseconds

Maximum time spent to
resolveServliet.maxTime create/locate the servlet instance
(within the servlet context).

Milliseconds

Average time spent to create/locate
resolveServiet.avg the servlet instance (within the
servlet context).

Milliseconds

sessionActivation.active Number of active sessions.

Operations

Total time in which sessions have

sessionActivation.time .
been active.

Milliseconds

sessionActivation.completed | Number of session activations.

Operations

sessionActivation.minTime Minimum time a session was active.

Milliseconds
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sessionActivation.maxTime

Maximum time a session was
active.

Milliseconds

sessionActivation.avg

Average session lifetime.

Milliseconds

service.time

Total time spent servicing requests.

Milliseconds

service.completed

Total number of requests serviced.

Operations

service.minTime

Minimum time spent servicing
requests.

Milliseconds

service.maxTime

Maximum time spent servicing
requests.

Milliseconds

service.avg

Average time spent in servicing the
servlet.

Milliseconds

service.active

Current number of requests active.

Operations

parseRequest.active

Current number of threadstrying
to read/parse AJP or HTTP requests.

parseRequest.avg

Average time spent to read/parse
requests.

Milliseconds

parseRequest.completed

Number of web requeststhat have
been parsed.

Operations

parseRequest.maxActive

Maximum number of threadstrying
to read/parse AJP or HTTP requests.

Threads

parseRequest.maxTime

Maximum time spent to read/parse
requests.

Milliseconds

parseRequest.minTime

Minimum time spent to read/parse
requests.

Milliseconds

parseRequest.time

Total time spent to read/parse
requests from the socket.

Milliseconds

processRequest.active

Current number of threads
servicing web requests.

processRequest.avg

Average time spent servicing web
requests.

Milliseconds

processRequest.completed

Number of web requests processed
by this application.

Operations

processRequest.maxActive

Maximum number of threads
servicing web requests.

Threads

processRequest.maxTime

Maximum time spent servicing a

Milliseconds
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web request.

Minimum time spent servicing a

web request. Milliseconds

processRequest.minTime

Total time spent servicing this

TR Milliseconds
application's web requests.

processRequest.time

Current number of threads trying

resolveContext.active to create/find the servlet context.

Average time spent to create/find

the servlet context. Milliseconds

resolveContext.avg

Count of completed context

resolveContext.completed
resolves.

Operations

Maximum number of threadstrying

to create/find the servlet context. Threads

resolveContext.maxActive

Maximum time spent to create/find

the servlet context. Milliseconds

resolveContext.maxTime

Minimum time spent to create/find

the servlet context. Milliseconds

resolveContext.minTime

Total time spent to create/find the
resolveContext.time servlet context. Each web module Milliseconds
(WAR) mapsto a servlet context.

MM Counters

JVM Counters

QALoad providesthe following statically discovered categories for monitoring a Java Virtual Machine
(VM). Each category provides countersthat allow the monitoring of your WM. QALoad utilizesthe Java

Monitoring and Management APl which were introduced in 2SE 5.0 for counter data.

VM Class Loading VM Memory

VM Compilation NM Operating System
VM Garbage Collection NMM Threads
Guideline:

You must start your VM asa"IM X-enabled WM"by inserting the following properties:

C\...\java -Dcom sun. managenent . j mxr enot e. port =1090 -
Dcom sum nmanagenent . j nxr enot e. ssl =fal se -
Dcom sun. managenent . j nxr enot e. aut henti cat e=f al se

For more information, see http://java.sun.com/j2se/1.5.0/docs/guide/management/agent.html.
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JVM Class Loading Counters

The WM Class Loading category includesthe counterslisted in the following table. QALoad utilizes M X
and the Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine (VM)
1.5, release 2SE 5.0.

Counters Description

Approximate time (in milliseconds) spent in Number of
Compilation Time compilation by the WM during the sample Integer o
; milliseconds
interval.
Current Loaded Class Number of classes currently loaded in the Number of
Integer
Count VM. classes
Loaded Class Count Numbt_ar of classesloaded since WM started Long Number of
execution. classes
Unloaded Class Count Number of cla}ssesunloaded sincethe WM Long Number of
started execution. classes

Parameters

The following parameter isvalid for this counter category.

JMX Port

JM X port associated with the VM you want to monitor.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

JVM Compilation Counters

The WM Compilation category includesthe counterslisted in the following table. QALoad utilizes M X
and the Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine (VM)
1.5, release PSE 5.0.

Approximate time (in milliseconds) spent in
Compilation Time compilation by the WM during the sample Long Milliseconds
interval.

Parameters

The following parameter isvalid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.
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Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

JVM Garbage Collection Counters

The WM Garbage Collection category includesthe counterslisted in the following table. QALoad utilizes
JMX and the Java Monitoring and Management APl which were introduced in the Java Virtual Machine
(VM) 1.5, release 2SE 5.0.

Counters Description Type Units

Garbage Collection Number of collectionsthat have occurred Number of
. ; Long ;

Count during the sample interval. collections

Approximate time (in milliseconds) spent
Garbage Collection Time garbage collecting by the WM during the Long Milliseconds
sample interval.

Garbage Collection Total number of collectionsthat have Number of
. . Long ;
Count occurred during the sampleinterval. collections

Total approximate time (in milliseconds)
Garbage Collection Time spent garbage collecting by the VM during Long Milliseconds
the sampleinterval.

Parameters

The following parameters are valid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Collector Name

This parameter is available with some of the garbage collection counters. It providesthe name of the
garbage collector you want to monitor. For the HotSot WM, the values are Copy and
MarkSwveepCom pact.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

JVM Memory Counters

The WM Memory category includesthe counterslisted in the following table. QALoad utilizesMMX and the
Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine (WM) 1.5,
release 2SE 5.0. -
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Counters

Description

Number of timesthat the WM has detected that

Collection Usage the memory usage hasreached or exceeded the Integer Number of
Threshold Count(M) | collection usage threshold for an identified 9 times
memory pool.
Amount of heap memory that iscommitted to the
MM for use. The WM hasaheap that isthe
. runtime data area from which memory for all class
Committed Memory | . .
Hea instances and arrays are allocated. It iscreated at Long Bytes
P the WM start-up. Heap memory for objectsis
reclaimed by an automatic memory management
system which isknown as a garbage collector.
. Amount of memory that isguaranteed to be
Committed . : o
availableto the WM to use for the identified Long Bytes
Memory(M)
memory pool.
Committed Non- Amount of non-heap memory that isguaranteed to Lon Bvtes
heap Memory be available to the WM for use. 9 y
Maximum Heap Maximum amount of heap memory that can be
Long Bytes
Memory used for memory management.
Maximum Maximum amount of memory that can be used for
. Long Bytes
Memory(M) memory management for thismemory pool.
Maximum Non- Maximum amount of non-heap memory that can
Long Bytes
heap Memory be used for memory management.
Objects Pending Approximate number of objects for which Inteaer Number of
Finalization Count finalization is pending. 9 objects
Peak amount of memory (in bytes) that was
Peak Committed guaranteed to be available for use by the VM for Lon Bvtes
Memory(M) theidentified memory pool sincethe VM was 9 y
started or since the peak was reset.
Peak maximum amount of memory (in bytes) that
Peak Maximum was available to the WM for the identified memory Lon Bvtes
Memory(M) pool sincethe VM was started or since the peak 9 y
was reset.
Peak used memory (in bytes) for the identified
Peak Used . .
memory pool since the WM was started or since Long Bytes
Memory(M)
the peak was reset.
. Amount of memory (in bytes) that is guaranteed to
Post Collection be available for use by the VM for the identified
Committed Long Bytes
Memory(M) memory pool aft_er the J\/M most recen?ly
expended effort in recycling unused objects.
Post Collection Maximum amount of memory (in bytes) that is
Maximum availableto the WM for theidentified memory Long Bytes
Memory(M pool after the VM most recently expended effort
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in recycling unused objects.

Post Collection Used

Used memory (in bytes) for the identified memory

Memory(M) pool aftgr the WM mo§t recently expended effort Long Bytes
in recycling unused objects
Total Collection Total number of timesthat the VM has detected Number of
Usage Threshold that the memory usage hasreached or exceeded Long times
Count(M) the collection usage threshold for amemory pool.
Total Committed Amount of memory (in bytes) that isguaranteed to Lon Bvtes
Memory(M) be available for use by the WM. 9 y
Total Maximum Maximum amount of memory (in bytes) available Lon Bvtes
Memory(M) to the WM for memory management. 9 y
Number of timesthat the VM has detected that
Total Usage the memory usage for amemory pool hasreached Lon Number of
Threshold Count(M) | or exceeded the usage threshold for the memory 9 times
pool.
Total Used Amount of memory (in bytes) currently in use by
Memory(M) the WM. Long Bytes
Number of timesthat the VM has detected that
Usage Threshold the memory usage for amemory pool hasreached Lon Number of
Count(M) or exceeded the usage threshold for the memory 9 times
pool.
Amount of heap memory (in bytes) currently in
use by the WM. The WM hasaheap that isthe
runtime data area from which memory for all class
Used Heap Memory instances and arrays are allocated. It is created at Long Bytes
the WM start-up. Heap memory for objectsis
reclaimed by an automatic memory management
system which isknown as a garbage collector.
Used Memory(M) gjﬁ? memory (in bytes) for the identified memory Long Bytes
Used Non-heap Amount of non-heap memory (in bytes) currently
Memory in use by the WM. Long Bytes
Parameters

The following parameters are valid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Memory Pool Name

This parameter is available with some of the memory pool counters. It providesthe name of the memory

pool you want to monitor. For the HotSot VM, the values are Code Cache and Survivor Space.
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Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

JVM Operating System Counter

The WM Operating System category includesthe counterslisted in the following table. QALoad utilizes
JMX and the Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine
(VM) 1.5, release 2SE 5.0.

Counters Description
Available Processor Number of processors available to the VM. Integer Number of
Count processors
Parameters

The following parameter isvalid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Data Point

The primary data point reportsthe number of processors available to the WM .

Interval

Recommended minimum is5 minutes.

JVM Threads Counters

The WM Threads category includesthe counterslisted in the following table. QALoad utilizesJM X and the
Java Monitoring and Management APl which were introduced in the Java Virtual Machine (VM) 1.5,
release 2SE 5.0.

Live Daemon . Number of
Thread Count Number of live daemon threads. Integer threads
Live Thread Count Number of live threads. Integer Number of
threads
Number of threadsthat are in deadlock waiting to
Monitor acquire object monitors. A thread ismonitor-
Deadlocked thread deadlocked if it is part of acyclein the r(?.lation "is Integer Number of
count waiting for an object monitor owned by." In the threads
simplest case, thread A is blocked waiting for a
monitor owned by thread B, and thread Bis
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blocked waiting for amonitor owned by thread A.

Sarted Thread Number of threads started by the WM during the Number of
. Integer

Count sampleinterval. threads

Parameters

The following parameters are valid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Thread ID

Identifiesthe individual thread in the process you want to monitor.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

Managing Counters
Adding Countersto a Task Using New Discovery Data

Add countersto amonitoring task by generating the available counter data and selecting the counters and
instancesto add to the task.

To add countersand instancesto a monitoring task:

1. Click Tools>Monitoring>Add counter>Use new discovery data. The Edit Monitoring Machine
Wizard appears.

2. Follow theinstructionsfor using the wizard to discover and add countersto the monitoring task.

Adding Countersto a Task Using Cached Discovery Data

It ispossibleto add countersto monitor for amachine and monitor type using cached discovery data.

Select the counter to add or modify:

1. Select Monitoring>Add counter>Use cached discovery data. This Add/Edit Counters dialog box
appears.

From the Available Items pane, select the Template tab or the Counter tab.

3. To add an item, select atemplate or a counter, and click Add, or double-click the item to display it
in the Selected Items pane. Click Add All to add all theitemson the selected tab to the Selected
Items pane.
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4. Toremove an item, double-click the item in the Selected Items pane or select the item and click
Remove. Theitem isreturned to the Available Items pane.

El Note: Select multiple counters and templates by doing one of the following:

1. To select nonadjacent counter items, click a counter item, and then hold down Ctrl and click
each additional counter item.

2. To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

5. Click Next. The Choose Instances dialog box displays.

El Note: When you select atemplate, and some of the countersit contains are not present on the machine
you are defining, you receive a message with a list of the countersthat will not be added to the task.

Choose the instances of the counter to monitor:

When clicking Next in the previous dialog box. The Choose Instances dialog box appears.

1. Review the countersselected. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until all instances of the counter that you want to apply to the task are selected.
Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Save the task:

When clicking Next in the previous dialog box, the Summary dialog box appears.

1. OntheSummary dialog box, review the monitors and counters selected for the template. Click
Back to return to adialog box and make changesto the information.

2. Click Finish to add the counters.

Removing a Monitor or a Counter from a Monitoring Task

Remove a monitor or a counter from a monitoring task, by following this procedure.

To remove a counter from a monitoring task:

1. On the Monitoring Optionstab, select the monitor, counter, or counter family to delete.
2. Click Tools>Monitoring>>Remove monitor/Remove counter.

3. When the verification dialog box displays, click OK.

El Note: You cannot remove the last monitor on a machine, the last counter in the family, or the last family of
countersin the task.
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Monitoring Templates
About Monitoring Templates

Monitoring templates are designed to facilitate the configuration process. A monitoring templateisa
predefined group of countersnot associated with a specific machine. You can create a new template for a
monitoring task, or you can use one of QALoad's pre-defined templates.

When you create a custom template, QALoad's New Monitoring Template wizard guidesyou through the
process of defining the type of template you want to create, configuring the monitor properties, and
adding the counters and instances of countersto the template.

When you use one of QALoad's predefined templates, you select a stored template with the countersyou
want to monitor. The templates have counters grouped by functionality, such as Network Traffic, Response
Time, or System Health. Where appropriate, the templatesinclude the specific instancesto monitor for
each counter.

You can add or edit countersin either custom or pre-defined templates. When you open atemplate to edit
it for thefirst time, Edit Monitoring Template wizard guides you through the process of discovering and
adding new countersto atemplate. When you've just completed the counter discovery process for a
template, either by creating a new template or by opening atemplate for editing, you can select counters
from those already available in memory by using the cached discovery.

Custom Templates

You can create templates of the monitoring tasksthat you develop so that all of the countersand instances
for the task are saved. You can create new tasks and incorporate the template you created. Templates are
saved as.xml filesin the Templates directory.

You can create atemplate when you define a monitoring task, or you can use the New Monitor Template
wizard to create and store atemplate for future use. Custom templates can be modified using either new
discovery data or cached discovery data.

Pre-defined Templates

About Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. Each template includesthe counters most
commonly used for particular task within each monitor type.

QALoad providesthe templates form the following monitor types:
I Oracle Application Server
! JVM
! SAP
I Server Analysis Agent
! SNMP
I WebLogic
I WebSphere
I WebSphere MQ
I Windows Registry

! WMI
El Note: You cannot modify pre-defined templates.
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Viewing Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. These include the countersmost commonly
used for particular task.

To access and review pre-defined templates:

In the Conductor, select Tools>Monitoring>Manage Monitoring Templates>Open existing template.
VM Templates

VM Templates
QALoad providesthe following pre-defined VM Server templates:
MM Availability

VM Performance

VM Availability
Thistemplate monitorsthe availability of your WM server.
The default sampling interval rate for thistemplate is5 minutes.

The VM Availability template monitorsthe following counters and categories:

Category Counters Description

Class Loading Current Loaded Class Count Number of classesthat are currently loaded in
the WM.
Amount of memory (in bytes) currently in use
Memory Total Used Memory by the VM.
Operating System Available Processor Count Number of processors available to the VM.
Threads Live Thread Count Number of live threads.

MM Performance
Thistemplate monitorsthe performance of your VM server.
The default sampling interval rate for thistemplate is5 minutes.

The WM Performance template monitorsthe following counters and categories:

Category ‘ Counters ‘ Description

Approximate time (in milliseconds) spent in

Compilation Compilation Time compilation by the WM during the sample
interval.
Garbage Total approximate time (in milliseconds) spent

) Total Garbage Collection Time
Collection g garbage collecting by the VM during the
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sampleinterval.

SAP Templates

SAP Templates

QALoad providesthe following pre-defined SAP templates:
QALoad-SAP R3 Remote Availability

QALoad-SAP R3 Remote Performance

QALoad-SAP R3 Remote System Errors

QALoad-SAP R3 Remote Availability

Thistemplate monitorsthe availability of an SAP R/3 Instance. The SAP R/3 Availability template returns
critical information about the availability of your SAPinstallation. One metric used to determinethe
availability of an SAP R/3 Instance isthe status of the SAP collector.

The default event action assigned to thistemplate issuesan alarm if either the specified R/3 Instance or the
collector goesdown. The default instance isthe first SAP Instance configured for monitoring during
installation.

The SAP R/3 Availability template uses the following SAP R/3 extended counters:

Active Servers Returnsthe number of active SAP application servers for
agiven instance. It detectswhen aremote server is
unavailable.

Rule: IF 'SAP R/3 Remote Extended.Active Servers(SAP
Instance: "**", Server Count: "10")' =0 .

QALoad-SAP R3 Remote Performance
Thistemplate monitorsthe performance of your SAP R/3 Instance.

The default event action for thistemplate raises an event if the number of alerts of critical statusis greater
than O, or if the buffer hit ratio falls below 95%.

All the counters associated with thistemplate require the instance number of your SAP installation. By
default, thistemplate usesthe first instance configured for monitoring during ServerVantage installation. If
you use thetask configuration wizard to change the instance that the template monitors, you must also
change theinstance specified in the rule accordingly.

The SAP R/3 Performance template uses the following SAP R/3 extended counters;

Buffer Statistic Returnsdifferent buffer statistics for selected buffer name. This
counter was chosen because buffering dataisakey to the
performance of SAP.

Rule: IF 'SAP R/3 Remote Extended.Buffer Satistic(SAP Instance:
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"*x" Buffer Name: "TTAB", Satistic Name: "Hit rate SAP
buffer(%%)")' < 95.

Itemized Spool Queue Return number of entriesin the spool queue that match the
specified criteria.

Rule: IF '"SAP R/3 Remote Extended.Spool Queue(SAP Instance:
" Request Status: "Processing")' > 10.

Memory Usage Returns current memory usage.

Rule: IF 'SAP R/3 Remote Extended.Memory Usage(SAP Instance:
"xtCount: "10", Metrics: "M B")' > 10000.

Page/Roll Area Returns Used Paging Area % statistic. This counter was chosen
because roll memory iscritical for work processes and page
memory iscritical for internal data processing.

Work Processes Counter for monitoring SAP R/3 work processes. Returns number
of stopped work processes.

Rule: IF'SAP R/3 Remote Extended.Work Processes(SAP Instance:
"**" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:
"Sopped")' > 2.

QALoad-SAP R3 Remote System Errors

Thistemplate monitorsthe errorsand critical situationsthat occur on a SAP R/3 system. Rules and
thresholds are preset to appropriate values for most sites.

The default sampling interval for thistemplateis5 minutes.

The SAP R/3 Performance template uses the following SAP R/3 Remote extended counters:

_

Alerts Counter for monitoring R/3 alerts. Returns number of alerts
according to the specified criteria. This counter checks all alerts
with error (red) status.

Rule: IF'SAP R/3 Remote Extended.Alerts(SAP Instance: "**",
Monitor Set: "SAP CCMSAdmin Workplace", Monitor:
"Database", Severity: "Error - Red", Pattern: "*", Show Alert Text:
“No")' > 0.

Itemized Spool Queue Return number of entriesin the spool queue that match the
specified criteria.

Fool Queue Return number of entriesin the spool queue that match the
specified criteria. This counter checks all spool entrieswith
“Problem” status.

Rule: IF'SAP R/3 Remote Extended.Spool Queue(SAP Instance:
"** Request Satus: "Problem™)’ > 0.

Work Processes Counter for monitoring SAP R/3 work processes. Returns number
of work processes according to the specified criteria. This counter
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checks stopped work processes.

Rule: IF'SAP R/3 Remote Extended.Work Processes(SAP Instance:
"**" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:

"Sopped")' > 0.

SNMP Templates

SNMP Templates

QALoad providesthe following pre-defined SNMP templates:

QALoad-HP Performance
QALoad-Linux Performance
QALoad-SUN Performance

QALoad-HP Performance

Thistemplate includesthe following counters and categories:

N )

HP System Cpuldle%

CpuSysh

CpuUser%

FreeMemory KBytes

FreeSvap KBytes

MaxUserMem KBytes

Users

tcp tcplnSegs/ sec
tcpOutSegs/sec

udp udplnDatagrams/sec
udpOutDatagrams/sec

CpuSys¥ isthe percentage of idle processor
time.

CpuSys¥ isthe percentage of non-idle
processor timethat isspent in system mode.

CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

FreeMemory KBytesisthe amount of idle
memory.

FreeSvap isthe amount of free swap space on
the system.

MaxUserMem isthe amount of maximum user
memory on the system.

Usersisthe number of userslogged on to the
machine.

tepInSegs/secisthe rate at which segments are
received, including those received in error.

tcpOutSegs/secistherate at which segments
are sent, including those on current

connections but excluding those containing
only retransmitted octets.

udplnDatagrams/secistherate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec isthe rate at which UDP
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datagrams are sent.

QALoad-Linux Performance

Thistemplate includesthe following counters and categories:

Linux System Cpuldle% CpuSys¥ isthe percentage of idle processor
time.
CpuSys¥ CpuSys¥ isthe percentage of non-idle processor

timethat isspent in system mode.

CpuUser% CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec Interrupts/sec isthe rate of system interrupts.

Pagesin KBytes/sec Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec PagesOut KBytes/sec isthe rate of pages written
to disk.

Swapln KBytes/sec Swapln KBytes/sec isthe rate at which pages are

being swapped in.

SwvapOut KBytes/sec SwapOut KBytes/sec isthe rate at which pages
are being swapped out.

tep tepln Segs/sec tepInSegs/secisthe rate at which segments are
received, including those received in error.

tcpOutSegs/sec tcpOutSegs/sec istherate at which segments are
sent, including those on current connections
but excluding those containing only
retransmitted octets.

udp udplnDatagrams/sec udplnDatagrams/secistherate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec | udpOutDatagrams/sec istherate at which UDP
datagrams are sent.

WebLogic Templates

WebLogic Templates
QALoad providesthe following pre-defined WebLogic templates:
QALoad-WebLogic Availability
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QALoad-WebLogic EB Performance
QALoad-WebLogic JDBC Performance
QALoad-WebLogic M S Performance
QALoad-WebLogic Performance
QALoad-WebLogic Server Security
QALoad-WebLogic Servlet Performance

QALoad-WebLogic Availability

Thistemplate monitorsthe availability of a WebLogic server. The WebLogic Availability template returns
critical information about the availability of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Availability template usesthe following WebLogic extended counters:

ExecuteQueueRuntime ExecuteQueueRuntime_PendingRequestOldestTime Returnsthetime
that the longest
waiting request
was placed in
the queue.

Rule: The
Application
Server isnot in
running mode if
thiscounter
valueis> 50.

ServerRuntime ServerRuntime_StateVal Returnscurrent
state of the
server. This
counter provides
amore detailed
state than
available or not.

Rule: The
Application
Server isnot in
running mode if
thiscounter
valueis<> 2.

ServerSecurityRuntime ServerSecurityRuntime _LockedUsersCurrentCount Returnsthe
number of
currently locked
userson this
server.

Rule: There are a
high number of
users locked out
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if thiscounter
valueis > 5.

QALoad-WebLogic EB Performance

Thistemplate monitorsthe EB performance of a WebLogic server. The WebLogic EIB Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.

The WebLogic EB Performance template usesthe following WebLogic extended counters:

EJBCacheRuntime EBCacheRuntime_ActivationCount

EBCacheRuntime_CacheAccessCount

EBCacheRuntime_CachedBeansCurrentCount

EBCacheRuntime _CacheHitCount
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Returnsthe
total number
of timesthe
EB was
activated.

Rule: Thereis
inefficient
cache access if
the number of
activationsis>
20.

Returnsthe
total number
of attemptsto
access a bean
from the
cache.

Returnsthe
total number
of beans from
thiselB Home
currently in
the EJB cache.

Returnsthe
total number
of timesan
attempt to
access a bean
from the cache
succeeded. The
cacheHitCoun
t value
subtracting the
cache miss
count from
the cache
access count.
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EBCacheRuntime_PassivationCount Returnsthe
total number
of beans from
thiselB Home
that have been
passivated.

Rule: Thereis
inefficient
cache access if
the number of
passivationsis
> 20.

EJBLockingRuntime EBLockingRuntime _LockEntriesCurrentCount Returnsthe
number of
currently
locked users
on this server.

EBLockingRuntime TimeoutTotalCount Returnsthe
current
number
Threadsthat
have timed
out waiting for
alock on a
bean.

EBLockingRuntime_WaiterTotalCount Returnsthe
number of
objects waiting
on thelock.

Rule: There are
alot of objects
waiting if the

interval value

of thiscounter
is>10.

EJBPoolRuntime EBPoolRuntime_BeansinUseCurrentCount Returnsthe
number of
bean instances
currently
being used
from the free
pool.

EBPoolRuntime_ldleBeansCount Returnsthe
total number
of available
bean instances
in the free
pool.
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EJBTransactionRuntime

284

EBPoolRuntime_TimeoutTotalCount

EBPoolRuntime WaiterTotalCount

EBTransactionRuntime_TransactionsCommittedTotalCount

EBTransactionRuntime_TransactionsRolledBackTotalCount

Returnsthe
total number
of Threads
that have
timed out
waiting for an
available bean
instance from
the free pool.

Rule: There are
alot of objects
timing out if
theinterval
value of this
counteris >
20.

Returnsthe
total number
of Threads
currently
waiting for an
available bean
instance from
the free pool.

Rule: There are
alot of objects
waiting if the

interval value

of thiscounter
is>10.

Returnsthe
total number
of transactions
that have been
committed for
this EB.

Rule: Thereis
high
transaction
overhead if the
interval value
of thiscounter
is> 20.

Returnsthe
total number
of transactions
that have been
rolled back for
this EB.

Rule: Thereis



EBTransactionRuntime_TransactionsTimedOutTotalCount

MessageDrivenEJBRuntime MessageDriven EBBRuntime_JM SConnectionAlive

QALoad-SUN Performance

Thistemplate includesthe following counters and categories:

Sun System Cpuldle% CpuSys% isthe percentage of idle processor
time.
CpuSys% CpuSys% isthe percentage of non-idle processor

timethat isspent in system mode.

CpuUser% CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec Interrupts/sec isthe rate of system interrupts.

Conductor

high
transaction
overhead if the
interval value
of thiscounter
is>20.

Returnsthe
total number
of transactions
that have
timed out for
this EB.

Rule: Thereis
high
transaction
overhead if the
interval value
of thiscounter
is>20.

Returnsa
boolean of the
status of the
connection.
Thiscounter
displaysthe
state of a M S
connection.

Rule: The MS
Connection is
down if this
counter value
is=0.
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Pagesin KBytes/sec Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec PagesOut KBytes/sec isthe rate of pages written
to disk.

Swaplin KBytes/sec Swapln KBytes/sec istherate at which pages are

being swapped in.

SwvapOut KBytes/sec SwvapOut KBytes/sec istherate at which pages
are being swapped out.

tcp tepln Segs/sec tcplnSegs/sec isthe rate at which segments are
received, including those received in error.

tcpOutSegs/sec tcpOutSegs/sec istherate at which segments are
sent, including those on current connections
but excluding those containing only
retransmitted octets.

udp udplnDatagrams/sec udplnDatagrams/sec isthe rate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec  udpOutDatagrams/sec istherate at which UDP
datagrams are sent.

QALoad-WebLogic JDBC Performance

Thistemplate monitorsthe JDBC performance of a WebLogic server. The WebLogic JDBC Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic DBC Performance template usesthe following WebLogic extended counters:

JDBC Connection Pool ActiveConnectionsCurrentCount Returnsthe current number of active
Runtime connections.
ActiveConnectionsHighCount Returnsthe highest number of active

current connections. The count starts
at zero each timethe
JDBCConnectionPoolRuntimeM Bean
isinstantiated.

ConnectionDelayTime Returnsthe number of milliseconds it
takesto get a physical connection
from the database. It is calculated as
summary time to connect divided by
summary number of connections.

ConnectionsTotalCount Returnsthe total number of DBC
connectionsin this
DBCConnectionPoolRuntimeM Bean
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FailuresToReconnectCount

LeakedConnectionCount

PoolSate

PrepSmtCacheMissCount

WaitingForConnectionHighCount

WaitSecondsHighCount

QALoad-WebLogic M S Performance

Conductor

since the pool wasinstantiated.

Returnsthe number of attemptsto
refresh a connection to a database
that failed. Failure may be due to the
database being unavailable or a
broken connection to the database.

Rule: There are a high number of
connection reconnect failureswhen
thiscounter valueis> 1.

Returnsthe number of connections
that were checked out from the
connection pool but were not
returned to the pool by calling close

0

Rule: Thereisalot of connection
pool leakage if this counter valueis >
5.

Current state of the connection pool.
Returns True if the pool isenabled,
False if the pool isdisabled.

Returns acount of the caseswhen
the cache doesnot have a cached
statement to satisfy arequest.

The high water mark of waiters for a
connection in this
JDBCConnectionPoolRuntimeM Bean.
The count starts at zero each timethe
JDBCConnectionPoolRuntimeM Bean
isinstantiated.

Returnsthe highest number of
seconds a connection waited.

Rule: Thereisalong wait for the
connection pool if thiscounter value
is >120.

Thistemplate monitorsthe M Sperformance of a WebLogic server. The WebLogic M S Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.

The WebLogic M SPerformance template usesthe following WebLogic extended counters:
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JMSConnectionRuntime SessionsCurrentCount

SessionsTotalCount
JMSRuntime

ConnectionsCurrentCount

ConnectionsTotalCount

JMSServerRuntime M essagesPendingCount

M essagesReceivedCount

M SSessionRuntime ConsumersCurrentCount

M essagesPendingCount

M essagesReceivedCount

M essagesSentCount
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Returnsthe current number of
sessions for thisconnection.

Returnsthe number of sessions
on thisconnection since the last
reset.

Returnsthe current number of
connectionsto thisWebLogic
Server.

Returnsthe total number of
connectionsmade to this
WebLogic Server since the last
reset.

Returnsthe current number of
messages pending
(unacknowledged or
uncommitted) stored on this
M Sserver. Pending messages
are over and above the current
number of messages.

Rule: There are alarge number
of pending messages if this
counter value is > 50.

Returnsthe number of messages
received on thisdestination
since the last reset.

Returnsthe current number of
consumers for this session.

Returnsthe number of messages
pending (uncommitted and
unacknowledged) for this
session.

Rule: There are alarge number
of pending M S Session
messages if this counter valueis
> 50.

Returnsthe number of messages
received on thisdestination
sincethelast reset.

Returnsthe number of bytes
sent by thissession since the
last reset.
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Conductor

Thistemplate monitorsthe performance of aWebLogic server. The WebLogic Performance template
returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Performance template usesthe following WebLogic extended counters:

ConnectorServiceRuntime

ExecuteQueueRuntime

JMSRuntime

JTARuntime

ConnectionPoolCurrentCount

ExecuteThreadCurrentldleCount

PendingRequestCurrentCount

ServicedRequestTotalCount

ConnectionsCurrentCount

ActiveTransactionsTotalCount

SecondsActiveTotalCount

TransactionRolledBackResourceTotalCount

TransactionTotalCount

Returnsthe number of
currently deployed
connection pools.

Returnsthe number of idle
threads assigned to the
gueue.

Returnsthe number of
waiting requestsin the
queue.

Rule: There are alarge
number of pending requests
if thiscounter value is > 50.

Returnsthe number of
requests that have been
processed by this queue.

Returnsthe current number
of connectionsto this
WebLogic Server.

Rule: There are alarge
number of M Sconnections
if thiscounter valueis > 20.

Returnsthe number of active
transactionson the server.

Returnsthe total number of
seconds for all committed
transactions.

Returnsthe number of
transactionsthat were rolled
back due to aresource error.

Returnsthe total number of
transactions processed. This
total includesall committed,
rolled back and heuristic
transaction completions.
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JVMRuntime HeapFreeCurrent Returnsthe current amount
of free memory (in bytes) in
the WM heap.

TimeServiceRuntime ExceptionCount Returnsthe total number of

exceptionsthrown while
executing scheduled triggers.

Rule: There are alarge
number of exceptionsif the
interval value of this counter
is>20.

ExecutionsPerMinute Returnsthe average number
of triggers executed per
minute.

QALoad-WebLogic Server Security

Thistemplate monitorsthe security of a WebLogic server. The WebLogic Server Security template returns
critical information about the security status of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Server Security template usesthe following WebLogic extended counters:

e e e

ServerSecurityRuntime InvalidLoginAttemptsTotalCount Returnsthe cumulative number of
invalid login attempts made on this
server.

Rule: Multipleinvalid login
attemptshave occurred when the
interval value of thiscounter is> 5.

LockedUsersCurrentCount Returnsthe number of currently
locked userson this server.

Rule: There are multiple locked
usersif thiscounter valueis > 5.

LoginAttemptswWhileLockedTotalCount Returnsthe cumulative number of
invalid login attempts made on this
server while the user was locked.

UnlockedUsersTotalCount Returnsthe number times users
have been unlocked on this server.

QALoad-WebLogic Servlet Performance

Thistemplate monitorsthe performance of your WebLogic serviet. The WebLogic Servlet Performance
template returnscritical information about the servlet performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.
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The WebLogic Serviet Performance template usesthe following WebLogic extended counters:

T T

ServletRuntime ExecutionTimeAverage Returnsthe average time all invocations of the
servlet that has executed since the task was
created.

Rule: The servlet isaveraging high execution
timesif thiscounter value average is > 10.

ExecutionTimeHigh Returnsthe amount of time the single longest
invocation of the servlet that has executed
since the task was created.

ExecutionTimeTotal Returnsthe total amount of time all
invocations of the servlet that has executed
since the task was created.

Internal Servlet whether thisisan Internal Servlet or not

InvocationTotalCount Returnsthe total number of timesthe servlet
has been invoked. Getsthe
invocationTotalCount attribute of the
ServletRuntimeM Bean object.

ReloadTotalCount Returnsthe total number of timesthe servlet is
reloaded. GetsthereloadTotalCount attribute
of the ServletRuntimeM Bean object.

WebSphere Templates

WebSphere Templates

QALoad providesthe following pre-defined WebSphere templates:
QALoad-WebSphere 5.0 IDBC Performance

QALoad WebSphere 5.0 Performance

QALoad-WebSphere 5.0 Web Application Performance

QALoad-WebSphere 5.0 IDBC Performance

Thistemplate monitorsthe performance of aWebShere IDBC server. The WebSphere DBC Performance
template returnscritical information about the JDBC performance of your WebSphere installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere DBC Performance template usesthe following WebSphere extended counters:

JDBC connectionPoolModule.avgWaitTime Average waiting time in milliseconds until a connecti
Connectio
n Pool
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Module

connectionPoolModule.concurrentWaiters WebShere extended counter for monitoring
connectionPoolModule.concurrentWaiters

connectionPoolModule.faults Average waiting time in milliseconds until a connecti

connectionPoolModule.percentMaxed Average percent of thetimethat all connectionsareiil

Rule: IF 'WebSphere

connectionPoolModule.connectionPoolM odule.perce

"t Server: "**" Data Source: "all")' > 25.

connectionPoolModule.percentUsed Average percent of the pool that isin use.

QALoad-WebSphere 5.0 Web Application Performance

Thistemplate monitorsthe performance of aWebShere 5.0 Web Application server. The WebSphere 5.0
Web Application Performance template returnscritical information about the Web Application

performance of your WebSphere installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere 5.0 Web Application Performance template usesthe following WebSphere extended

counters:

WebSphere servlietSessionsModule.activateNonExistSessions
servletSessionsModule

servletSessionsM odule.activeSessions

servletSessionsM odule.cacheDiscards

servletSessionsM odule.invalidatedSessions
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Number of requests for a
session that no longer exists,
presumably because the
session timed out. This
counter may indicate a high
number of timeout
conditions.

The number of concurrently
active sessions. A session is
active if WebSphereis
currently processing a
request, which usesthat
session. This counter may
indicate high activity.

Number of session objects
that have been forced out of
the cache. Thiscounter may
indicate aneed for more
memory in the cache.

Number of sessions
invalidated. This counter
may indicate a high number
of invalidated sessions.



WebSphere
webAppModule

servletSessionsM odule.invalidatedViaTimeout

webAppModule.serviets.concurrentRequests

webAppModule.servlets.numErrors

webAppModule.serviets.responseTime

QALoad WebSphere 5.0 Performance

Thistemplate includesthe following counters and categories:

WebSphere
jvmRuntimeModul
e

WebSphere
orbPerfModule

jvmRuntimeModule.freeMemory

jvmRuntimeModule.usedMemory

orbPerfModule.concurrentRequests

orbPerfModule.interceptors.processingTime

orbPerfModule.referenceLookupTime

Conductor

Number of requests for a
session that no
CountSatistic exists,
presumably because the
session timed out. This
counter may indicate ahigh
number of timeout
conditions.

Number of requeststhat are
concurrently processed. This
counter may indicate high
activity for an application.

Total number of errorsin a
servlet or Java Server Page
(JSP). Thiscounter may
indicate a high number of
error incidents.

Responsetime, in
milliseconds, of a servlet
request. Thiscounter may
indicate a slow response
time of arequest.

WebShere extended counter for
monitoring
jvmRuntimeModule.freeMemory

WebShere extended counter for
monitoring
jvmRuntimeModule.usedMemory

WebSphere extended counter for
monitoring
orbPerfModule.concurrentRequests

WebSphere extended counter for
monitoring
orbPerfModule.interceptors.processingTime

WebShere extended counter for

monitoring
orbPerfModule.referenceLookupTime
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WebSphere systemModule.avgCpuUtilization WebShere extended counter for
systemModule monitoring
systemModule.avgCpuUtilization

systemModule.freeMemory WebSphere extended counter for
monitoring systemModule.freeMemory

WebSphere hreadPoolModule.activeThreads WebSphere extended counter for
threadPoolModule monitoring
threadPoolM odule.activeThreads

WebSphere MQ Templates

WebSphere MQ Templates

QALoad providesthe following pre-defined WebSphere MQ templates:
QALoad-WebSphere MQ Availability

QALoad-WebSphere MQ Performance

QALoad-WebSphere MQ Availability

Thistemplate monitorsthe availability of aWebShere MQ server. The WebSohere MQ Availability
template returnscritical information about the availability of your WebSphere MQ installation.

The default sampling interval for thistemplateis5 minutes.
The WebShere MQ Availability template usesthe following WebSphere MQ extended counters:

e e

Channel Events Return the number of channel events for the current
interval.

Queue Manager Events | Reportsthe number of queue manager eventsfor the
current interval.

Queue Manager Monitorstherunning state of a queue manager.
Up/Down

QALoad-WebSphere MQ Performance

Thistemplate monitorsthe performance of aWebShere MQ server. The WebSphere MQ Performance
template returnscritical information about the performance of your WebSphere MQ installation.

The default sampling interval for thistemplate is5 minutes.

The WebShere MQ Performance template usesthe following WebSphere MQ extended counters:

Performance Events Thiscounter reportsthe number of
performance eventsfor the current
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interval.

WMI Templates

WMI Templates

QALoad providesthe following pre-defined WMI templates:
QALoad-Active Monitoring Availability

QALoad-Citrix IMA Networking

QALoad-Citrix Metaframe All

QALoad-Citrix MetaFrame IMA

QALoad-Citrix MetaFrame Zone

QALoad-Cold Fusion

QALoad-Generic Application Availability and Performance
QALoad-M SIIS Availability

QALoad-M SIISPerformance

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Memory Available M Bytes
Processor % Processor Time
System System Up Time

QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:
I I
Citrix IMA Networking Bytes Received/sec
Bytes Sent/sec
Network Connections

Network Interface Bytes Total/sec

QALoad-Citrix Metaframe All
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Thistemplate includesthe following counters and categories:
Citrix MetaFrame XP Application Enumerations/sec

Application Resolution Time
(ms)

Application Resolutions/sec
Data Sore Connection Failure
DataStore bytes read/sec
DataStore bytes written/sec
DataStore reads/sec

DataStore writes/sec

Dynamic Store bytes read/sec

DynamicSore bytes
written/sec

DynamicStore reads/sec
DynamicStore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes
read/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/sec
LocalHostCache writes/sec
Zone Elections

Zone ElectionsWon

Memory Page Reads/sec
PhysicalDisk % Disk Time
Processor % Processor Time
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QALoad-Citrix MetaFrame IMA

Thistemplate includesthe following counters and categories:

Citrix MetaFrame Application Enumerations/sec
XP

Application Resolution Time (ms)

Application Resolutions/sec
Data Sore Connection Failure
DataStore bytesread/sec
DataStore bytes written/sec
DataStore reads/sec

DataStore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytesread/sec

LocalHostCache byteswritten/sec

LocalHostCache reads/sec

LocalHostCache writes/sec
Terminal Services | Active Sessions

Total Sessions

QALoad-Citrix MetaFrame Zone

Thistemplate includesthe following counters and categories:

T | T

Citrix MetaFrame Dynamic Store bytes read/sec
XP

DynamicSore bytes
written/sec

DynamicStore reads/sec
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DynamicSore writes/sec
LocalHostCache bytes read/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/sec

Zone Elections

Zone Elections Won
Network Interface Bytes Total/sec

Current Bandwidth
Terminal Services = Active Sessions

Total Sessions

QALoad-Cold Fusion

Thistemplate includesthe following counters and categories:

ColdFusion M X Avg DB Time (msec)
Server

Avg Queue Time (msec)

Avg Req Time (msec)

BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec

Queued Requests

Running Requests

Timed Out Requests
Memory % Committed BytesIn Use

Available Bytes
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QALoad-Generic Application Availability and Performance

Thistemplate includesthe following counters and categories:

Process

System

Page Faults/sec

% Processor Time

% Processor Time

System Up Time

QALoad-M SIS Availability

Thistemplate includesthe following counters and categories:

System

Web Service

System Up Time

Current Anonymous
Users

Current Connections
Logon Attempts/sec

NonAnonymous
Users/sec

Not Found Errors/sec
Total Delete Requests
Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-M SIS Performance

Thistemplate includesthe following counters and categories:

Conductor
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Internet Current Blocked Async I/O
Information Requests
Services Global

Total Blocked Async I/O
Requests

Total Rejected Async 1/0O
Requests

URI Cache Hushes
URI Cache Hits
URI Cache Hits %

URI Cache Misses

PhysicalDisk % Disk Time
Process % Processor Time
Redirector Current Commands

Network Errors/sec

Server Work Item Shortages
Server Work Queue Length
Queues

Web Service Not Found Errors/sec

Windows Registry Templates

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Memory Available MBytes Thiscounter monitorsthe Active
Monitoring client site and notifies
you when it islow on resources,
where Processor time is > 95% for
more than 3 intervals. The parameter
for thiscounter isinstance. The
default is _Total.

Processor % Processor Time Raise an event when Active
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Monitoring client siteislow on
memory resources, where Available
Memory isat or below 1MB for more
than 3 intervals.

System System Up Time  Thiscounter teststhe network
connection between two machines
and monitorsthe communication
status of the machinethat receives
communication.

QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:

Citrix IMA Bytes
Networking Received/sec(*_Total”)
Bytes

Sent/sec(_Total”)

Network Connections

Network Interface Bytes Total/sec

QALoad-Citrix Metaframe all

Thiscounter monitorsthe
total bytesreceived per
second.

Thiscounter monitors the
total bytes sent per second.

Thiscounter monitorsthe
network connections.

Thiscounter monitorsthe
network connection total
bytes/sec.

Thistemplate includesthe following counters and categories:

Citrix MetaFrame XP = Application Enumerations/sec = Thiscounter monitors

application enumerations/
sec.

Application Resolution Time Thiscounter monitors

(ms)

application resolution
time.

Application Resolutions/sec Thiscounter monitors

application resolutions.

Data Sore Connection Failure Thiscounter monitors

DataStore bytesread/sec

datastore connection failure.

Thiscounter monitors
datastore bytes reads per
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Memory

302

DataStore byteswritten/sec

DataStore reads/sec

DataSore writes/sec

Dynamic Sore bytes read/sec

DynamicSore bytes
written/sec

DynamicSore reads/sec

DynamicSore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytes read/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/ sec

LocalHostCache writes/ sec

Zone Elections

Zone ElectionsWon

Page Reads/sec

second.

Thiscounter monitors
datastore bytes written per
second.

Thiscounter monitors
datastore reads per second.

Thiscounter monitors
datastore writes per second.

This counter monitors
DynamicSore bytesread per
second.

Thiscounter monitors
DynamicSore bytes written
per second.

Thiscounter monitors
DynamicSore reads per
second.

This counter monitors
DynamicSore writes per
second.

This counter monitors
Filtered Application
Enumerations per second.

This counter monitors
LoadHostCache bytesread
per second.

This counter monitors
LoadHostCache bytes
written per second.

Thiscounter monitors
LoadHostCache reads per
second.

This counter monitors
LoadHostCache writes per
second.

Thiscounter monitors zone
elections.

Thiscounter monitors zone
electionswon.

This counter monitors page
reads per second.



PhysicalDisk

Processor

% Disk Time

% Processor Time

QALoad-Citrix Metaframe IMA

Conductor

Thiscounter monitors %
disk time.

Thiscounter monitors %
processor time.

Thistemplate includesthe following counters and categories:

Citrix MetaFrame
XP

Application Enumerations/sec

Application Resolution Time (ms)

Application Resolutions/sec

Data Sore Connection Failure

DataStore bytes read/sec

DataStore byteswritten/sec

DataSore reads/sec

DataSore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes read/sec

LocalHostCache byteswritten/sec

LocalHostCache reads/sec

LocalHostCache writes/sec

Thiscounter monitorsthe
application enumeration per
second.

Thiscounter monitorsthe
application resolution time.

Thiscounter monitorsthe
application resolution.

Thiscounter monitorsthe
datastore connection failure.

Thiscounter monitorsthe
datastore bytesread per second.

Thiscounter monitorsthe
datastore byteswritten per second.

Thiscounter monitorsthe
datastore reads per second.

Thiscounter monitorsthe
datastore writes per second.

Thiscounter monitors filtered
application enumerations per
second.

Thiscounter monitors
LoadHostCache bytesread per
second.

Thiscounter monitors
LoadHostCache bytes written per
second.

This counter monitors
LoadHostCache reads per second.

This counter monitors
LoadHostCache writes per second.
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Terminal Services Active Sessions Thiscounter monitors active
sessions.
Total Sessions Thiscounter monitorstotal
sessions.

QALoad-Citrix Metaframe Zone

Thistemplate includesthe following counters and categories:

Citrix MetaFrame Dynamic Sore bytesread/sec Thiscounter monitorsthe dynamic

XP store bytesread / sec.
DynamicSore bytes This counter monitorsthe dynamic
written/sec store bytes written / sec.
DynamicSore reads/sec This counter monitorsthe dynamic

store reads/ sec.

DynamicStore writes/sec This counter monitorsthe dynamic
store writes/ sec.

LocalHostCache bytesread/sec Thiscounter monitorsthe
LocalHostCache bytesread / sec.

LocalHostCache bytes Thiscounter monitorsthe
written/sec LocalHostCache bytes written / sec.
LocalHostCache reads/sec This counter monitorsthe

LocalHostCache reads/ sec.

Zone Elections This counter monitorsthe zone
elections.
Zone Elections Won This counter monitorsthe zone

electionswon.

Network Interface Bytes Total/sec This counter monitors network
connection total bytes.

Current Bandwidth This counter monitors network
connection current bandwidth.

Terminal Services Active Sessions This counter monitors active sessions.

Total Sessions This counter monitorstotal sessions.
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Thistemplate includesthe following counters and categories:

ColdFusion M X
Server

Memory

Process

Avg DB Time (msec)

Avg Queue Time (msec)
Avg Req Time (msec)
BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec

Queued Requests
Running Requests
Timed Out Requests

% Committed BytesIn
Use

Available Bytes
Page Faults/sec

% Processor Time

QALoad-MSIIS Availability

Thistemplate includesthe following counters and categories:

System

Web Service

System Up Time

Current Anonymous
Users

Current Connections
Logon Attempts/sec

NonAnonymous Users/sec

Conductor

305



QALoad 05.06 Using the Conductor

Not Found Errors/sec
Total Delete Requests
Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-M SIS Performance

Thistemplate includesthe following counters and categories:

Internet Current Blocked Async
Information I/0 Requests
Services Global

Total Blocked Async I/O
Requests

Total Rejected Async
I/0 Requests

URI Cache Fushes
URI Cache Hits
URI Cache Hits %

URI Cache Misses

PhysicalDisk % Disk Time
Process % Processor Time
Redirector Current Commands

Network Errors/sec
Server Work Item Shortages
Server Work Queues Queue Length

Web Service Not Found Errors/sec
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QALoad-Server Health

Thistemplate includesthe following counters and categories:

Memory % Committed BytesIn
Use
Pages/ sec
PhysicalDisk % Disk Time

Avg. Disk Queue Length
Processor % Processor Time

System Processor Queue Length

QALoad-Windows Availability

Thistemplate monitorsthe availability of the Windows operating system, focusing on:
Logons

Security

Up time

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:

T T T

Server Errors Access Permissions The Microsoft Windows
Availability template uses these
Server registry countersto
Errors Logon monitor errors due to logon

Errors System problems.

Errors Granted Access

To enable these counters, you
must configure your Windows
system to audit logon and
logoff events. You can do this
by configuring the Audit Policy
in the User Manager for
Domains program.

Logon Total

Server Sessions The Microsoft Windows
Availability template uses these
Server registry countersto
Sessions Forced Off monitor how well users
sessionsare running.

Sessions Errored Out

Sessions Logged Off
If thereisalarge number of
session errors, it isusually due
to systemsrebooting often or

Sessions Timed Out
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network errors.

System System Up Time Thiscounter returnsthe
number of secondsthat a
system was available for use. If
thisnumber continuesto reset
to zero, it meansthat the
system isrebooting often. For a
report that liststhe number of
timesthat the system has
rebooted over a period of time,
see the Microsoft Windows
Availability Report topic.

QALoad-Windows Performance

Thistemplate monitorsthe performance of the Microsoft Windows system, focusing on:
CPU

Disk I/0

Disk space

Memory

Network

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:

LogicalDisk % Disk Time Thiscounter monitorsthe
percentage of elapsed timethat
the disk servicesread and write
requests, including thetime
that the disk driver waitsin the
disk queue. If thisvalueis
consistently near 100%, the disk
isin very heavy use. You can
determine which processes are
making the majority of the disk
requests by monitoring them
individually.

% Free Space This counter monitors low free-
space situations.

Avg. Disk Queue Length = Thiscounter indicatesthe
number of pending I/O service
requests. If thereturned valueis
greater than 2, thereisadisk
problem. On a multi-disk
subsystem, such asastriped set
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Available Bytes

Cache Faults/sec

Conductor

or striped with parity, you can
perform a calculation to
determine the presence of a disk
problem. The basic formulais
(Disk Queue Length) - (Number
of Physical Disk Drivesin the
multi-disk configuration).

For example, if you have a
striped set with 3 disk drives
and a queue length of 5, then
you get an acceptable value of 2
(5-3=2).

If the valuereturned by this
counter fallsunder 10 MB,
virtual memory isrunning low.
To resolve this, close some
applicationsor increase the
memory settings. If this counter
isconsistently low after an
application isrunning, it
usually indicates a system
memory leak.

Asthevaluereturned by this
counter decreases, the value
returned by the Committed
Bytes counter increases. This
indicatesthat a processis
allocating memory from the
virtual address space but might
not be using it. Because the
virtual address spaceisalimited
resource, use these countersto
check for applicationsthat
allocate memory but do not use
it. To resolve this, add more
physical memory. When an
application finishes processing,
note thelast value. If this
counter does not return to the
original value, the application
hasamemory leak or ahidden
processthat hasnot properly
terminated.

The acceptable range for
committed bytes should be less
than the physical RAM. The
default value is 64 MB.

If the valuereturned by this
counter islessthan the value
returned by the Page faults/sec
counter, the system is paging
too much for anormal system.
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Committed Bytes

Page Faults/sec

Page Reads/sec

Pages/sec

Transition Faults/sec

Paging File % Usage Peak

PhysicalDisk % Disk Time
Avg. Disk Queue Length

Avg. Disk sec/Transfer

310

To resolve this, add more
physical memory.

This counter returnsthe
amount of virtual memory (in
bytes) that was committed, as
opposed to memory that has
was reserved.

If the valuereturned by this
counter is greater than 5, the
system ispaging too much. Add
more physical memory. A
consistent value of 10 or later
needsimmediate attention.

If thiscounter returnsahigh
peak value, the system is
experiencing alot of paging
activity. A high value also
indicatesthat your system does
not contain enough physical
memory to handle the demands
placed on it by the application.
To resolve this, add more
physical memory. To calculate
the % disk time used for paging,
use the following calculation:

(% Disk Time used for paging) =
(Memory, Pages/sec) * (Average
Disk Transfer/sec) * 100

Thiscounter returnsthe
maximum use of your page file.
If the value the counter returns
consistently reaches 90%, the
virtual address space istoo
small. You should increase the
size of your paging file. When
the valuereturned by the
counter exceeds 75%, a
significant system performance
degradation becomes
noticeable.



Processor

Redirector

Server

Disk Reads/sec
Disk Writes/sec

% Interrupt Time

% Processor Time

% User Time

Network Errors/sec

Bytes Received/sec
Bytes Total/sec
Bytes Transmitted/sec

Errors Logon

Work Item Shortages

Conductor

Thiscounter monitorsthe
percentage of time that the
processor spent receiving and
servicing hardware interrupts
during the sample interval.

On single processor systems, if
the valuereturned by this
counter isconsistently higher
than 90%, the CPU probably
has a bottleneck. You should
examine each processin the
system to determine which one
isusing more of the processor
than it should. The process with
the highest peak isgenerally the
performance bottleneck.

Thiscounter monitorsnon-idle
processor time spent in User
mode as a percentage of the
sample interval.

Thiscounter indicates how
many serious network errors
have occurred. These errors are
generally logged in the system
event log, so you can check
there for moreinformation. If
an error occurs, take immediate
action to resolve the problem.

Thiscounter determinesif an
unauthorized user istrying to
access your system.

Thiscounter monitorsthe
number of timesthat awork
item was not allocated. You
might need to increase the
InitWorkltems and

MaxW orkltems parameters for
the LanMan Server if this
number continuesto increase.
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System

Context Switches/sec If the valuereturned by this
counter valueishigh, assign a
higher priority to the use of
critical sections or semaphores
by the program. Thisachieves a
higher throughput and reduces
task switching.

Processor Queue Length

Managing Monitoring Templates

Creating a New Template

To accessthe New Monitoring Template wizard:

In Conductor, click Tools>Monitoring>Manage monitoring templatesSNew monitoring template. The
New Monitoring Template wizard appears. Click Next to start the procedure.

Usethe following stepsin the New Monitoring Template wizard to create a new monitoring template:

1.

o o w

Enter the template properties
Configure the monitor
Counter discovery

Choose the counters
Choosetheinstances

Review, save, and create the template

To enter propertiesof the template:

312

In the Template name field, type aname for the template.

Click the arrow in the Monitor type field, then select the type of monitor on which data will be
gathered when thetest session isrunning.

Click the arrow in the Machine (hostname or IP address) field and select the host name name or IP
address of the machine on which the monitor will run.

For Oracle Application Server (AS), WM, SAP, WebLogic, WebSphere, or WebSphere MQ, in the
Java Settings field, click Browse... and select the path for the Java component.

I For Oracle AS, SAP, WebLogic, and WebShere MQ thismay be a Sun-installed Java Home, for
example, C:\ Javal DK1.4 wherea Sun DK isinstalled.

I For WebSphere, thismust be a WebSphere-installed Java Home, such as, C:\ Program
Files\ .WebSphere\ AppServer\ Java.

I For WM, thismay be a ServerVantage-installed Java Home, for example, C:\ Program
Files\ Compuware\ ServerVantage\ Java.

Click Next. The Configure Monitor dialog box displays.
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To configure the monitor:

1.

Type the configuration data for the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type you selected. Click alink below
to view the required configuration details for your monitor type.

I Oracle Application Server
I SAP

I SNMP

I WebLogic

I WebSphere

I WebSphere MQ

I Windows Registry

I WMI

Click Next. The counter discovery process begins.

To discover the counters:

QALoad automatically performsthe counter discovery. The default maximum time for counter discovery is
300 seconds. When counter discovery iscomplete, the Choose Countersdialog box displays.

Choose theindividual countersor families of countersto monitor on thismachine and monitor type.

To choose the counters:

When the counter discovery process completes, the Add the desired counter to thistemplate dialog box

displays.
1. From the Available Items pane, select the Template tab or the Counter tab.
2. To add an item, select atemplate or a counter to monitor and click Add, or double-click theitem to
add it in the Selected Items pane. Click Add All to add all theitemson the selected tab to the
Sected Items pane.
3. Toremove an item, double-click the item or select it in the Selected Items pane and click Remove.

Theitemsisreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

4.

I To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

Click Next. The Choose Instances dialog box displays.

Note: A template may contain countersthat are not present on the machine you are defining. A message
appears with a list of the countersthat will not be added.

To choose the instances of the counter to monitor:
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Review the countersyou selected. If the folder next to the counter shows a circle with an X, thismeans
you must select avalue for the instance of the counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.
Click Save. You return to the Choose Instances dialog box.

Repeat this process for each designated counter.

N g~ e DR

Click Next. The Summary dialog box displays.

To save the template:

1. Onthe Summary dialog box, review the monitorsand countersyou have selected for the template.
Click Back to return to a dialog box and make changesto theinformation.

2. Click Finish to create the template.
Opening an Existing Template

Usethe following stepsto apply a previously created or pre-defined template.

To open and review an existing template:

1. Select Tools>Monitoring>Manage Monitoring Templates>Open existing template. The Select a
Monitor Template File dialog box displays.

2. Double-click atemplate type, then select atemplate and click Open. The template and its counters
display in the Monitoring Optionstab of the Conductor'smain screen.

Note: To apply a template to a task, use the New Monitoring Task wizard.

Editing Instances for Templates

To edit instancesin atemplate:

1. On theMonitoring Optionstab, select the template to edit.

2. Click Tools>Monitoring>Manage monitoring templates>Edit instances. The Edit Template
Instances Wizard appears.

To choose the instances of the counter to monitor:

Review the countersyou selected. When ared dot appears next to a counter, you must select an instance
for the counter.

1. Double-click the counter group to display the counters.
Select an instance for a counter and click Edit. The Select instance for counter dialog box appears.
To add an instance: In the Available Instance pane, select an instance and click Add.

To remove an instance: In the Selected instances pane, select an instance and click Remove.

o 0N

Repeat until you select all instances of the counter that you want to apply to the task.
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6. Click Save. You return to the Choose Instances dialog box.
7. Repeat thisprocess for each designated counter.

8. Click Next. The Summary dialog box displays.

To save the template:

1. OntheSummary dialog box, review the monitors and countersyou have selected for the template.
Click Back to return to a dialog box and make changesto the information.

2. Click Back to return to the previous step and edit the instances.

3. Click Finish to create the template.

Modifying Template Counters for Custom Templates

When you need to add or edit countersin atemplate that you created, you can use the cached counter
discovery datato modify the template.

El Note: You cannot modify the countersin pre-defined templates.

Select the counter to add or remove:

1. Select Monitoring>Manage monitoring templates>Add/Edit counter>Use cached discovery
data. The Edit Template Counterswizard appearswith the Add/Edit/Remove Template
Countersdialog box displayed.

2. From the Available Items pane, select the Template tab or the Counter tab.

3. To add an item, select atemplate or a counter to monitor for thismachine and monitor type, and
click Add, or double-click theitem to display it in the Selected Items pane. Click Add All to add
all theitemson the selected tab to the Selected Items pane.

4. Toremove an item, select theitem in the Selected Items pane and click Remove, or double-click
theitem to return it to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

= To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

= To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

5. Click Next. The Choose Instances dialog box displays.

Note: When selecting a template, if some of the countersit contains are not present on the machine you
are defining, a message displays with alist of the countersthat will not be added.

Choose the instances of the counter to monitor:

1. Review the selected counters. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.
Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

A

Repeat until you select all instances of the counter that you want to apply.
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6. Click Save. The Choose Instances dialog box appears.
7. Repeat thisprocess for each designated counter.

8. Click Next. The Summary dialog box displays.

Save the template:

1. OntheSummary dialog box, review the selected monitorsand countersfor the template. Click
Back to return to adialog box and make changesto the information.

2. Click Finish to create the template.

Removing a Counter from a Template

Remove a counter from atemplate by following this procedure.

To remove a counter from atemplate:

1. OntheMonitoring Optionstab, select the counter or counter family to delete.
2. Click Tools>Monitoring>Manage monitoring templates>Remove counter.

3. When the verification dialog box displays, click OK.
El Note: You cannot remove the last counter in a family.

Modifying Template Counters Using New Discovery Data

When you want to add or edit countersin acustom template, you can generate the discovery datathat you
add to the template. The Edit Monitoring Template wizard guides you through the process of generating
and applying new discovery data.

To accessthe Edit Monitoring Template wizard:

Click Tools>Monitoring>Manage monitoring templates>Add/Edit Counter>Use new discovery data.
The Edit Monitoring Template wizard appears. Click Next to start the procedure.

Enter properties of the template:

Click Next in the Welcome dialog box. The Enter properties of the template dialog box displays.
1. Typeanameforthetemplatein the Template name field.

2. Click thearrow in the Monitor type field, then select the type of monitor on which data will be
gathered when thetest session isrunning.

3. Click thearrow in the Machine (hostname or IP address) field and select the host name or IP
address of the machine on which the monitor will run.

4. For SAP, WebLogic, WebSphere, and WebSphere MQ, in the Java Home field, click Browse... and
select the path for the Java component. For SAP, WebLogic, and WebShere MQ thismay be a
SUN-installed Java Home, for example, C:\ Java\ DK1.4, where a SUN DK isinstalled. For
WebShere, thismust be aWebShere-installed Java Home, such as, C:\ Program
Files\ WebSphere\ AppServer\ Java.

5. Typeadescription for the templatein the Description field

6. Click Next. The Configure Monitor dialog box displays.
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Configure the monitor:

1. Typethe configuration datafor the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type selected. Monitor types are:

= Oracle Application Server
= VM

= SAP

= Server Analysis agent

= ServerVantage

= SNMP
= Weblogic
= WebSphere

= WebSphere MQ
=  Windows Registry
= WMI

2. Click Next. The counter discovery process begins.

Counter discovery:

When clicking Next in the previous dialog box, the Add the desired countersto thistemplate dialog box
appears.

QALoad automatically performsthe counter discovery. The default maximum time for counter discovery is
300 seconds. When counter discovery iscomplete, the Choose Countersdialog box displays.

Choose the counters:

When the counter discovery process completes, the Add the desired counter to thistemplate dialog box
appears.

1. From the Available Itemspanein the Choose Countersdialog box, select the Template tab or the
Counter tab.

2. To add an item, select atemplate or a counter to monitor in the task for thismachine and monitor
type, and click Add, or double-click theitem to display it in the Selected Items pane. Click Add
All to add all theitemson the selected tab to the Selected Items pane.

3. Toremove an item, double-click the item in the Selected Items pane or select the item and click
Remove. Theitem isreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

= To select nonadjacent counter items, click one counter item, and then hold down CTRL and
click each additional counter item.

= To select adjacent counter items, click the first counter item in the sequence, and then hold
down SHIFT and click the last counter item.

4. Click Next. The Choose Instances dialog box displays.

Note: When selecting a template, and some of the countersit contains are not present on the machine
you are defining, you receive a message with a list of the counters that will not be added to the task.
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Choose the instances of the counter to monitor:

Review the selected counters. When ared dot appears next to a counter, select an instance of the counter.

1.
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Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.
In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.
Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.

Click Next. The Summary dialog box displays.

Save the template:

1.

2.

On the Summary dialog box, review the countersand instances you have selected for the template.
Click Back to return to a dialog box and make changesto the information.

Click Finish to create the template.

Creating and Editing Monitoring Tasks

Creating a New Monitoring Task

To accessthe New Monitoring Task wizard:

Click Tools>Monitoring>New monitoring task. The New Monitoring Task wizard appears. Click Next to
start the procedure.

Usethe following stepsin the New Monitoring Task Wizard to create anew monitoring task:

1.
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Define the monitor

Configure the monitor

Discover the counters

Choose the countersfor the monitoring task
Choose theinstances of the counter to monitor
Review the monitor definition

Save and create the monitoring task

To define the monitor:

1.
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Click the arrow in the Monitor type field, then select the type of monitor on which data will be
gathered when the test session isrunning.

Click the arrow in the Machine (hostname or IP address) field and select the host name or IP
address of the machine on which the monitor runs.

Control Server Database Host: (Server Vantage) Host machine for the database used by the control
server. It may be the same machine used by the control server.
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Nucleus Server Name or IP Address: (Vantage Analyzer) Machine hostname or IP address of the
machine on which the Vantage Analyzer Nucleus server runs.

3. For Oracle Application Server (AS), VM, SAP, WebLogic, WebSphere, and WebSphere MQ:

In the Java Home field, click Browse and select the path for the Java component.

For Oracle AS, SAP, WebLogic, and WebShere MQ, thismay be a Sun-installed Java Home. For
example, C:\ Javal DK1.4 wherea Sun DK isinstalled.

For WebSphere, thismust be aWebShere-installed Java Home, such as C:\ Program
Files\ WebSphere\ AppServer\ Java.

For WM, thismay be a ServerVantage-installed Java Home, for example, C:\ Program
Files\ Compuware\ ServerVantage\ Java.

4. Click Next to proceed to the next step, where you configure the monitor.

Step 2:

Configure the monitor:

1. Typethe configuration datafor the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type you selected. Click alink below
to view therequired configuration detailsfor your monitor type.

Oracle Application Server
SAP

Server Analysis agent
ServerVantage

SNMP

WebLogic

WebSphere

WebShere MQ
Windows Registry

WMI

2. Click Next. The counter discovery process begins.

To discover the counters:

QALoad automatically performsthe counter discovery. During this process, QALoad collectsthe
counters from the target servers.

Note: For Oracle Application Server (AS), WebSphere, WebLogic, SAP, WebSphere MQ, and WM, the
ServerVantage Agent performsthe counter discovery.

The default maximum time for counter discovery is 600 seconds. You can change the timeout value
from the Monitoring Options menu (Click Tools>Monitoring>Monitoring Options). QALoad calculates
thetimeout period for Windows Registry, SNMP, and Server Analysis monitor types based on the
timeout value you enter in the Monitoring Options dialog box. For other monitor types, QALoad
passesthe timeout value to the ServerVantage agent, which determineswhen the discovery timeout is
reached.

When counter discovery iscomplete, the Choose Countersdialog box displays.
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Choose theindividual counters, families of counters, or select countersfrom a predefined template to
monitor on thismachine and monitor type.

To choose the counters for the monitoring task:

When the counter discovery process completes, the Choose Countersdialog box displays.
1. From the Available Items pane, select the Template tab or the Counter tab.

2. To add an item, select atemplate or a counter to monitor and click Add, or double-click theitem to
display it in the Selected Items pane. Click Add All to add all theitemson the selected tab to the
Selected Items pane.

3. Toremove an item, double-click the item or select it in the Selected Items pane and click Remove.
Theitemsisreturned to the Available Items pane.
Note: Select multiple counters and templates by doing one of the following:

I To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

4. Click Next to proceed to the next step, choosing the instances for the counter.

Note: Atemplate may contain countersthat are not present on the machine you are defining. A message
appears with a list of the countersthat will not be added.

To choose the instances of the counter to monitor:

Review the countersyou selected. If the folder next to the counter shows a circle with an X, thismeansyou
must select avalue for the instance of the counter.

1. Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.
Click Save. You return to the Choose Instances dialog box.

Repeat this process for each designated counter.
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Click Next to proceed to the next step, where you review the monitor definition.

To review the monitor definition:

1. Review theinformation for the monitoring machine you defined.
2. Select one of the following:

I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you can add
another monitor to the monitoring task.

I Continue without adding any more monitors - continuesin thisdialog box.

3. (Optional) In the Monitors pane, select the monitor, then click Save as Template to create a
template for thismonitoring task.
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(Optional) In the Monitors pane, select the monitor type, then click Remove Monitor to delete a
monitor from the task.

(Optional) Typeanew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data during runtime data collection.

Click Next to proceed to the next step, where you review the summary and create the task.

To review and save the task:

1.

5.

Review the monitorsand countersyou have selected for the task in the Summary dialog box. Click
Back to return to adialog box and make changesto the information.

In the Monitoring task name field, type aname for the monitoring task. The task is saved so you
can reuse this configuration of countersand instances.

In the Description field, type a description for the task.

Select amonitor in the Monitors pane, and click View Monitor Details. The Properties of dialog box
displayswith detailed information about the monitor.

Click Finish to create the monitoring task.

Using an Existing Monitoring Task

To select an existing monitoring task:

1.
2.

Click Tools>Monitoring>Use existing task. The Choose an Existing Task dialog box appears.
Select atask and click OK. The task displaysin Conductor's Monitoring Optionstab.

Adding a Monitoring Machine

To accessthe New Monitoring Task wizard:

Click Tools>Monitoring>Add monitor. The Add Monitoring Machine wizard appears. Click Next to start
the procedure.

Usethe following stepsin the Add Monitoring Machine wizard to add a monitoring machine to the task:

1.
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Enter properties of the monitoring machine
Configure the monitor

Discover the counters

Choose the countersfor the monitoring task
Choose the instances of the counter to monitor
Review the monitor definition

Save and create the monitoring task

Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type.

To enter propertiesfor the monitoring machine:

1.

Click the arrow in the Monitor type field, then select the type of monitor on which data will be
gathered when thetest session isrunning.
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Click the arrow in the Machine (hosthname or IP address) field and select the host name or IP
address of the machine on which the monitor will run.

For Oracle Application Server (AS), WM, SAP, WebLogic, WebSphere or WebShere MQ, in the Java
Home field, click ... (Browse) and select the path for the Java component.

! For Oracle AS, SAP, WebLogic, and WebShere MQ thismay be a SUN-installed Java Home, for
example, C:\ Javal DK1.4 where a SUN DK isinstalled.

I For WebSphere, thismust be a WebSphere-installed Java Home, such as, C:\ Program
Files\ .WebSphere\ AppServer\ Java.

I For WM, thismay be a ServerVantage-installed Java Home, for example, C:\ Program
Files\ Compuware\ ServerVantage\ Java.

Note: In a monitoring task that includes multiple monitors, when the "Define Monitor" page is being
validated, you are warned and prevented from proceeding to the next page if you choose to add another
monitor that would result in WM clashes. (WebSphere isa good example because it usesits own VM.)
Moreover, multiple versions of Oracle AS monitors are not allowed in the same task.

4.

Click Next to proceed to the next step, where you configure the monitor.

Editing a Monitoring Machine

To accessthe Edit Monitoring Machine wizard:

Click Tools>Monitoring>Edit monitor. The Edit Monitoring Machine wizard appears. Click Next to start
the procedure.

Usethe following stepsin the Edit Monitoring Machine wizard to change the properties of amonitoring
machine:

1.
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Enter properties of the monitoring machine
Configure Monitor Dialog

Discover the Counters

Choose Counters

Choose Instances

Review Monitor Definition

Summary

El Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type.

To enter propertiesfor the monitoring machine:

1.
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Click the arrow in the Monitor type field, then select the type of monitor on which data will be
gathered when the test session isrunning.

Click the arrow in the Machine (hosthame or IP address) field and select the host name or IP
address of the machine on which the monitor will run.

For SAP, WM, WebLogic, WebSphere or WebSphere MQ, in the Java Home field, click ... (Browse)
and select the path for the Java component.

I For SAP, WebLogic, and WebSphere MQ thismay be a SUN-installed Java Home, for example,
C:\ Java\ IDK1.4 wherea SUN DK isinstalled.

I For WebSphere, thismust be a WebSphere-installed Java Home, such as, C:\ Program
Files\ .WebSphere\ AppServer\ Java.
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I For WM, thismay be a ServerVantage-installed Java Home, for example, C:\ Program
Files\ Compuware\ ServerVantage\ Java.

Click Next to proceed to the next step, where you configure the monitor.

To configure the monitor:

1.

Type the configuration data for the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type you selected. Click alink below
to view therequired configuration detailsfor your monitor type.

I Oracle Application Server
I SAP

I Server Analysis agent

I ServerVantage

I SNMP

I WebLogic

I WebSphere

I WebSphere MQ

I Windows Registry

I WMI

Click Next. The counter discovery process begins.

To start the counter discover process:

QALoad automatically performsthe counter discovery. The default maximum time for counter discovery is
300 seconds. When counter discovery iscomplete, the Choose Countersdialog box displays.

Choose theindividual counters, families of counters, or select countersfrom a predefined template to
monitor on thismachine and monitor type.

To choose the counters for the monitoring task:

1.
2.

From the Available Items pane, select the Template tab or the Counter tab.

To add an item, select atemplate or a counter to monitor and click Add, or double-click the item to
add it in the Selected Items pane. Click Add All to add all theitemson the selected tab to the
Selected Items pane.

To remove an item, double-click the item or select it in the Selected Items pane and click Remove.
Theitemsisreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

I To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.
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4. Click Next to proceed to the next step, where you select the instances of the countersto monitor.

Note: A template may contain countersthat are not present on the machine you are defining. A message
appears with a list of the countersthat will not be added.

To choose the instances of the counter to monitor:

Review the countersyou selected. If the folder next to the counter shows a circle with an X, thismeansyou
must select avalue for the instance of the counter.

1. Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.
Click Save. You return to the Choose Instances dialog box.

Repeat this process for each designated counter.
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Click Next to proceed to the next step, where you review the monitor definition.

To review the monitor definition:

1. Review theinformation for the monitoring machine you defined.
2. Select one of the following:

I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you can
add another monitor to the monitoring task.

I Continue without adding any more monitors - continuesin thisdialog box.

3. (Optional) In the Monitors pane, select the monitor and click Save as Template to create atemplate
for thismonitoring task.

4. (Optional) In the Monitors pane, select amonitor and click Remove Monitor to delete a monitor
from thetask.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data during runtime data collection.

6. Click Next to proceed to the next step, where you review and save your selections.

To review and save the updated monitor information:

In the Summary dialog box, information on the machine you added appears on two tabs: Countersto
Monitor and Type-specific properties.

1. Review the monitorsand countersyou have selected for the task. Click Back to return to adialog
box and make changesto theinformation.

2. Click Finish to add the monitoring machine.

Editing Instances

Use the following procedure to edit instancesif the counters you are monitoring.
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To accessthe Edit Instances dialog boxes:

1. On the Monitoring Optionstab, select the machine, the counter, or the instance to edit.

2. Click Tools>Monitoring>Edit instances. The Edit Instances dialog boxes display.

To edit the instances of a counter:

1. Inthe Choose Instances dialog box, double-click the counter group in the left-hand paneto
display the counters.

2. Select acounter and click Edit. The Select instance for counter dialog box appears.
Zl Note: When a counter can not be edited, the Edit button is unavailable.
3. Perform the necessary edits. You can do the following:

= In the Available Instances pane, select an instance and click Add. Theinstanceisadded to the
Selected Instances pane. Repeat until you select all instances of the counter that you want to
apply to the task.

* In the Selected Instances pane, select an instance and click Remove. Theinstanceisremoved
from the Selected Instances pane and added to the Available Instances pane.

e

Click Save. The Choose Instances dialog box displays again.

o

Repeat this process for each counter you want to edit.

6. Click Next. The Review Monitor Definition dialog box displays.

Review the monitor definition:

1. Review theinformation for the monitoring machine you defined.
2. Select one of the following:

I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you can
add another monitor to the monitoring task.

I Continuewithout adding any more monitors - continuesin thisdialog box.
3. (Optional) Click Save as Template to create atemplate for thismonitoring task.

4. (Optional) Select amonitor in the Monitors pane and click Remove Monitor to delete a monitor
from the task.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data from ServerVantage during runtime data collection.

6. Click Next. The Summary dialog box displays.

Save the task:

1. Review the monitorsand countersyou have selected for the task. Click Back to return to adialog
box and make changesto theinformation.

2. IntheMonitoring task name field, type aname for the monitoring task.
In the Description field, type a description for the task.

4. Select amonitorin the Monitorspane, and click View Monitor Details. The Properties of dialog
box displayswith detailed information about the monitor configuration and the countersyou
selected.
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5. Click Finish to create the monitoring task.

Server Analysis Agent

Server Analysis Agents

Server Analysis agents use enhanced ServerVantage technology to provide server utilization data without a
complete ServerVantage deployment. Server Analysis agents, provided on the QACenter Performance
Edition CD, are quickly and easily installed on the serversthat you wish to monitor during aload test.
Server Analysis agents provide you with valuable server utilization metrics — called counters— on Web
servers, application servers, and database servers being exercised by your load test to help you to pinpoint
performance bottlenecks when load testing.

Unlike a full ServerVantage installation, you can start, stop, and configure Server Analysis Agentsright
from the familiar interface of the QALoad Conductor.

Server utilization data from the agents and response time information from QALoad is all automatically
downloaded and correlated through the use of ActiveAnalysis, and is available for post-test analysis
through QALoad Analyze.

Server Analysis agents are set up when you create a monitoring task. For details about using Server Analysis
agentsin aload test, see Creating a New Monitoring Task.

Server Analysis Agent Templates
QALoad-Windows Performance
Thistemplate monitorsthe performance of the Microsoft Windows system, focusing on:
I CPU
! Disk 1/O
I Disk space
I Memory
I Network

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:

LogicalDisk % Disk Time

Memory Available Bytes
Cache Faults/sec
Committed Bytes
Page Faults/sec

Paging File % Usage Peak

Processor % Processor Time
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% User Time

Interrupts/sec
Server Bytes Total/sec
ServerVantage

Server Monitoring with ServerVantage

If you are currently alicensed user of Compuware's ServerVantage, you can integrate data from your
existing ServerVantage deployment directly into a QALoad timing file.

For thismethod to be successful, the following conditions must be met:
I ServerVantage must beinstalled and configured correctly on your system.

I ServerVantage must be scheduled to monitor the specified performance countersat atime that
coincideswith arunning QALoad test.

I Thedefault SQL port, 1433, must be open on the ServerVantage database server so that QALoad
can retrieve the counter data at the conclusion of the test.

I QALoad must be ableto accessthe ServerVantage database server on port 139 or 445 viatcp to
obtain time stampsat the beginning and end of the test.

I QALoad must be ableto accessthe ServerVantage agent using an ICMP ping during the monitor
setup. If security restrictions prevent pinging the agent, an entry can be added to the host's file on
the Conductor machine mapping the domain name of the agent to the IP address of amachine
that can be pinged, such asthe Conductor.

About ServerVantage

ServerVantage (formerly ECoTOOLS) monitorsthe availability and performance of applications, databases
and servers, allowing usersto centrally manage events across all application components— Web servers,
firewalls, application servers, file systems, databases, middleware, and operating systems. ServerVantage
simultaneously monitorsthese components, analyzes both historical and real-time events, and correlates
monitored information for problem detection.

Integration with ServerVantageis configured from the QALoad Conductor. Performance counters collected
during aload test areincluded in thetest'stiming file and can be sorted and displayed in QALoad Analyze
in much the same way as QALoad timing data. For more information about installing or configuring
ServerVantage, refer to its product documentation.

Setting Up Integration with ServerVantage

To set up integration with ServerVantage:

1. On the Conductor Test Information Screen, click the Monitoring Optionstab.
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2. Click the Set up monitoring link, then select Set up a new monitoring task. Click OK. The New
Monitoring Task Wizard dialog box appears.

3. Click Next. In the Define Monitor dialog box, click the arrow in the Monitor Type box and select
ServerVantage.

4. In the Control Server Database Host field, click the down arrow and select the hostname of the
machine where the ServerVantage server islocated.

Click Next. The Configure Monitor dialog box displays.
In the Username field, type a valid user name to accessthe ServerVantage server, if necessary.

In the Password field, type the password that correspondsto the user name above, if necessary.
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Select the Override Default Database check box to provide the ServerVantage database name.
When thisoption isnot selected, QALoad usesthe default ServerVantage database name. If you
provided a different name during the installation of ServerVantage, select thisoption and typethe
namein the Database Name field.

9. IntheNamefield in the Vantage Agent area, type the hostname of a machine(s) where a
ServerVantage Agent isinstalled, and click the Add button to add it to your load test.

10. Click Next to proceed to the next step.

Integrating ServerVantage Agent Data

If you set optionsto integrate ServerVantage resource utilization data before running atest, that datais
included in theresulting timing file. It can be sorted and displayed in QALoad Analyzein much the same
way as QALoad timing data. ServerVantage data providesa summary of all the Agentsthat ServerVantage
monitored during the load test and details aggregate statistics for Agent data pointsincluding minimum,
maximum, and mean data values.

Displaying ServerVantage Agent Data

When you open atiming file containing ServerVantage Agent data, QALoad Analyze displaystest data with
QALoad timing datatwo ways:

I ServerVantage Agent workstationsare listed in the Server Monitoring group in the Workspace tree-
view, under the Resource Trends (ServerVantage) branch. From the Workspace, select Agent
workstationsto create detail or graphical views of the Agent data points. Specifically, you can:

= Display Agent data point details.

= Graph Agent data point details.

I Detailed data point information isdisplayed in the Datawindow. The ServerVantage detail view
includes data such asthe name of the machine where you ran the ServerVantage Agent; the Agent
name; and the minimum, maximum, and mean data values for the Agent.

El Note: ServerVantage resource utilization data is available only if you set the ServerVantage integration
options on the QALoad Conductor’s Test Information window before executing a load test.
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ApplicationVantage

Overview of ApplicationVantage

QALoad integrates with ApplicationVantage to help you analyze network performance during aload test.
ApplicationVantage provides granular thread detailsthat allow network managersto identify poorly
performing applications. QALoad also providestest datathat you can open in ApplicationVantage.

&l Note: Scriptsthat run in ApplicationVantage mode must run only one virtual user.
Before QALoad can collect network data during a load test, the following must be true:
I The ApplicationVantage Agent isinstalled on the sasme machine asthe QALoad Conductor.
I You have specified on which NIC to capture from the Machine Assignment tab in Conductor.

At test time when atransaction is started, the Player configured to capture ApplicationVantage data starts
an ApplicationVantage trace. The trace stopswhen the transaction completes. When a Player isrunning a
script that isset to run in ApplicationVantage mode, every transaction generates a new trace file. At the
end of the test, these files are packaged into the test'stiming file.

' Hint: For information about ApplicationVantage, refer to the documentation you received with your
purchase of thistool.

Configuring atest to use ApplicationVantage

Integration with ApplicationVantage enablesyou to study network problemsin detail. You can set up one
or more ApplicationVantage (AV) Player machines for the load test. These AV Player machinesrun a
QALoad script on a periodic basiswhile the AV Agent capturesthe network traffic that the script produces.
Theresulting AV trace files (*.opx) are sent back to the Conductor with the regular QALoad timing file for
analysis after the test iscomplete.

To enable ApplicationVantage, you must be running ApplicationVantage 10.0. You must select the
ApplicationVantage option, and then set the Network Interface Card (NIC) Name used by the machine on
which the datais captured. Scriptsthat run in ApplicationVantage mode must run only one virtual user.

Enabling ApplicationVantage

You can enable or disable the ApplicationVantage for each load test on a script. To enable
ApplicationVantage, you must select the option, and then set the Network Interface Card (NIC) Name.

Note: Scriptsthat run in ApplicationVantage mode in Conductor must run only one virtual user.

To enable ApplicationVantage:

1. Click Conductor's Script Assignment tab.

2. Clickin the Script column to enable the Browse (...) button. Then, click Browse. The Select Script
dialog box displays.

Click the ApplicationVantage Mode box at the bottom of the dialog box..
4. Click OK.
5. Setthe NIC Name.
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Note: Scriptsthat run in ApplicationVantage mode in Conductor must use only one virtual user.

Setting up Network Interface Card Name

To usethe ApplicationVantage Agent to collect data for ApplicationVantage, it isnecessary to specify
which Network Interface Card (NIC) to capture on. Thisisthe network information for the workstation
where your ApplicationVantage Remote Agent isinstalled.

To set up NIC Name:

1.
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With the session ID you want to use for your test open, click the Conductor's Machine
Assignment tab.

Click the Manage Player Machines button for the Conductor to query your test network for
installed Player Agents. You also can select Tools>Manage Player Machines. The Manage Player
Machines and Groupsdialog box displays with names of available Player machines.

In the All Player Machinesand Groups area, double-click the Player machine that will berunning
thevirtual user to be captured. The Edit Player Machine dialog box displays.

Click the Application Vantage Settingstab.

From the drop-down list in the NIC Name field, select the NIC that isused by the machine.

Note: All NIC Description namesthat the ApplicationVantage capture driver identifies are listed in
thisfield.

Click Apply, then click OK.
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Troubleshooting

Conductor Pre-test Checks

Before atest begins, the Conductor completesthe following pre-test checks of the parameter filesand
Players. If any of these checks fail, the Conductor displays an error message.

I Arethere enough Players configured to support the number of users specified in the session ID file?

I Doesthe number of users specified in the session ID file exceed the maximum number of users
defined by your authorization key?

I Can the specified compiled script files be accessed?

I Areall Playerscommunicating with the Conductor? (The Conductor sends a request message to all
the Playersto verify that they are up and running.)

Executing SSL Scriptsthat use Client Certificates

If you are executing SSL scriptsthat use client certificates, you must manually copy the client certificatesin
use to the Player machine(s) executing the script(s).

Manually copy the client certificates from the\ Program Fi | es\ Conpuwar e\ QALoad\ Certifi cates
directory to the same default directory on the Player machine.

El Note: On the Unix player platform, you must create the Certi fi cat es sub-directory in the QALoad
directory. The directory name is case sensitive.

Heartbeat Message Failure on a Virtual User

When a Player machine crashes or experiences aloss of communication, the heartbheat message that the
Conductor sends out (if enabled) fails. Thissituation isindicated in the runtime Conductor through a
message on each virtual user that is affected. When the heartbeat message fails for a virtual user, the Satus
column of the Details view of a script displaysthe following message: "The Player running this user failed
to respond to a heartbeat message."

The option for enabling a heartbeat message islocated on the Player tab of the Optionsdialog box in the
Conductor.

Timing Fle istoo Big

Depending on the length of the load test and the amount of data that was collected, timing files can grow
to excessively large sizesthat become difficult to handle. To prevent timing filesfrom becoming too large,
try modifying the following settings:

! Disable automatic middleware checkpoint timingsin the Conductor
I Usethe Conductor'stiming datathinning options

Both of these settings are located on the Timing Optionsdialog box, which can be accessed from the Script
Assignment tab of the Conductor.
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Tips for Running QALoad Tests on UNIX Systems

To successfully run large QALoad tests on UNIX systems, you may need to make adjustmentsto your
settings as described below:

General (AlX, Solaris, and RedHat Linux)

When you attempt to run alarge number of virtual userson UNIX platforms, the virtual users do not
always synch. If virtual usersdo not synch, try increasing the Virtual User Sartup Delay. By default,
QALoad Conductor setsthe VU Sartup Delay to 1 millisecond. Thisdefault isnot high enough for UNIX
platforms. If the UNIX Player receives a value lessthan 15 milliseconds, the delay will be 15 milliseconds
or more.

To increase the delay:

1. In the QALoad Conductor, click Tools>Options.
2. Click the Player tab.
3. IntheVU Startup Delay field, type the number of millisecondsto delay virtual user startup.

Solaris

The default file descriptor limit on Solarishas a "soft" limit of 64, and a"hard" limit of 1024 (Solaris 2.6).
Per the Solaris 2 FAQ (refer to http://www.wins.uva.nl/pub/solaris/solaris2.html), the file descriptor limit is
described in the getrlimit() manual page as: "One more than the maximum value that the system may
assign to anewly created descriptor. Thislimit constrainsthe number of file descriptorsthat a process may
create."

To increase thislimit, system administrators can modify the/ et ¢/ syst emfile and reboot the system. For
example:

* set hard limt on file descriptors
set rlimfd_nmax - 4096
*set soft limt on file descriptors
set rlimfd_cur = 1024

332



Index

CFG il 16
A
Analyze
teSt StAtiStICS. . vveeei i 36
ApplicationVantage ..........cccevvvuiineeennenns 329, 330
B
batch test
AddiNgG SESSIONS..ccvviiii et 26
FEMOVING @ SESSION .vvvvviieeeeeeeeiiiieeeeeeeeeeeeennnns 26
(0T 11T oo 26
terminating.......ueeiii e 27
bulk license checkout..........ccoooociiiiiiiiiiiinn, 22
C
checkpoints
Oraphing ..o 29
client certificate..........ooocvveeeiiiiiee 331

command line

starting Conductor ........ccuvveeiiieeeieeeeee e 4
concurrent
[ICENSE .oiiiiiiiiiiiii 22
Conductor
CONFIQUIING oo 11
AEDUQG e 28
DetailS VIEW ... 6
OraPNS e 7,29, 30
[0 o 11 o TR 21
menus and toolbar buttons..........cccoeecviveennnn. 2
new monitoring task ........cccccvvvinnieeeeeeeiinnnn, 318
new monitoring template ........cccooeeevvvevnnnnnn. 312
player machine.........cccoooooiiiii, 19, 20
(=Too] o 1 s o T 32
RUNtiMe WindOW ........ccoovvimiriiiiieeeeeeeee 6

SCript @sSigNMeENnt ......ooovvviiiiiiieiieeiiie e 17
SCEIPES ettt 18
SESSION VIEW ..eeiiieeiiiiinrieie e 8
SELLING UP it 10
LSz L A o [ 3,4
[0 S T o 4,331
viewing datapool usage........ccccceeeeiiieeiiieiinnnnn. 28
CONAUCEOT ..t 2
configuring
CONAUCEOT e 11
counters
addingto atask ........coovveiiiiiiiiiii 273
Oraphing .oooovveece e 30
VM 267
Oracle AS.....coo 231
remote monitoring.......cccceevvvvnennnn. 40, 315, 316
removing from atask ........cccccceeiiiinnnn, 274
AP 75
NMP e 102
WEDLOGIC. .uuuiiiiiiiieiiiiei e 108
WebSphere ..., 175
WebSphere MQ ...ooovvvviiiiieiiieeeee e, 217
WiINdOWS NT...cooviiiiiiiiiiiiiii 41
Windows RegIStIY.....uvvivviieiiiieiiiiii e, 56
WMo 229
CPU USAJE....ccieiii ettt 28
D
datathinning....ccccoccveiiiiiiiiee e 15
datapool
removing used data.........cccccceeviiieeeeeeiiiiinnenn, 24
VIEWING USAQE ....cevveeiiiiiiieeeeeeeeiiie e e e e e e e e 28
debug
LS o] 1 o) 18, 28



QALoad 05.06 Using the Conductor

dial-up/down virtual USsers........ccccceeeeieeeeieennnnnnn. 23
E
error handling.......ooovvviiii e, 15
EXPEIT USEI ittt eeeas 34
G
graph
diSplaying coooeeeeeeeece e 7
H
heartbeat message.........ccuuuiiiiiiiiiiiiiiiieeeeeeees 331
I
INSLANCES. ...cvvveeiieeee et 40
integration
Application Vantage..........ccceevvvevviviiiiieennnnnns 329
FEQUITEMENTS. ... e ieeeeiiie e e e e 37
ServerVantage ......coooeveveieeiiiiiecei e 327
integration/Application Vantage..................... 329
J
MM
COUNTEIS ...uiiiiiiirnnrnrrnrrrnrnneen e 267
teMPlateS ..o 276
L
licenses
check out/in ... 22
VIrtUal USEIS...ccooiiiiiiiiiiii, 22
load test
analyzing data ......cccoooeeeeiieeiiiiii e 36
FUNNINQ ittt eeeeeanns 22
1Si0] o] o114 Lo 25
logfile generation ..........coeeiiiiiiiiiiiiiiii e 18
M
machine configuration ............cccccvviiiiniieennnnnn, 16
menus
CONAUCEON ...ueiiiiiiiiiiiiiiiieiie e 2
monitor
removing from atask .........ccccceeeeiii i, 274
monitoring
creatinganew task ........cccceeeii i, 318

334

creating anew template...........ccooevviieinn. 312

FEQUITEMENTS ..ovvieiiiiii e 37
N
NIC Service Name ..o 330
O
Oracle AS

(oo ]T] gL 4= = T 231
P
performance monitoring ........ccccvvveeiinieerieeennnnnn. 37
Player

BITONS ettt ettt 18
playersand groupsS........cccveeeveeeernnniirnnneeneeee s 19
Q
QALoad CondUCEOr........voveiiiiieeeeiiiieeeiree e 2
R
FAMP-UP SESSION ..eiiiiiiiiiie et e e 23
random SEEAS......ccoviiiiiiiieii e 10

Remote Monitoring

COUNTEIS .o 40, 315, 316
BASK ottt 321
templates.....ooeeeieiiiiiiiii 275, 315, 316
Remote MOoNitoring .....cocevvveeiiiieeieeeiiiee e eeeeeens 39

running atest

DetailS VIEW .......vvvviiiiiiiiiiiiiiiiiiiiiiiiiieieeeivieeneeeees 6
FUNNING @teSt.uuuii i 6
runtime datatransfer........cccoooiiii, 24
Runtime Window

DetailS VIEW ..coovviiiiiiiicee e 6

GrapNS VIEW ....cuuvuiiiieiiieeiiie e 7

SESSION VIEW ..eeiiieeiiiiirieeie e e 8
Runtime Window ... 6
S
SAP

COUNTEIS.....ooiiiiiiiiiii et 75
script

addingto atest..cccooeeeviieiiiiiii e 14

ASSIGNMENT it 17



debugging ..o 18

EXECULING e eeeieeeiie e e e 28

removing from atest .........cccvviiiiiiiiiiiinnnn, 15

Validating...coeveeeieieeeeeee e 18
server analysis

AGENTS. . e 326
server monitoring

ServerVantage .....ccooveveeeeieveeiieeeeeneeeee e 327
Server MONItOrNG ..oooeviiiiiii e 37
ServerVantage......ooooveveeeeveeiiiieeeiiie e 327, 328
SNMP

COUNTEIS ...ttt 102

teMPlateS ..cooveeeecee e 279
S

LS 1 o 331
SEALISEICS. .ot 36
summary test reSultS.......ceeveeeiiiiiiiiiie e, 8
T
BASK et 318
technical SUPPOIt ...oovveiiiiiiii e i
template

COUNTEIS . .uvvriiirrnnrnnnnnnnnneneennnennnnnnnnnnnnenes 315, 316

CrEALING .evee e 275, 312

INSLANCES ....coiiirieeeiie e 314

pre-defined........ccooevvieiiiiiiiii e, 275

remote monitoring..........ccceeevveenn. 275, 312, 314

SAP 277

SNMP 279

WEDLOGIC . .ccuuiiiiiieiiiiiiiiii e 280

WebSPhere....ooooevv i 291

WebSphere MQ.....ooooiiiiiiiiiiiieiiiiiiii e 294

WM 295
templates

VM 276
test

adding @ SCriPt coocvvveiiie e 14

analyzing data ........ccoooeeeiiiiiiiiii e 36

changing OptioNS .......coouiviiiiiiiiiiiiii e 17
pre-test checks.......cooevvvviiiiiiiiiii e, 331
FeMOVING @ SCHPt.....ciii e 15
results
thinning data.......ccccoovvviiviiiiiiii e, 15
FUNNIN Gttt 22,26
SESSION ID i 11
1SS g Lo VT o 10
SEALISLICS ..ceeiieiiiiiieee 36
thinning test data........ccccevvvviiiiieeeieieiiiiii e, 15

timing data/file

CrEALING . ettt 36

thinNINg oo 15

troubleshooting.......coouvvviiiiiiiiiiiii e, 331
tiMiNG UPAatES.....vveviiieeiieeeiie e 24
tips

UNIX e 332
L] 332
toolbars

CONAUCEOT e 2

Top Processes

COECtING i 28
U
UNIX
FUNNING LESES .ooiviiiiiie e 332
V
virtual user
addingto atest..cccoooevviieiiiiiii e 23
changingthenumber..............cciiii e, 17
EXPEIT USET 1ovvieieiiieee e e e e e e e e e 34
[HCENSING veii e 22
W
WebLogic
(oo ]T] 0L 4= = T 108
teMPlates. ... 280
WebSphere
COUNTEIS.....coiiiiiiiiiin e 175



QALoad 05.06 Using the Conductor

templates ..o 291
WebSphere MQ ..cooovvviiiiiiieee e, 217
WIN 2K e 56
WINAOWS NT oo 41
Windows Registry

336

COUNTEIS....ciiiiiiiiiiii e 56
WMI

COUNTErS.....coviiiiiiiiiniee e 229, 230, 231

teMPlatesS...coovveiiieeee e 295



	Conductor
	About the Conductor
	Overview of the QALoad Conductor
	QALoad Conductor Menus and Toolbar Buttons
	Starting the Conductor
	Starting the Conductor From the Command Line
	Test Setup Interface
	Runtime Window Interface

	Setting Up a Test
	About Setting Up a Test Setup
	Setting Up the Conductor
	Configuring the Conductor
	Setting Up a Test Session
	Adding a Script to a Test
	Removing a Script from a Test
	Anticipating Error Conditions
	Managing Large Amounts of Test Data
	Saving Machine Configurations
	Assigning Scripts to Player Workstations
	Changing the Number of Virtual Users
	Changing Test Options
	Setting Delays Between Tests
	Validating Scripts in Conductor
	Debugging a Script

	Managing Players and Groups
	Overview of Players and Groups
	Managing Player Machines
	Managing Groups

	Running a Test
	Running a Load Test
	Checking Out Virtual User Licenses
	Dialing Up/Down Virtual Users
	Increase/Decrease Runtime Timing Updates
	Removing Used Datapool Records After a Test
	Stopping a Load Test

	Running a Series of Tests (Batch)
	Running a Batch Test
	Adding Sessions to a Batch Test
	Removing a Session from a Batch Test
	Terminating a Batch Test

	Monitoring a Running Test
	Monitoring CPU Usage
	Watching a Script Execute
	Viewing Datapool Usage
	Graphing Checkpoints
	Graphing Counter Data

	Recording and Playing a Test
	Recording a Test
	Replaying a Test

	Expert User
	Overview of Expert User
	Enabling Expert User

	Analyzing Load Test Data
	Analyzing Load Test Data
	Creating a Timing File (.tim)
	Viewing Test Statistics

	Integration and Server Monitoring
	Server and Performance Monitoring
	Integration and Monitoring Requirements
	Remote Monitoring
	Server Analysis Agent
	ServerVantage
	ApplicationVantage

	Troubleshooting
	Conductor Pre-test Checks
	Executing SSL Scripts that use Client Certificates
	Heartbeat Message Failure on a Virtual User
	Timing File is too Big
	Tips for Running QALoad Tests on UNIX Systems


	Index

